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1. Reverse Engineering
Permette di caricare tutte le tabelle/viste… da un DB Oracle con tutte le informazioni
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NB:

Non checcare i seguenti perché implicherebbe per DB grandi un reverse con tempi lunghissimi:
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 Conviene mettere tutto UPPERCASE
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Attenzione a non selezionare ROW Count perché altrimenti ci mette oltre 1 ora!!
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Organizzarli qui per zona-entità:

Premere CTRL+G >> scegli Tabella (inserendo le prime lettere si trova subito)
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si evidenzia in giallo per trovarla facilmente:
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E si sposta nella zona dell’entità:
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Risultato:
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2. Crea Entità di tabelle
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Si scelgono le tabelle membri del gruppo
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Comandi Di ZOOM
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Relazione n:1
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3. Importare una sola tabella dal DB
[image: image23.png]dependent table]



 [image: image24.png]


rinominare con lo stesso nome della tabella [image: image25.png]


tasto destro
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4. Definizione Primary Key
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5. Rinomina
F2 oppure CTRL+ALT dopo aver selezionato il campo
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6. Cancella campo
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7. Stile Diagrammi

· TITOLO Gruppo: 20 Bold

· FONT: Ariel

· Nome tabella: 12 bold
· Corpo tab: 10

· Format: senza Show Shadows

· Format >> Table Diplay:
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· DB0: GIALLO [image: image49.bmp]
· DB1: CELESTE [image: image50.png]



· DBT: GRIGIO

· DB2: VERDE
· NOTE JOIN TRA CAMPI [image: image51.png]PUN_AUMENTO_PURT: NUMBER(11,3) NUL
PUN_NOTA_ATTACCO: VARCHAR2(250) NU

SER_COD_MPIAN

SERVIZ
NJ/Q SER_UTE: VARCHAR2(2) NOT NULL (FK)

€, SER_PUNTOPRESA: NUMBER(15) NOT NULL





· PER NASCONDERE UN CAMPO DOPPIO (in genere FK quindi non cancellabile) usare il colore del font uguale allo sfondo
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8. Constraints

1.  PRIMARY KEY: va definita la chiave primaria che permette un accesso molto rapido alle righe della tabella tramite la definizione e l’utilizzo di un indice sopra la chiave primaria (l’indice deve essere creato prima della chiave primaria; vedi anche dopo). Una chiave primaria deve essere ovviamente univoca, le sue colonne non possono contenere valori nulli e il numero di colonne deve essere minimale: non esiste un sotto insieme di quelle colonne che sia univoco. 

2.  UNIQUE KEY: possono essere create altre chiavi sulla tabella che devono essere univoche ma non per forza minimali e le cui colonne possono contenere anche valori nulli. In generale nella letteratura il valore nullo rappresenta l’indeterminazione, non è un valore, per cui due colonne nulle non risultano uguali. Questo succede anche in Oracle ma solo per le chiavi univoche composte da una sola colonna. Se si hanno invece COMPOSITE KEY (chiavi composte da più colonne) le colonne nulle risultano per Oracle uguali. 

3. CHECK CONSTRAINT: sono delle condizioni che posso imporre su una colonna o una combinazione di colonne. Riguardano sempre una sola riga di dati della stessa tabella e vengono validate all’inserimento o all’aggiornamento della riga stessa. L’esempio più comune di check è quello che dice che una colonna non deve contenere valori nulli (NOT NULL). Altri esempi: per un campo quantità si impone un valore sempre maggiore o uguale a zero, per un flag si impongono valori ammissibili, ecc.. Definire delle check permette di spostare il controllo dei dati sul server invece che sulla form in modo da appesantirla il meno possibile. Ovviamente è possibile definire più check constraints su una stessa colonna o combinazione di colonne.

4. FOREIGN KEY: sono anche chiamate REFERENTIAL CONSTRAINTS. Servono per definire il vincolo di integrità referenziale tra una tabella padre e una tabella figlio (Master/Detail) in modo che venga sempre controllato all’inserimento / modifica / cancellazione della riga figlio l’esistenza di quella padre. In particolare la primary key di una tabella padre (che quindi deve essere stata definita e in questo caso viene chiamata referenced key) viene ripetuta come foreign key di una tabella figlia. Un’opzione nella definizione della FK è la seguente: “ON DELETE CASCADE”. Se la FK è definita con questa opzione il record della tabella figlio vengono cancellati automaticamente al momento della cancellazione del record della tabella padre. In Oracle non esiste invece l’update cascade.

9. Da ERwin a Visio

Salvare il file ER1 come ERX format e poi importare in Visio Database Modeling.

10. Getting Started with ERwin 

10.1. Introduction 

ERwin is a popular data modeling tool used by a number of major companies in Omaha and throughout the world.  The product is currently owned, developed, and marketed by Computer Associates, a leading software developer.  The product supports a variety of aspects of database design, including data modeling, forward engineering (the creation of a database schema and physical database on the basis of a data model), and reverse engineering (the creation of a data model on the basis of an existing database) for a wide variety of relational DBMS, including Microsoft Access, Oracle, DB2, Sybase, and others. 

This brief tutorial steps you through the process of creating a data model using ERwin.   It will not explain all aspects of ERwin, but will show you the minimum necessary to create and use data models for this class.  It consists of three major segments, which correspond to the project-related assignments in your class: 

1. Creation of a basic data model (Conceptual data model) 

2. Creation of a database schema 
3. Creation of the database 

10.2. Section 1. Creation of a basic data model 

You will be creating a data model similar to that created for the Heartland Properties case study used in class.  The Entities involved in this model include:  Employee, Office, Property, and Inspection.   

First, invoke ERwin from Start->Programs->Computer Associates->All Fusion-> ERwin Data Modeler->  ERwin 

You will first encounter a dialog box entitled "ModelMart Connection Manager".  Simply click on Cancel. 

You will be asked to choose between creating a new model, and opening an existing model, as shown in Figure 1.  For this exercise, create a new model. 
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Figure 1: Create a new model 

The next dialog box, shown in Figure 2, will ask you to choose the template to be used to create the new model.  At this point, you may associate the model with a target DBMS product, such as Microsoft Access, Oracle, DB2, etc.  You will have the opportunity to change this choice later, but for now choose Microsoft Access.  Also, choose Logical/Physical as the new model type.  This choice will allow us to switch back and forth easily between a logical model (ER Diagram) and a physical model (database schema). 
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Figure 2: Selecting a model type 

ERwin will now display the main window from which most of your ER diagram development will be done, as shown in Figure 3. 

[image: image57.jpg]S Computer Associates ERs =10l x|
S Fle Edt Vew Fomat Model Modeert Tods Window el EET]

D5 H|8| &N 755 Q& . a0|D: oy || a5 2
[l o =B s gh.gmgﬂ.gwia&aa»; 0
mme pEn

5§ Model Sources
¥r Validation Rules
32 DefaltValues
T Trsnsoms
Enites

% Subiect Areas

. o]
BAvost [ @0 ] %D‘SW,

[Reads I e 7





Figure 3: The ERwin Workplace 

The ERwin workplace consists of two main parts.  On the left is the Model Navigator, which displays a hierarchy of items of importance, such as entities, domains, and subject areas.   On the right is the Display Window, which will show the ER diagram itself.  As you create objects, they will appear in the display window (if they are visual in nature, like entities), and appear in the hierarchy within the Model Navigator.   

7.1.1. Setting Preferences 

A tool like ERwin can accomodate a number of data modeling notations and conventions.   In my class please make the following changes to the preferences before you begin to create your model: 

1. From the Format->Entity Display menu, make sure that Primary Key Designator is checked 

2. From the Format->Entity Display menu, make sure that Foreign Key Designator (FK) is unchecked. 

3. From the Format->Entity Display menu, make sure that Show Migrated Attributes is unchecked. 

4. From the Format->Relationship Display, make sure that Verb Phrase is checked. 

In addition, you may choose between two different E-R diagramming notations.  In ERwin, click on Model->Model Properties to see the window shown in Figure 3b: 
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Figure 3b:   Choice of notation 

This tutorial is based on the Information Engineering ("Crows Foot") notation.  You may also use IDEF1X, if you wish. 

7.1.2. Creating an Entity 

To create a new entity, click on the entity icon ([image: image59.jpg]


) on the toolbar, or right-click on the word Entity in the Model Navigator.  If you click on the entity icon, you then should click on the Display Window where you would like the entity to appear, as shown in Figure 4. 
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Figure 4: A new entity 

Notice that the default name for the entity is E/x, where x is some number (2 in this case).  Click on the Tab key several times and notice what happens.  Pressing the tab key cause the focus to cycle between the three main parts of the Entity:   the name of the entity, the primary key attribute(s), and the non-primary key attribute(s).   In general, to modify one of these three parts of the entity, you will press the Tab key to cycle to the appropriate part of the entity, then type to add or modify that part of the entity.   

Right now, press the Tab key until the entity name is highlighted.  Then type EMPLOYEE, as shown in Figure 5. 
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Figure 5: Changing the name of the entity 

At this point, you may wish to save and name your diagram to avoid loss should the system or application crash. 

7.1.3. Adding primary key columns 

Once you have changed the name to EMPLOYEE, press the Tab key again to move the focus to the next part of the Entity, adding a primary key attribute.  Then type the name of the primary key attribute, Emp_Num, as shown in Figure 6. 
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Figure 6: Adding a primary key attribute 

Notice that because of the preferences you set earlier, the primary key attribute has a key icon next to it. 

Press the Tab key one more time to bring the focus below the horizontal line in the Entity, where you will add in a number of non-primary key attributes.   Type Emp_Fname, as shown in Figure 7.   When you have typed Emp_Name, press the Enter key (not Tab).   Notice what happens.  The cursor is now positioned for you to add another attribute in this same portion of the Entity, the non-primary key attribute portion.   
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Figure 7: Adding non-primary key attributes 

Continue adding the following non-primary key attributes: 

Emp_Lname
Emp_SSN
Emp_Street
Emp_City
Emp_State
Emp_Zipcode
Emp_Phone
Emp_Fax 

Your diagram should now look like Figure 8. 
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Figure 8: The Employee entity 

Repeat the entity creation process for the entities and attributes listed in Table 1. 

	Entity
	Attributes
	Entity
	Attributes

	OFFICE
	Office_Num (pk)
Office_Street
Office_City
Office_State
Office_Zipcode
Office_Name
Office_Phone
Office_Fax
	INSPECTION
	Insp_Date (pk)
Insp_Comments

	PROPERTY
	Prop_ID (pk)
Prop_Street
Prop_City
Prop_State
Prop_Type
Prop_Baths
Prop_Rooms
Prop_MonthlyRent
	MANAGER
	Man_Salary
Man_Car_Allowance

	
	
	ASSOCIATE
	Assoc_Hourly_Rate

	Table 1: Entities and Attributes 


Notice that some of the entities have no primary key attributes (Manager, Associate), and one entity has an attribute which is part of the primary key, but by itself does not constitute a primary key (Inspection).  As we add relationships to the diagram, the nature of the keys for these entities will become clear.  For the time being, be sure that there are no primary key attributes for Manager and Associate, and only one primary key attribute for Inspection, as shown in Figure 9. 
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Figure 9: Heartland Properties Entities 

7.1.4. Creating Relationships 

ERwin supports the creation of relationships with three basic kinds of connectivity:   one-to-one, one-to-many, and many-to-many.  Within the one-to-many category, ERwin allows us to distinguish between identifying and non-identifying one-to-many relationships.     

One-to-many Relationships 

We'll begin with two relationships, between Inspection and Employee and between Inspection and Property.  Inspection is related to both Property and Employee in one to many relationships.   Each Inspection is undertaken at one Property; each Property may undergo many inspections.  Each Inspection is carried out by one Employee; each Employee carries out many Inspections.  Are these relationships identifying relationships or non-identifying relationships?   The issue hinges on the nature of the primary key of Inspection, the entity on the "many" side of the relationship.  The primary key of Inspection in this example is a composite primary key consisting of two attributes: {Insp_Date, Prop_ID}  The business rule in effect here is that each property has at most one inspection per day.  One might argue whether or not that is a sound assumption, but lets suppose for the sake of illustration that it is.  Notice that the primary key of Inspection includes the primary key of Property, the entity with which it has a relationship.  For this reason, we say that the relationship between Inspection and Property is an identifying one-to-many relationship. 

An identifying relationship is created by clicking first on the identifying relationship icon ([image: image66.jpg]


).  Notice that it has the crow's foot notation (indicating "many") and a solid line (indicating identifying).   To create an identifying relationship, click first on this icon, then click on the parent entity (on the one side of the relationship) and then click on the child entity (on the many side of the relationship).   In this case, you will click first on the identifying relationship icon, then on Property, then on Inspection.  The results are shown in Figure 10. 
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Figure 10: An identifying relationship 

Notice that ERwin has provided a label "R/1" for the relationship, which is not very helpful.  Double-click on the relationship itself to bring up a dialog box in which we can further refine the relationship definition.   Fill out this dialog box as shown in Figure 11.   
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Figure 11: Relationships definition 

 In the Relationship: text box the relationship is presented in the form parent entity R/1 child entity.  The Verb Phrase portion of this box allows us to define the label to place on the relationship in place of R/1.   Since the parent entity is Property and the Child entity is Inspection, the Parent-to-Child verb phrase will read "Property Undergoes Inspection."  The Child-to-Parent verb phrase will read "Inspection Undertaken at Property."   

In the Relationship Cardinality portion of this window, we can determine how many child entity occurences may be associated with each parent entity occurence.  More specifically, "One Property Undergoes Zero, One or More Inspections."  Notice that at this point we are also able to define participation.   If each property had to have undergone at least one inspection in order to be stored in the database, then we could have forced mandatory participation by choosing the One or More option.   

Click OK to complete the relationship definition, as shown in Figure 12. 
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Figure 12: Finished relationship 

Notice that when an entity participates as the child in an identifying relationship it is modeled with rounded corners.  This notation is used for what in other data modeling tools is called a "Weak Entity".   

The relationship between Inspection and Employee is somewhat different.  It is a one-to-many relationship, but it is non-identifying, because the primary key of Employee is not part of the primary key of Inspection.  For such a relationship, we must click on the non-identifying relationship icon ([image: image70.jpg]


), which uses a dashed line instead of a solid line. 

As before, we click on the icon, then the parent entity, then the child entity.   Click on the non-identifying relationship icon, then the Employee entity, then the Inspection entity.   Double-click on the relationship to bring up the relationship definition window and fill it in as shown in Figure 13. 
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Figure 13: Non-identifying relationship definition. 

As before, we provide more meaningful verb phrases for the relationship.  As before, since each employee may be associated with zero, one or more inspections, we choose the corresponding cardinality.  Unlike before, when we chose the identifying relationship type, we have now chosen the non-identifying relationship type.  We have the option of indicating whether nulls are permitted or not.   This decision regards the participation of the parent entity in a relationship with the child entity.  In other words, does each child entity occurence (Inspection) have to be associated with a parent entity occurence (Employee)?   In this case, the answer yes.  Each inspection must be carried out by an employee, or it is not considered a proper inspection.  The participation of Employee in the relationship is mandatory.   

Click OK to complete the relationship definition, as shown in Figure 14. 
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Figure 14: Non-identifying relationship 

Employee and Office also participation in a relationship with each other.  Each Employee is assigned to one and only one Office, and each Office has one or more Employees. In this one-to-many relationship, Office is the parent and Employee is the child.  Since the primary key of the child (Employee) does not include the primary key of the parent (Office), this is a non-identifying relationship.  Click on the non-identifying relationship icon, Office, and Employee to create this relationship.  Double-click on the relationship and fill in the relationship definition window as shown in Figure 15.   
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Figure 15: A non-identifying relationship with mandatory participation 

In Figure 15, see an example of a relationship in which participation is mandatory for both entities.  The Cardinality indicates that each Office is associated with One or More (but not Zero) Employees.  The Relationship Type indicates that this is a non-identifying relationship, and that Nulls are not permitted.  In other words, each child (Employee) must be associated with a single parent (Office). 

Complete the relationships by creating a relationship between Office and Property in which each Office manages zero, one, or more properties, and each property is managed by one and only one Office.  Your diagram should now appear as shown in Figure 16. 
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Figure 16: Relationships 

7.1.5. Subtypes and Supertypes 

There are two kinds of employees we wish to distinguish between:  Managers and Associates.  Each of these two kinds of employees has all of the properties of Employee, but have in addition a small number of specific attributes.  Only managers have a salary and a car allowance.  Only associates has an hourly rate.  We can specify that Manager and Associate are subtypes of Employee.  To do this, we will use the subtype icon ([image: image75.jpg]


).   To indicate that Manager is a subtype of Employee, click first on the subtype icon, then on the supertype (Employee), then on the subtype (Manager).  The result appears in Figure 17. 
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Figure 17: Subtype relationship 

To include Associate as a subtype, click again on the subtype icon.  Now, instead of clicking on the supertype again, click on the subtype icon in the diagram between Employee and Manager.  Then, click on Associate.  The result appears in Figure 18. 
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Figure 18: The Final ER Diagram 

Finally, save your work.   You may now either exit ERwin, or proceed to the next section, entitled Creating a Relational Schema. 

11. Section 2: Creation of a Database Schema 

In this section you will learn how to create a database schema based on the E-R diagram you created in Section 1.  As you proceed through this section, you may either use the E-R diagram you created in Section 1, or you may download my section 1 E-R diagram. 

The section has two main parts.  First, we ensure that all fundamental (strong) entities have a primary key.  Second, we define the domain for each attribute.  Third, we let ERwin do the work of converting the E-R diagram into a relational schema. 

11.1. Assigning primary keys 

Fundamental entities are those that do not depend on any other entity for their primary key.  In particular, fundamental entities are not: 

· subtypes 

· associative (composite) entities 

· weak (attributive) entities.   

· entities at the 'many' end of an identifying 1-to-many relationship.  Actually, associative and weak entities are examples of this kind of entity. 

In our current example, our E-R diagram appears as in figure 2.1 
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Figure 2.1 E-R diagram 

Notice that MANAGER and ASSOCIATE do not have primary keys (they are subtypes).   The primary key of INSPECTION includes Insp_Date, but will also include Prop_ID, because the relationship INSPECTION undertaken at PROPERTY is an identifying relationship.  Our fundamental entities are:  EMPLOYEE, OFFICE, PROPERTY.  Each of these three has a fully defined primary key. 

11.2. Defining Domains 

The domain of an attribute is the set of values that attribute is permitted to have.  For example, the domain of an attribute Day_of_Week would consist of seven values:   {Monday, Tuesday, ..., Sunday}.  To define a domain we need to define: 

1. a datatype (mandatory).   Data types can be used to specify character string data, numbers (several flavors), date and time data, etc.  Every attribute must at least have a data type.   For example, Assoc_Hourly_Rate must be a decimal number with two decimal places.  Prop_Rooms must be an integer.   Emp_Fname must be a variable-length character string of up no more than 50 characters. 

2. constraints (optional).  For some attributes, the set of permitted values may be narrower than the set defined by the data type alone.  The attribute Day_of_Week is one example.  In our E-R diagram, several attributes have more narrowly defined domains.  For example, the value of Prop_Type must be in {Home, Apartment, Condo, Commercial}.  The value of Prop_MonthlyRent must be greater than $0.   

One of the attractive features of domains, aside from the enhanced data integrity they provide, is that domains can be shared by more than one attribute.   For example, the domains Emp_State and Prop_State are identical:  the list of 50 possible state codes.  In an E-R diagram, we can define the domain once, and apply it to multiple attributes.  The benefit of this is consistence across attributes and ease of maintenance.   If a new state were added to the Union, for example, we could modify Emp_State and Prop_State to accept the new state code ('PR' for Puerto Rico?) simply by making a single change to the domain definition itself. 

We will define all the domains we'll need in our E-R diagam first, then apply them to our attributes. 

7.1.6. Creating domains 

From the Model Menu option, choose Domain Dictionary.  You will see a window that looks like Figure 2.2 
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Figure 2.2 Domain Dictionary 

We'll first create a new domain that can be applied to numeric identifiers we'll use, such as Emp_Num, Prop_ID, and Office_Num.   Click on New... to create a new domain.  Type in Identifier as the name of the domain in the Logical Name column as shown in Figure 2.3. 
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Figure 2.3 New Domain 

Click OK to proceed.  You will return to the Domain Dictionary window and see that a new domain, Identifier, has been created, as shown in Fiure 2.4.   Click on the Data Type tab, and choose the INTEGER datatype for this domain.   
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Figure 2.4 Assigning a Data Type to a New Domain 

We'll now create another domain, State, to be used for Emp_State, Prop_State, and Office_State.   Do NOT click OK in the Domain Dictionary window.  Rather, click on New... again.  As shown in Figure 2.5, name this new domain State 
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Figure 2.5 The State Domain 

Click OK.  Choose the VARCHAR() datatype from the Data Type tab, and type in the number 2 inside the parentheses, as shown in Figure 2.6.   This indicates that the data type is a two-character string.  (Actually, CHAR(2) would be the most appropriate, but when the target database is Microsoft Access, ERwin doesn't properly associate CHAR() with the Microsoft TEXT datatype. 
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Figure 2.6 State Datatype 

We now need to specify the state codes that constitute valid values for this domain.  Click on the ellipsis (...) to the right of the combo box field labeled Valid:  You will see a window in which you can create validation rules, as shown in Figure 2.7. 
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Figure 2.7 Validation Rules 

We will create a new validation rule for the State domain.   Click on New... .  Name the validation rule State Codes as shown in Figure 2.8. 
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Figure 2.8 State Codes 

Click on OK.  You will come back to the Validation Rules window.  Here, click the radio button labeled  Valid Values List and begin typing in valid state codes in the Valid Value column, as shown in Figure 2.9. 
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Figure 2.9 Entering Valid Domain Values 

You will notice that ERwin builds a SQL IN clause listing the values you have specified.  When you have completed, click OK. 

Use a similar set of steps to create the domains with the data types and validation rules indicated in Table 2.1.  Be sure that the validation rule for the domain is either empty, or is the validation rule you want.  Sometimes ERwin will allow a validation rule created for one domain to be applied to the definition of a second domain without the user's involvement. 

	Domain name
	Datatype
	Validation rule

	Name
	VARCHAR(50)
	

	Street
	VARCHAR(100)
	

	City
	VARCHAR(50)
	

	State
	VARCHAR(2)
	Note:  Although State should be CHAR(2) for fixed-length strings, I think there is a bug in the software in which such data types will eventually get converted into the Byte datatype in Access.   This might be because Access doesn't have a proper fixed-length string data type.  Not quite what we want...

	Zipcode
	VARCHAR(10)
	

	Phone
	VARCHAR(15)
	

	Currency
	DECIMAL(9,2)
	Create a new validation rule called Currency with a Minimum value = 0

	SSN
	VARCHAR(11)
	Note:  This should be CHAR(11), but see the note above to understand why we are using VARCHAR(11) instead.

	Comment
	VARCHAR(255)
	

	Property Type
	VARCHAR(25)
	Create a new validation rule called Property Type with a list of valid values consisting of:  {Home, Apartment, Condo, Commercial}

	Date
	DATE
	

	Non negative Integer
	INTEGER
	Create a new validate rule called non negative integer with a Minimum value = 0

	Table 2.1 Domain creation 


When you are finished, the Domain Dictionary should show the domains you created, as shown in Figure 2.10 
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Figure 2.10 Domain List 

Click OK when you have completed. 

7.1.7. Applying Domains to Attributes 

The final step of working with domains is to associate a domain with each attribute.  To do this, double-click on one of the entities in your E-R diagram, such as EMPLOYEE.  You will see a list of attributes in the left-hand portion of the window, and a list of the domains on the right-hand side.  To associated a domain with an attribute, click first on the attribute, then click on the associated domain.  You will not receive any additional informational message that this association has been made.   For example, Figure 2.11 shows that the Emp_Num attribute has been associated with the Identifier domain. 
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Figure 2.11 Associated a Domain with an Attribute 

Associate each of the attributes in your E-R diagram with a domain, as instructed in Table 2.2.  Notice that the same domain may be used for more than one attribute. 

	Attribute
	Domain

	Emp_Num
	Identifier

	Emp_Fname
	Name

	Emp_Lname
	Name

	Emp_Street
	Street

	Emp_City
	City

	Emp_State
	State

	Emp_Zipcode
	Zipcode

	Emp_SSN
	SSN

	Emp_Phone
	Phone

	Emp_Fax
	Phone

	Office_Num
	Identifier

	Office_Street
	Street

	Office_Zipcode
	Zipcode

	Office_Name
	Name

	Office_Phone
	Phone

	Office_Fax
	Fax

	Insp_Date
	Date

	Insp_Comments
	Comment

	Prop_ID
	Identifier

	Prop_Street
	Street

	Prop_City
	City

	Prop_State
	State

	Prop_Zipcode
	Zipcode

	Prop_Type
	Property Type

	Prop_Baths
	Non negative integer

	Prop_Rooms
	Non negative integer

	Prop_MonthlyRent
	Currency

	Man_Salary
	Currency

	Man_Car_Allowance
	Currency

	Assoc_Hourly_Rate
	Currency

	Table 2.2 Attribute - Domain Association 


11.3. Converting an E-R Diagram into a Relational Schema 

The first stop in converting an E-R Diagram into a relational schema is to transform each entity and each relationship into its counterpart in a relational schema consisting of relational tables.  We have covered in class the rules for such conversions.  ERwin is easily able to manage this transformation based on those rules. 

From the Format->Entity Display menu option, make sure that the following three options are checked (and choose them if they are not): 

1. Primary Key Designator (should already be checked) 

2. Foreign Key Designator (FK) 

3. Show Migrated Attributes 

When these three are checked, the E-R Diagram should appear as in Figure 2.12 
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Figure 2.12 E-R Diagram Showing Migrated Attributes and Foreign Keys 

Notice that ERwin has automatically done the following: 

1. Foreign keys are used to reflect the one-to-many relationships.   Because ERwin automatically provides foreign keys when such relationships exist, any foreign keys created by the data modeler would not be redundant and would have to be deleted. 

2. Foreign keys that result from identifying relationships automatically become part of the primary key (see INSPECTION). 

3. Subtypes inherit the primary key of the supertype, and those primary keys also serve in a foreign key capacity. 

Finally, to transform the logical E-R diagram into a physical Relational schema, simply choose Physical instead of Logical in the combo box ([image: image90.png]


)at the top of the window shown in Figure 2.12.  The result is shown in Figure 2.13. 
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Figure 2.13 The Physical Relational Schema Model 

Notice that the datatypes, as defined in the domain definitions, are all clearly represented. 

In our final section, Section 3, we will examine how we can use ERwin to create a database in Microsoft Access (or almost any other DBMS) directly, based on our design. 

12. Section 3: Creation of the Database 

In this section you will learn how to create a physical database based on the relational schema developed in Section 2.  You may either use the schema you created, or download my Section 2 relational schema. 

This section has four parts.  First, we will check our relational schema to make sure that all the data types are as they should be.  Second, we will create an empty Access database to hold our database.  Third, we will use ERwin to generate a set of tables within the database that conform to our relational schema. Fourth, I we will see how we can use our very same E-R diagram to generate tables within Oracle. 

12.1. Checking the Relational Schema 

Before you go further, take a look at your relational schema to make sure that all of the data types and column names are as they should be.  This is particularly important in working with Access as a target database, because ERwin aparently mis-handles some of the data types.  For example, CHAR(2) is transformed into an Access BYTE datatype rather than the correct TEXT(2).   Figure 3.1 shows the Relational Schema from section 2. 
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Figure 3.1 The Physical Relational Schema Model 

The datatypes in this figure all appear to be appropriate.   

12.2. Creating the Empty Access Database 

The next step is to create an empty Access database into which ERwin will create tables.   Do this by using Access itself to create a blank database, as shown in Figure 3.2. 
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Figure 3.2 Creating a new, blank database 
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Figure 3.3 Creating a new database 

Create the database, but do not create any tables or other objects within it.   

Now, exit Access.   The database will remain as a file (Tutorial.mdb). 

12.3. Generate a New Database 

The final stage involves using ERwin to generate a new database based on the relational schema. 

From the Tools menu, choose Forward Engineer/Schema Generation.  You will see a window like that in Figure 3.4 
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Figure 3.4 Schema Generation 

At this point, we will stick with the default settings and go right to the schema generation step.  This window, however, is the place one could specify in some detail what kinds of objects will, or will not, be included in the schema generation process. 

Click on Generate... 

At this point you will see a window that prompts you for information necessary to connect to the Access database you just created, shown in Figure 3.5. 
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Figure 3.5 Acces Connection 

You should type in ADMIN as the User Name, and Browse... to find the database you created in the previous step. 

When you have made these two entries, click Connect 

At this point, ERwin goes off and creates the tables and associated database objects.   If all goes well, you will see a window such as the one shown in Figure 3.6, indicating the results of the schema generation. 
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Figure 3.6 Schema generation 

Finally, go back and open up the Access database you created earlier.  As Figure 3.7 indicates, your database has now been populated with tables that conform precisely to the database schema created in the previous section.   

Congratulations!  You may now proceed to add Forms, Queries, Macros, etc. to implement the rest of your database application (ERwin doesn't help you with that.) 
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Figure 3.7  The Access Database 

12.4. Targeting a different DBMS 

What if you really want to create an Oracle database, not an Access database?  You may do so, based on the very same E-R diagram you created before.  There are three steps: (1) Generate a new Physical Model with a different database as the chosen target, (2) Generate a database in a fashion similar to that described above. 

Return back to the Logical E-R diagram developed in Section 1, shown in Figure 3.8. 
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Figure 3.8 The Logical database model 

From the Tools menu, choose Derive New Model 

You will see a window like the one shown in Figure 3.9.[image: image100.png]Derive New Model
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Figure 3.9 Derive New Model 

In the section labelled New Model Type, make sure Physical is chosen.   In the section labelled Target Database choose, in place of Access 2000, Oracle 8x. 

Click Next> .   The window shown in Figure 3.10 displays the objects in the logical model that are to be included in the new physical model. 
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Figure 3.10 Derive Model 

If the items in the Auto-Transform Logical Objects section are not checked, then check them.  This will ensure that any many-to-many relationships are transformed into a new table and that subtypes properly inherit the primary keys of their supertypes. 

Click Next> 

You will now see a window dealing with logical to physical name conversion (Figure 3.11).  Since our physical database is to have column and table names that are the same as the attribute and entity names in our E-R diagram, we need make no changes.   
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Figure 3.11 Logical to Physical Name Conversion 

Click Finish. 

You will now see (Figure 3.12) a new physical model with the same table and column names as before, but the datatypes have now been mapped to Oracle datatypes. 
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Figure 3.12 The Physical Data Model based on Oracle datatypes. 

As before, choose Forward engineer/generate schema from the Tools menu.   

At this point, to keep things simple, indicate that ERwin should generate only the tables, views, and the primary keys.  In particular, un-check all the Triggers (Shown in Figure 3.13).  Also, uncheck Create Procedure, which is one option in the Schema, View, and Table items shown in this figure.  The simpler the schema, the more easily it will be created within Oracle. 
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Figure 3.13 Oracle Schema Generation Options 

If you click on the Preview... button, you can see the SQL that ERwin will generate to create your tables in Oracle. 

When you are ready, click Generate... 

ERwin will prompt you for the necessary information to connect to the Oracle database (Figure 3.14).  Here at PKI, you must type in your Oracle username, password, and connect string.   Notice that this information is different from that you provided to connect to Access (as it should be). 
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Figure 3.14 Connecting to Oracle 

With any luck, the database  tables are now created within your Oracle account. 
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Figure 3.15 Oracle tables created. 

13. ERWIN FAQ

Da http://esupport.ca.com/index.html?/public/erwin/infodocs/erw_faq.asp 

	AllFusion ERwin Data Modeler

	Connection
	

	Date
	Question and Answer
	

	09/27/04
	Product: AllFusion Erwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q: When I connect to AllFusion Model Manager and choose Open, I get a list of libraries and models, but no Subject Areas. I can see the Subject Areas in the Subject Area manager. Why is this?
A: Disconnect from the AllFusion Model Manager and close AllFusion ERwin Data Modeler. Do Start/Search or Start/Find and locate a file called erwin40.ini that typically resides in the WINNT folder. Rename this file to ERwin40.old. Launch AllFusion ERwin Data Modeler again, reconnect to AllFusion Model Manager, and choose Open. The Subject Area(s) should now appear.
	

	09/13/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: After I open a model in AllFusion Model Manager on MS SQL Server, I get the error: "unable to open query connection to repository ModelMart," followed by another error: "NULL DBPROCESS pointer encountered."
A: The network communication to MS SQL Server database has been interrupted in some way. Try rebooting and re-connecting to see if this resolves the problem. If not, ask yourself what has changed since you last connected? Have you add/removed any software?
	

	03/30/04
	Product: AllFusion ERwin Model Manager
Version: 4.1, 4.1.4
OS: Windows
Q: When attempting to connect to Model Manager on an Oracle database, I am receiving a message of "Version is not compatible". How do I find the version of Model Manager? 
A: Using the SQL Plus editor in Oracle, run the following query against the MMAPPLICATION table in your MM database. 

Select APPLICATIONNAME, BUILDNUMBER from MMAPPLICATION;

This will show the Model Manager build number.
	
	
	
	

	01/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q; I am trying to connect to Model Manager 4.1.4 and getting an error "Unable to locate a ModelMart. Please check that your ModelMart master database is specified correctly".
A: Check the version on your Oracle connectivity software. If your client is Oracle 8.1.6 client, there is a known incompatibility between ERwin 4.1.4 and Oracle 8.1.6. This is under review for inclusion in the next Service Pack, but the simple workaround for now is to simply upgrade to the Oracle 8.1.7 connectivity client. Even if you are still using Oracle 8.1.6, the 8.1.7 client will work with 8.1.6.
	
	
	
	

	User Defined Datatype (UDT)
	
	
	
	

	Date
	Question and Answer
	
	
	
	

	10/08/02
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: I was trying to match the physical names to the logical names, used Reset in the Attribute Editor for the Name and the attributes name and the column names, and they all changed to their Domain names. Why did that happen? Also, is it possible to match the physical names to corresponding logical names?
A: In ERwin, each and every attribute and column is associated with a Domain. If you check the Domain dictionary, you will notice that the default for the “Name Inherited by Attribute” is %AttDomain and for “Name Inherited by Column” is %AttName. So if the Reset is done at the Physical level, the Column is reset to its logical counter part (%AttName). If the Reset is done in the logical side, it is reset to the domain it is associated with (%AttDomain). So, it is possible to match the physical names to the logical names but the Reset needs to be done at the Physical Level. The flow is only one way - from logical to physical, so logical names cannot be reset to match the physical names.
	
	
	
	

	10/08/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows 
Q: If the display is set for dataypes, it shows domains on the physical side. If the display is set for both, domains and datatypes, the domain is displayed twice. This is not occurring for default domains and is seems to be SQL Server, Sybase and DB2 related. Why so?
A: It is because of the User Defined Datatypes (UDTs). Domains in ERwin are same as Domains in SQL Server, Sybase and DB2. These are defined once and attached to a number of columns and are, therefore, reflected accordingly. This is why it happens only for the User Defined Datatypes or Domains. If you want to see the actual datatypes go into the Domain Editor, select the Domain, go to the General tab, uncheck the option to generate the domain as a user defined datatype (SQL Server-User Datatype, DB2-Distinct Type, etc.). Oracle has a different way of implement it (Create Type…) which is not presently supported so Oracle models do not have thisdisplay. It also impacts the way schema is generated.
	
	
	
	

	Database

	Date
	Question and Answer
	
	
	
	

	03/30/04
	Product: AllFusion ERwin Model Manager
Version: 4.1, 4.1.4
OS: Windows
Q: I am MMADMIN and when I try to save a model into my AllFusion Model Manager, I get the error: "ORA-01536: quota of space exceeded for tablespace 'XXXXXXXX'", but the Quota for the tablespace "XXXXXXXX" is set to Unlimited. Why?
A: As the installer, MMADMIN, you were probably granted DBA privileges to install the AllFusion Model Manager but those DBA privileges have since been revoked. The unlimited quota needs to be granted to MMADMIN. The other users should not need unlimited quota.
	
	
	
	

	11/25/02
	Product: ERwin
Version: 4.0, 4.10
OS: Windows 
Q: What is this forward compatibility option? Will it allow me to open a file saved in a later version even if I am using an earlier version?
A: AllFusion ERwin Data Modeler 4.1-Service Pack 1 includes a forward-compatibility feature that enables you to open 4.1-SP1 models in the 4.1-GA version of the software. This feature will be carried forward to future releases of the software so that it will be easier to share files between machines that are running different versions of ERwin Data Modeler.

For this release, the forward compatibility feature applies to files created in version 4.1-GA and 4.1-SP1. You can use either release of the software to read ER1 files. In previous releases, attempting to open an ER1 file from the latest release in an earlier version of the software resulted in a compatibility error. The exception to this rule is when there is a file format change between the two versions, in which case it will not be compatible. To use this feature, copy the file ForwardCompat.txt from the 4.1-SP1install directory to the install directory of the machine running 4.1-GA.

Each new release of ERwin Data Modeler will provide a version of ForwardCompat.txt that records information about new object and property types.
	
	
	
	

	09/13/02
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Reverse Engineering or Complete Compare with DB2 OS 390 takes quite long. Is there any suggestion to improve the performance on this? Does creating Alternate Catalog help?
A: Alternate catalogs have been known to improve the performance significantly. With 4.x, ERwin provides the choice to select either System or Alternate catalog.
	
	
	
	

	V4.0 SP3 and V4.1

	Date
	Question and Answer
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Is ERwin Data Modeler 4.1 the latest release?
A: Yes, ERwin Data Modeler 4.1 is the latest release of this product.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: What patch level is ERwin Data Modeler 4.0 SP3?
A: Patch 1711.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Why was ERwin Data Modeler 4.0 SP3 released after ERwin Data Modeler 4.1?
A: ERwin Data Modeler 4.0 SP3 is cumulative maintenance of this release. This is targeted for customers already using ERwin Data Modeler 4.0. Support was responsible for delivering this Service Pack, whereas, ERwin Data Modeler 4.1 was delivered by the Development organization, as the subsequent GA release of ERwin Data Modeler. The release date of ERwin Data Modeler 4.1 was planned prior to the release date of ERwin Data Modeler 4.0 SP3.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Are there any differences in maintenance fixes between ERwin Data Modeler 4.1 and ERwin Data Modeler 4.0 SP3?
A: Yes.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: What are the differences in maintenance fixes between ERwin Data Modeler 4.1 and ERwin Data Modeler 4.0 SP3?
A: All of the problems addressed in ERwin Data Modeler 4.0 SP2 are included in ERwin Data Modeler 4.1. There are some problems that have been addressed in ERwin Data Modeler 4.0 SP3, but are not included in ERwin Data Modeler 4.1. Please review the document titled "Fix List Comparing 4.0 SP3 and 4.1" which can be found at http://esupport.ca.com/public/erwin/infodocs/erw_1001.asp.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Why are there differences in maintenance fixes between ERwin Data Modeler 4.1 and ERwin Data Modeler 4.0 SP3?
A: During any Development cycle, there comes a time when the code for a prospective release needs to be "frozen". By "frozen" we mean no new code changes are made. This allows the Quality Assurance group to test a version of the software that does not change. After this point, the only code changes allowed are to address any regression issues found during the QA cycle.

While Quality Assurance is testing the prospective new release, maintenance is still ongoing for the current supported releases. As a result there are problems that get resolved in the current supported releases, but do not get included into the new release at the time of GA. The fixes for these problems are referred to as "Gap Fixes".
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: When will the "Gap Fixes" from ERwin Data Modeler 4.0 be included in ERwin Data Modeler 4.1?
A: ERwin Data Modeler 4.1 SP1 will include all of the "Gap Fixes" from ERwin Data Modeler 4.0 SP3.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: What is the current expected release date for ERwin Data Modeler 4.1 SP1?
A: ERwin Data Modeler 4.1 SP1 is planned for release in the beginning of Q4, calendar year 2002.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Now that ERwin Data Modeler 4.1 is available, will CA be providing additional service packs for ERwin Data Modeler 4.0?
A: No. ERwin Data Modeler 4.0 SP3 is the last service pack for ERwin Data Modeler 4.0. However, patches for ERwin Data Modeler 4.0 will continue to be made available up until the release of ERwin Data Modeler 4.1 SP1.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Are the .er1 files compatible between ERwin Data Modeler 4.0 SP3 and ERwin Data Modeler 4.1?
A: ERwin Data Modeler .er1 files are upward compatible. As a result, you can open ERwin Data Modeler 4.0 .er1 files in ERwin Data Modeler 4.1. However, ERwin Data Modeler 4.1 .er1 files cannot be opened using ERwin Data Modeler 4.0. Therefore, it is recommended that you backup your ERwin Data Modeler 4.0 .er1 files prior to using ERwin Data Modeler 4.1.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Is ERwin Data Modeler 4.0 compatible with Model Manager 4.1?
A: No, you must use ERwin Data Modeler 4.1 with Model Manager 4.1.
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Should I use ERwin Data Modeler 4.0 SP3 or ERwin Data Modeler 4.1?
A: The points below should help you make an informed decision as to which release you should use at this time. 

  If you plan to use Model Manager 4.1 (formerly known as ModelMart), then ERwin Data Modeler 4.1 is the version for you because Model Manager 4.1 support is compatible with ERwin Data Modeler 4.1. 

  If you do not plan to use Model Manager 4.1, then you can remain using ERwin Data Modeler 4.0 SP3 until ERwin Data Modeler 4.1 SP1 is available. 

  If you are interested in using one of the new features within ERwin Data Modeler 4.1, such as Oracle 9i support, then you should use the ERwin Data Modeler 4.1 release. However, you should refer to the attached documents above to understand what problems are not yet addressed in ERwin Data Modeler 4.1, but are included in ERwin Data Modeler 4.0 SP3. As mentioned above these problems will be included in ERwin Data Modeler 4.1 SP1. 

  If you do not need the new features in ERwin Data Modeler 4.1, then you can remain using ERwin Data Modeler 4.0 SP3 until ERwin Data Modeler 4.1 SP1 is available. 
	
	
	
	

	07/22/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: What if I have other questions regarding the differences between ERwin Data Modeler 4.0 SP3 and ERwin Data Modeler 4.1?
A: Visit us at http://esupport.ca.com/. You can call us via the phone number listed under Contact Us, or you may open an issue via StarTCC. We will be glad to help with any other questions or concerns that you may have.
	
	
	
	

	Database Compare 

	Date
	Question and Answer
	
	
	
	

	03/06/02
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: Complete Comparing with Oracle database shows differences in constraints. Why?
A: ERwin allows check constraints to be defined at both the table and column level. Oracle does not differentiate check constraints in this way and stores all of them in a single system table. When ERwin reverse engineers an Oracle check constraint it will classify it as a table level constraint if the rule applies to more than one column. If only a single column is referenced ERwin will consider it a column level constraint. This process can lead to what appears to be incorrect differences when using Complete Compare. If a TABLE level constraint is defined which only refers to a single column, and this constraint is forward engineered to an Oracle database, ERwin will consider it a COLUMN level constraint during reverse engineering and fail to match it to it's original definition. This can be avoided by defining single column constraints as Column level check constraints; this provides the added benefit of allowing you to use ERwin macro language substitution to provide the column name in the definition of the constraint.
	
	
	
	

	File I/O

	Date
	Question and Answer
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Can I open models created by AllFusion ERwin DM 4.1 SP2 in AllFusion ERwin DM 4.1 SP1 or GA?
A: Yes. Starting with SP2, the Forward Compatibility feature lets you open AllFusion ERwin DM models created with SP2 and above with SP1. You will need the ForwardCompat.txt file for the later version. This may be found in the install directory of later versions or you may contact technical support to get the latest version of the file. Place the file in the install directory of your current AllFusion ERwin DM version.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Can an AllFusion ERwin DM 4.1 .er1 model be opened in AllFusion ERwin DM 4.0?
A: No, due to a file format change in AllFusion ERwin DM 4.1. A work around is to save the AllFusion ERwin DM 4.1 .er1 file as an ERwin 3.5.2 model and that model can be opened in AllFusion ERwin DM 4.0.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: I am using AllFusion ERwin DM 4.1 SP2, but some people in my group are still using SP1. Can we share files?
A: Yes. Files can be shared if you do the following: Copy the ForwardCompat.txt file from the current AllFusion ERwin DM build to the folder of the older AllFusion ERwin DM build. By doing this you are giving the older version of AllFusion ERwin DM the information it needs to open up files from the newer version of AllFusion ERwin DM.
	
	
	
	

	09/30/02
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: When I open a diagrams with File | Open, I get the error message “Couldn’t Open Input File”, but when I open diagrams by double-clicking on the .er1 file in Windows Explorer or a folder it opens without an error. The same build is launched when the diagram does open by double-clicking. What's the difference?
A: ERwin cannot load a diagram if the complete path leading to it is over 99 characters long. This usually happens if the folder is embedded six or more folders deep with each folder name adding to the characters to the path. This has been addressed and the fixed in ERwin 4.1 SP1.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 4.0
OS: Windows 
Q: I am using ERwin 4.0 SP1 (Build 1511), I cannot open this specific .er1 file but can work with a new or some other files. What could be the reason?
A: There was a file format change between the two service packs. As a result, the .er1 files saved in Builds 1687 (SP2) and later cannot be opened from Build 1511 (SP1). The solution is to upgrade to SP2.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 4.0
OS: Windows 
Q: I can launch ERwin, but I can't open a diagram. Clicking File | Open causes ERwin to crash. Why?
A: There may be an illegal value in your ERwin40.INI file. Rename you ERwin40.ini file to ERwin40.old and then re-launch ERwin. A new .ini file is automatically recreated when the application is subsequently closed.
	
	
	
	

	Migration

	Date
	Question and Answer
	
	
	
	

	10/22/02
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.1
OS: Windows
Q: In 3.5.2, if a relationship was marked logical only, the attributes still migrated to the child table. It was helpful if the column was required without the baggage of FK constraint and/or RIs. In 4.x, the same scenario does not bring in the column to the child table. Why this change? Also, is there any alternative to accomplish it?
A: FK migration is because of the relationship. If the relationship is marked logical only, theoretically it implies that the migration is not required. This is why the change was made from 3.5.2 to 4.x for accurate representation. For the situations where the column is required without the relationship, in 4.x, there is a Column Denormalization transform. You can use this transform to migrate a column from one table to another without any relationship.

To keep 4.x in sync with 3.5.2, a change has been made with ERwin 4.1 SP1 (Build 2522). There is now an option either to display the FK migration or not. This option in ERwin 4.1 SP1 can be found in Format | Preferences under the Display tab. You can still use the Column Denormalization transform if you choose to.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: Which build of 3.5.2 is compatible with ERwin 4.0?
A: ERwin 4.0 was tested with ERwin 3.5.2 Build 466 (SP3) which was available over six months prior to the release of 4.0. Diagrams from earlier versions of 3.5.2 can be opened with 4.0, but it is highly recommended to first save your diagrams in SP3 of ERwin 3.5.2 before opening those in 4.0.
	
	
	
	

	Database Connectivity

	Date
	Question and Answer
	
	
	
	

	05/26/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: WINDOWS
Q: When trying to Connect to an Oracle Server I receive the error message 'ORA-01041: internal error, hostdef extension doesn't exist'. Why?
A: While this ORA-01041 error can be generic, one of the reasons could be that the particular service in the Server has not been started. Go to Control panel->Administrative tools->Services->make sure that particular service is started.
	
	
	
	

	02/06/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: WINDOWS
Q: I installed Sybase Client Software but when trying to connect to the database (v 11.x or 12.x) from AllFusion ERwin DM, get an error 'Unable to find all Sybase library functions'. What could be the reason?
A: One reason could be the incorrect library selection. Make sure that you are using the compatible library - 'ctlib' is the default and is the general choice in the database. This selection is found under the Library section in the Database | Choose Database menu (4.x) or Server | Target Server (3.5.2).
	
	
	
	

	01/06/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: WINDOWS
Q: What might be a cause of a problem connecting to SQL Server remotely?
A: Install SQL Server client software. If the you do not know whether it is installed or not, search NTWDBLIB.dll under System32 or Bin directory depending on the OS installed. This dll will be added when client software is installed.
	
	
	
	

	01/06/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: WINDOWS
Q: I am connecting to Oracle, DB2, etc. and specifying Owner, Tablespace or Database Names, and AllFusion ERwin DM is not retrieving any Tables. Why?
A: Starting with 4.1 SP 1 build 2522, Owner, Tablespace and Database Name fields for Reverse Engineer and Complete Compare are Case Sensitive.
	
	
	
	

	01/06/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: WINDOWS
Q: When will I be able to use NT authentication for SQL Server 2000?
A: This enhancement has been implemented in AllFusion ERwin Data Modeler 4.1.4.
	
	
	
	

	01/06/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: WINDOWS
Q: When Reverse Engineering from Oracle, I receive the following error: Ora-03113: End of file on communication channel. What should I do?
A: Create an environment variable called NLS_LANG set to a value with the following convention:

NLS_LANG = LANGUAGE_TERRITORY.CHARACTER_SET

select * from v$nls_parameters where PARAMETER = 'NLS_CHARACTERSET';

select * from v$nls_parameters where PARAMETER = 'NLS_LANGUAGE';

select * from v$nls_parameters where PARAMETER = 'NLS_TERRITORY';
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Does AllFusion ERwin Data Modeler 4.1 support Windows Authentication when logging onto an MS/SQL Server database?
A: Windows Authentication is supported beginning in AllFusion ERwin Data Modeler 4.1.4.
	
	
	
	

	11/05/02
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Using AllFusion ERwin Data Modeler 4.1 SP1 (Build 2522), when connecting to Oracle (even some other databases), the user name is now case sensitive. It was not so until now. Why this change?
A: This is to address the situation where there are two users in the database with the same user id but different case (e.g. JOHN and John). ERwin used to convert it to ALL CAPS to match Oracle's system of storing it as ALL CAPS unless it is within quotes. However, if there were a user with a lower or mixed case, ERwin's query would have missed it as the Owner name was always converted to ALL CAPS. With this change, implemented with Allfusion ERwin Data Modeler 4.1, SP1, it is now possible to query the user with case sensitivity.
	
	
	
	

	09/23/02
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows
Q: I get “CT_ALLOC_..” error when connecting to Sybase from ERwin. What could be the reason?
A: The most likely reason is multiple connections to the database. Disconnect all connections and try to reconnect. In some cases rebooting may be required, as it will clear up any residue from the previous connections.
	
	
	
	

	08/23/02
	Product: AllFusion Model Manager
Version: 3.5.2, 4.1
OS: WINDOWS

Q: I have SQL Server set with WIndows NT security setup but cannot connect to the database from ERwin. What could be the reason?

A: ERwin and ModelMart as yet do not support NT authentication. The workaround is to set another account using the SQL Server or Both connectivity option.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: To What DBMS does ERwin connect natively (direct)?
A: ERwin can connect directly to Oracle, Sybase SQL Server, Microsoft SQL Server, Informix, and SQL Base.

For all native (direct) connections, the appropriate networking software, such as TCP/IP, must be installed on the workstation. DBMS client software is available from the DBMS manufacturer and must also be installed. DBMS client software is not packaged with ERwin.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: When connecting to Oracle 8.x, I get the dialog box and enter the user name, password and connect string. Clicking on Connect does not get me connected and the dialog box never goes away. What could be the reason?
A: The problem for this could be the missing oci.dll. Please find this DLL and copy it in to $ORACLE_HOME/bin directory. It should take care of the problem.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: What is the User Name and Password to connect to a local copy of Access which has no particular security applied?
A: UID is Admin, pwd is null.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: What DBMS' does ERwin connect to using ODBC middleware?
A: ERwin connects to the following targets through an ODBC driver:

  DB2 (Used with IBM DB2 Connect) 

  Rdb 

  Watcom 

  INGRES 

  AS/400 

  Netware SQL 

  Clipper 

  FoxPro 

  DBase 

  Paradox 

  Progress 

  Teradata 

  Red Brick 

  Interbase 

  HiRdB 

  Informix (in conjunction with Informix client) 

Once an ODBC driver is installed, an ODBC data source must be created. An ODBC data source is a logical name for a specific database location. The ODBC data source is the database name chosen from the drop down list box in the ERwin connection dialog box. Complete instructions for creating an ODBC data source can be found in the ERwin Reference Guide.
For more information concerning installing and configuring ODBC please refer to the ODBC driver installation manual and/or your system administrator.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: What do I need to connect to Oracle?
A: 

  Net8/Net8i/SQL*NET version 2.x (for Oracle version 7.3) installed and configured along with all support files and network adapters 

  The $ORACLE_HOME/BIN for your operating system should be in the path. For example, for Windows (16bit) it is \ORAWIN\BIN, for Win95 it is \ORAWIN95\BIN, and for NT it is \ORANT\BIN. 

  An [ORACLE] section in the WIN.INI file that points to the ORACLE.INI file in the \WINDOWS directory. 

For more information refer to the Oracle SQL*NET manuals and/or your system administrator.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: How can I tell if the connection software is already installed?
A: Guidelines to help you diagnose whether or not your connection software is installed can be found below. If you are having difficulty connecting to your database with ERwin, if you do not remember installing the client software previously, if you have not connected previously, or if you cannot find these key files in the appropriate directories, then you probably need to install client connection software. The guidelines below, however, are no substitute for the documentation supplied by the manufacturer of your connectivity software or the invaluable help that can be provided by your DBA or System Administrator.

If you find that your connection software is not installed, please use the installation program that comes with the connection software. Attempting to install connection software by copying files to this or that directory in response to error messages from ERwin is almost always ineffectual and frustrating.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: How do I install the connection software?
A: Use the install program supplied by the manufacturer of the client connection software.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: Does ERwin include connection software?
A: ERwin, like most SQL enabled products, relies on external "middleware" to connect to your DBMS. ERwin itself does not ship with connection software for supported databases
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: How Does ERwin Connect to my Database?
A: ERwin connects to your database via native DBMS connection software or through Windows ODBC standard drivers. Which software is required for which database can be found in the ERwin on-line Help|Topic Index section "Connecting ERwin to a DBMS". The manufacturer of your DBMS typically supplies native client connection software. ODBC drivers may be obtained from your DBMS manufacturer, Microsoft, or a third party driver manufacturer such as Intersolv. Please note in this section that odbc.dll indicates that you will be connecting via ODBC. The actual required ODBC file icon your system will have a different name. Those drivers used in testing ERwin can be found below.
	
	
	
	

	API

	Date
	Question and Answer
	
	
	
	

	09/13/04
	Product: AllFusion Erwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I register XML4ERwin.dll, so I can save or open XML files?
A: Go to start - run. Type in regsvr32.exe and put the path and file name for XML4ERwin.dll.

Example Command: regsvr32.exe "C:\Program Files\CA\AllFusion ERwin Data Modeler\XML4ERwin.dll" 

Note: To have the correct path and filename, you should drag the XML4ERwin.dll file to the command line of the run box, after the command: regsvr32 (or regsvr32.exe). 
	
	
	
	

	09/13/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I register Scapi.dll, so I can use Erwin API or Connect to ModelMart/Model Manager, etc.?
A: Go to start - run. Type in regsvr32.exe and put the path and file name for scapi.dll.

Example Command: regsvr32 "C:\Program Files\CA\AllFusion ERwin Data Modeler\scapi.dll"

Note: To have the correct path and filename, you should drag the scapi.dll file to the command line of the run box, after the command: regsvr32 (or regsvr32.exe). 
	
	
	
	

	02/06/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows

Q: Where can I find API Documentation?
A: For Erwin 3.5.2, you can look at:
http://www.ca.com/products/alm/erwin/companion_products/download1.htm.
For AllFusion ERwin 4.X, go to http://esupport.ca.com/premium/erwin/manuals/erwindm-docmenu.asp or look in the Erwin/Doc directory, which is typically: C:\Program Files\CA\AllFusion ERwin Data Modeler\Doc, and look at the files, ERwinAPI.pdf, and ERwinAPI_Readme.html.
Also you will find information under FAQs for Erwin, on http://SupportConnect.ca.com. Look under the API Category.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: When using the Locator Property string for a Persistent unit example in the AllFusion ERwin DM API documentation, I cannot get the locator string figured out properly. I tried: "mmart://mm1/PRODUCTION-DB2G/CCMNWD1-NWB?SRV=SPRDEV;USR=GCE335;PWS=MyPWD", but the locator string is not being parsed correctly. Why?
A: There is an error in the documentation. On page 4-19 it should use UID instead of USR as an abbreviation for USER locator parameter. Hence, the correct string should read: "mmart://mm1/PRODUCTION-DB2G/CCMNWD1-NWB?SRV=SPRDEV;SRT=Oracle Vers. 8.xx/9i;UID=MyUSer;PSW=MyPwd;"
	
	
	
	

	04/07/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: Is it possible for a model to be opened, changed and saved without creating a lock upon it?
A: It is a fact that ModelMart is by design a multi-user system, similar to databases. For this reason, it is not possible to let such system work without mechanism to prevent corruption of resulted model. This is why the only way to open a model without applying an exclusive lock to it is to open a model as read-only. An exclusive lock is a lock that restricts access to a model to only one client. As a result, the exclusive lock only allows opening a model when nobody else has it open and it locks everyone else from accessing the model for modification for duration of the lock. The reason is that ERwin API does not have programmatic mechanism to resolve possible conflicts that could happen in the process of checking changes in ModelMart. ModelMart, on other hand, has Change-Control Manager to perform such task.
	
	
	
	

	04/07/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: Is possible to know if other Model Manager user locks a stored model?
A: There is no flag that warn in advance, but if there is a lock then Add on a persistence unit collection will fail with a specific error code.
It is possible to add such information in a property bag of a model directory unit, but there is none at the moment.
	
	
	
	

	04/07/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: In ERwin XML, Erwin4/Model/ModelProps there is a value called Target_Server. In my example which is a physical model for SQL Server 7.0 the value is set at 172 I would like a table of the possible values for this field.
A: Here is a list we maintain to track enumerated values for XML output. The first page includes the values for the target server. Our hope is to eventually provide a complete list of all the relevant values with the API Reference Guide on in the online help. Hope this is of some help. 

Target Server
ID
Target Server
NameProp Text
Major
Version
Major Version
Text
Minor
Version
170

DB2

4
5
6
7

DB2/MVS 4
DB2/OS390 5
DB2/OS390 6
DB2/OS390 7

0
0
0
0

172

SQL Server

6
7
8

6.5
7.0
2000

0
0
0

173

SYBASE

11
12

11.x
12.5

0
5

174

ORACLE

7
8
8
9

7.3
8.x
8.1
9.x

3
0
1
0

175

OpenIngres

2
2
2
6

2.0
2.5
2.6
6.4

0
5
6
4

176

SQLBase

6
5

6.x
5.0

0
0

177

dBASE IV

0

1.5

2

179

INFORMIX

7
9
9

7.x
9.1x
9.2x

0
0
2

181

FoxPro

6

6.x

2

182

Clipper

0

 

2

183

Rdb

7

7

0

185

SQL Anywhere

5

SQL Anywhere 5

0

186

Access

8
9

97
2000

0
0

187

Paradox

7

7.x

0

188

Progress

8

8.x

0

189

AS/400

4

4.x

0

190

TERADATA

2

2.x

0

191

Red Brick

5

5.x

0

192

DB2/UDB

11
12
13

DB2/UDB 5
DB2/UDB 5.2
DB2/UDB 6.1
DB2/UDB 7.1

0
2
1
1

193

InberBase

0

5

2

194

ODBC/Generic

2
3

2.0
3.0

0
0

195

HiRDB

0

4.x

2

196

SAS

0

 

2


	
	
	
	

	04/07/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: Could you, please, provide a list of Entity types?
A: The following is a list of Entity types for your information: 

Entity types:

Independent entity

1

Dependent entity

6

View

17

Summary or Materialized

21

 

Subtype symbol types. (Entity model object represents these symbols in a model):

Complete subtype (IE & IDEF1X notations)

3

Incomplete subtype (IE & IDEF1X notations)

8

Inclusive subtype (IE notation only)

18

Inclusive incomplete subtype (IE notation only)

19

 

Obsolete type:
Texnote

5


	
	
	
	

	03/27/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: How does ERwin API report errors?
A: ERwin API utilizes the automation error object to report an error message. This is the standard way to communicate an error to an automation client.
How this error processed by a client is the language specific. For instance, if the client is C++ code that invokes an interface method directly, hence able to process HRESULT value, there is no exceptions thrown. Error related data such as error description, error code, etc. are made available via error object. The object is maintained by COM environment on the logical thread and available via IsupportErrorInfo interface. The interface is exposed by all API components.
For a C++ client that uses Microsoft Visual C++ #import directive, the compiler generates a set of COM client wrapper classes. These classes employ an exception mechanism to report an error.
Visual Basic has dedicated Err object. If an error condition has arisen than the object is populated and the outcome depends on the active On Error directive.
A result that API methods return in a case of an error are method specific. In most cases it is Boolean, for Visual Basic, or VARIANT_BOOL for Visual C++ or a short type number for Java where -1 is used for VARIANT_TRUE, and 0 for VARIANT_FALSE.
	
	
	
	

	03/27/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: How do I check if a property of a model object has a value?
A: ISCModelPropertyCollection::HasProperty returns VARIANT_TRUE if a property has a value. If the property type does not exist for a model object type than an error is returned.
Meta model information could be used to see if a model object has a specific property exposed.

If a model object instance does not have an instance of a property:
ISCModelPropertyCollection::Item won't report an error and will return a valid ISCModelProperty pointer, unless the model object of this type does not expose the property.
Any attempt to retrieve a value with ISCModelProperty::Value or similar will fail with an error message.
A new value could be assigned, as well as property Class, ClassName and Flags are available all the time.

ISCModelPropertyCollection::Add will fail if an instance of a property does exist for an object instance.
	
	
	
	

	03/27/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: How ERwin API provides macro resolution?
A: ERwin API provides macro resolution via ISCModelProperty::FormatAsString method. As an option, ISCModelProperty::Value returns same result as FormatAsString for non-string properties when ValueType parameter set to SCVT_BSTR.
	
	
	
	

	03/27/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: Do I need to register ERwin API COM server or this is a part of the installation process?
A: The registration of the server is a part of the ERwin installation. It also could be done at any point later by using regsvr32 system utility:
regsvr32.exe <ERwin installation directory>scapi.dll
Care should be taken to make sure that the system registry has the correct location of the server. In case of any doubts, try to re-register the server by using the above method.
There is only one version of ERwin API could be registered on any particular computer. It is not possible to run two different ERwin 4.x versions on the same computer with out distracting ERwin API functionality.
	
	
	
	

	03/27/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows

Q: How to create an empty model?
A: Use Create method for IPersistenceUnitCollection. The method accepts two parameters: a pointer on Property Bag and a new model unique Id. The second parameter is optional; in such case the API will assign a unique id to the new model. The Property Bag is a collection of parameters to direct the creating of a new model. Detail description of the parameters could be found in ERwin API documentation. The following is a sample of creating of a new mode in Visual Basic:

Dim oBag As New SCAPI.PropertyBag

oBag.Add "Model Type", "ERwin Logical Physical Model"
oBag.Add "Target Server", "ORACLE"
oBag.Add "Target Server Version", 8

' Create a new persistence unit
Dim oUnit As SCAPI.PersistenceUnit
Set oUnit = oSCAPI.PersistenceUnits.Create(oBag)
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Q: How to tell if I work with logical or physical?
A: There are three possible types of model in ERwin: 1 or ERwin Logical Model, 2 or ERwin Physical Model, 3 or ERwin Logical Physical Model. These are the values for model type that could be retrieved or used to create a new model via ERwin API.
Using PropertyBag property of IPersistenceUnit interface could access a model type. The property returns an instance of the PropertyBag with set of properties. The model type is a value for 'Model Type' property of the bag. The value could be accessed by the property name. See the documentation for details.
'Type' property of Model model object provides an alternative way to retrieve model type.
In both cases, the model type is read-only. The only time to specify a type of a model is when the model is created.
ERwin API is not discriminated by logical/physical view on a model. The API provides access to the complete set of model objects and properties, in the same way as ERwin does it internally. Logical and Physical views for a Logical Physical Model is function of ERwin user interface.
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Q: How to create a model object?
A: Pre-conditions for creating of a model objects are: an open session and active transaction. The session should be opened on Model Level (SCD_SL_M0).
Creating of an object includes three steps:

  Creating of an object instance. This is done by using Add method of IModelObjectCollection interface. An object class is required to create an object. It is either a string with a type name - 'Entity' for instance, or a string with the type id, which is '{6B0B5860-9075-11D2-A56D-00E0290FE9E4}+00000003 for Entity. An optional object unique Id could be specified at this point. 

  Populating object's properties. This is done by using IModelPropertyCollection interface. At least, properties mentioned as required in ERwin metamodel, should be specified for successful creating of an object. 

  After implementing of all modifications for the model, committing the active transaction invokes ERwin API validation process for the proposed changes and if the validation has succeeded, ERwin API applies the changes to the model. 
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Q: What is the ERwin metamodel?
A: The ERwin metamodel presents an abstract view on the organization of ERwin models. The metamodel consists of Meta objects. Single Meta object holds a description for a single Model Object Type or Model Property Type.
The metamodel could be accessed programmatically through ERwin API by opening a session on Metamodel Level or could be reviewed with ERwin Spy utility. There are two type of metamodels: model type specific and intrinsic metamodel. Model type specific metamodels contain information relevant to Logical, Physical or Logical Physical model separately. The type of metamodel information depends on the type of model in associated with the session persistence unit. The intrinsic metamodel is a superset of all model type specific metamodels. It is available by opening a session without persistence unit specified.
A metamodel has hierarchical organization:

- On the top level is a Meta object describing a model type.
- Next level consists of Meta objects representing the complete set of available Model Object and Model Property Types.
- For a specific Model Object, the next level lists children Model Object Types and describes Model Properties for the type.
- For a specific Model Property the next level lists Model Object Types where the property type employed.

The following are some properties of Model Object Type Meta object:
- 'Supports User-Defined' is true if the type can have user-defined properties;
- 'Required Properties' lists property types required for creating of the object
- 'Non-Creatable' is true if the object type created by ERwin only

The following are some properties of Model Property Type Meta object:
- 'Datatype' defines the property datatype
- 'Scalar' is true if a property scalar
- 'User-Defined' is true if a property is user-defined. Not available in intrinsic metamodel.
- 'Default Value' defines a default value for user-defined property
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Q: What are Read-Only and Tool Maintained properties?
A: Read-only and tool maintained properties are both available only for reading regardless of transaction status of a session. However, there is some important exception for a read-only property. A read-only property can acquire a value via ERwin API call, hence is write-able, if the following conditions are met:
- the property is listed as required for creating of an object in a metamodel;
- the property belongs to a new model object;
- the model object participates in a transaction and the transaction is active and not committed.
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Q: What are Type Name and Type Id?
A: Wherever ERwin API methods requires a model object class or a model property class, a type name or type id could be used. They could be used interchangeably.
The format for Type Id similar to model Object Id. It is a string that includes a unique GUID number in {} brackets and offset. In fact, Type Id is indeed an Object Id for Meta object that describes the Type on metamodel level.
The API spec does not restrict Type Ids to any specific range of values as long as they are unique. However, ERwin API follows the following schemas:
- Model Object Types:
{6B0B5860-9075-11d2-A56D-00E0290FE9E4}+nnnnnnnn
- Model Property Types:
{6B0B5861-9075-11d2-A56D-00E0290FE9E4}+nnnnnnnn
- Model Types:
{6B0B5863-9075-11d2-A56D-00E0290FE9E4}+nnnnnnnn
where nnnnnnnn is a number.
There is no guaranty that the schemas won't change in the future releases.
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Q: How do I create a Subject Area and hook objects to it?
A: ERwin makes a distinction between model data and its graphic representation. ERwin stores model data in such objects as Entity, Relationship, while their graphic represented by drawing objects 'Drawing Object Entity' and 'Drawing Object Relationship' respectively. Entities and relationships are located under Model, while drawing objects are children of Stored Display objects. The drawing objects are linked to associated Entity and Relationship objects via 'DO Reference Object' property.
A model in ERwin can have multiple subject areas and each subject area has one or more stored displays. A subject area maintains membership while a store display represents a graphical view. There are at least Main Subject Area and at least one Stored Display in it - Display1 by default.
'Referenced Entities' and 'Referenced Relationships' vector properties of Subject Area object represent a membership in a subject area. These properties are read-only and cannot be changed. To maintain membership enrollment ERwin employs drawing objects. A presence of a drawing object as a child for Stored Display of a particular subject area establishes an associated model object (entity or relationship) membership. For the enrolment to be valid, drawing objects must exist in all stored displays of the subject area.
At the commit of a transaction in which new entities and relationships were created, ERwin API creates a complete set of drawing objects for all stored displays of a main subject area unless a client provides them.

The following is an example of Drawing Object Entity manipulation:

Dim oEnt As SCAPI.ModelObject
Dim oSD As SCAPI.ModelObject
Dim oEntDraw As SCAPI.ModelObject
Dim aLocation(4) As Long

' Locate a Stored Display
Set oSD = oSession.ModelObjects("Display1", "Stored Display")

' Create an entity
Set oEnt = oSession.ModelObjects.Add("Entity")

' Populate properties
oEnt.Properties("Name").Value = "Ent" + Str(nIdx)
oEnt.Properties("Type").Value = "Independent"

' Create a drawing object for an entity
Set oEntDraw = oSession.ModelObjects.Collect(oSD.ObjectId).Add("Drawing Object Entity")

'Populate properties
aLocation(0) = 100
aLocation(1) = 100
aLocation(2) = 110
aLocation(3) = 110
oEntDraw.Properties("DO Reference Object").Value = oEnt.ObjectId
oEntDraw.Properties("DO Location").Value = aLocation
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Q: How do I find a column by the column physical name?
A: In ERwin, logical and physical sides of attribute-column pair are represented by one object type - Attribute. This object stores an attribute name in 'Name' property while a column name in 'Physical Name' property. Index method supports lookup by 'Name' property value only. To locate a column by Attribute object 'Physical Name' could be done by iterating over a collection of attributes and search for matching 'Physical Name'. The following is an example of a program that reports all attribute physical names in a model:

Sub main()

' Report all attributes physical name with exception of logical only models

Dim oSCAPI As New SCAPI.Application
Dim oPU As SCAPI.PersistenceUnit
Dim oSession As SCAPI.Session

' Open an exist model
Set oPU = oSCAPI.PersistenceUnits.Add("W:\New.er1", "RDO=Yes")

' Check on a model type
Dim strNameProp As String
strNameProp = "Physical Name"

Dim oBag As SCAPI.PropertyBag
Set oBag = oPU.PropertyBag("Model Type", True)
If oBag.Value("Model Type") = "ERwin Physical Model" Then
' This is physical only model
strNameProp = "Name"
End If

' Open a session
Set oSession = oSCAPI.Sessions.Add
oSession.Open oPU

Dim oAttr As SCAPI.ModelObject
' iterate over all attributes and report their Physical Names and owner Entity
For Each oAttr In oSession.ModelObjects.Collect(oSession.ModelObjects.Root, "Attribute", 2)
Debug.Print oAttr.Properties(strNameProp).FormatAsString + _
" of " + _
oAttr.Context.Name + _
" entity"
Next oAttr
' Close the session
oSession.Close

' Release the persistence unit
oSCAPI.PersistenceUnits.Clear

End Sub
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Q: Why do we use Key Group Type as unique? 
e.g. AK1, IE2, IF2 and not as common for corresponding category: alternative key, inverse key or foreign key as AK, IE or IF
A: The numeric part of "Key Group Type" property affects only exist objects and is not required to be set for creating a new Key Group object. "Key Group Type" property required for creating of Key Group object.

The property appearance is due to the use of macro %KeyType in generating Key Group (Index) physical names. Commonly used macro definition for a physical name is X%KeyType%TableName. Hence, to keep it unique, in case if an entity has more then one key of the same type, ERwin sticks a number at the end of %KeyType value. The number guarantied to be unique in scope of a single entity and key group type. The value of %KeyType is in fact a value of Key Group Type property and this is why it makes it like this in ERwin API output. The numeric part can be safely ignored. In fact, ERwin does not required the numeric part for Key Group construction, ignores it if present and will re-generate these numbers in the process of creating new objects.
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Q: How to enforce rolenames using API? 
A: A case of rolenaming is when a migrated attribute has a name different from one of the source in a parent entity. In such case, the attribute name becomes a role name. ERwin uses 'Name' property of attribute's role naming in case of Logical/Physical and Logical models and 'Physical Name' in case of Physical model.
Certainly, a migrated attribute is the one with 'Parent Attribute' and 'Parent Relationship' properties set.
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Q: If an attribute belongs to more than 1 Relation we have to add the attributes more than once. Do we have to set Attributes-Values (e.g. DataType) for all copies? Or is there any automatic replication? If yes, which is the master version? 
A: Duplication of attributes occurs if a child entity has more then one in-coming relationship with the same parent attribute(s). ERwin UI displays only one attribute as a result of a process called 'unification of attributes'. The criteria for unification are presents of more than one migrated attribute with identical name, the same source of migration and none of then is hidden.
First, creation of migrated attributes 'by hands' is an optional. ERwin API will automatically create all required migrated attribute objects at the end of a session.
Second, there is no 'master version' for duplicate attributes as well as a source attribute in a parent relationship does not override properties in migrated copies automatically. Hence, in order to avoid undesirable side effects, all related attributes must have identical sets of properties. It is guaranteed with the API enforced migration as well as ERwin UI might fix up such discrepancies when Attribute Editor or Relationship Editor called. However, it is bettor not to rely on such leniency.
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Q: Is it possible to "Auto-Layout" a model via the API? 
A: This functionality is not available via ERwin API. However, if 'Drawing Object Relationship' in a Stored Display has property 'Do User Controlled Path' set to true, ERwin automatically layout a relationship path in the Stored Display. True is a default value for this property.
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Q: Where can I see what properties are required for creating of an object? 
A: This information provided by ERwin API on Meta data level. It could be accessed programmatically via the API as well as with ERwin Spy. Open Spy, select menu Models and then Intrinsic Meta and locate desired object type in Objects tree. Click a button in the middle of the screen in order to see the type properties. Minimum set of properties required for creating an object of selected type is listed under 'Required Properties' in Spy right panel. If the category is not present, then none of properties are required.
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Q: How to create or remove a User-Defined property (UDP)? 
A: Introduction of a UDP in a model is a two-step process. First, a client must create a 'UDP Definition' object. A definition must be created under Model object and has two required properties:
'Is UDP Logical' is a Boolean property and is true if this is a UDP for logical model or a logical side of a logical/physical model. Otherwise the property should be set to false. This arrangement allows to have two UDPs for a single class of model objects with identical names but different values on logical and physical sides of a model.
'Meta Object Type' - this is to specify a target model object class for a UDP. A native class id for an object class must be used. An object class name cannot be used at this time. This is a subject of improvement in coming release of the API.
A native class id for a model object class could be obtained with ERwin SPY. Use meta data mode for ERwin Spy and check 'Native Class' property for a desired object class.
The following are additional available properties for a UDP definition:

- 'Name', allow addressing a property by name. Recommended to be set.
- 'UDP Property ID', a property native Id. Assigned by ERwin, could be changed with a caution.
- 'Type', by default set to 2 or Text. Other available UDP types are: 1 - Integer; 3 - Date; 4 - Command; 5 - Real; 6 - List;
- 'Definition', any text
- 'UDP Default Value', a default value for a UDP. A value for UDP is always a string, regardless of 'Type' property value.

Remove of a UDP Definition object cause all UDP instances in model objects to be removed as well.

Before new created UDP definitions could be used, commit an active transaction.

Second, a UDP is treated similar to a common property of a model object in respect of access and modification of values. UDPs are available via enumeration of a property collection. A UDP name or Class Id could be used to address the property in property collection directly. A UDP value is always of a string type, regardless of 'Type' property for UDP definition.
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Q: Where can the object property typecode list be found for 4.x?
Where can the object dependency diagram be found for 4.x ? 
A: Documents for ERwin API 4.0 do not have a formal listing of properties or model object dependencies. However, we offer ERwin SPY utility. In metadata mode, the utility lists all available object types, property types and demonstrate their dependencies as well as displays other useful information on metadata. The following is an excerpt from the utility description:

ERwin SP1 installation includes two extra directories. These directories are located under Samples\ ERwin API and offer you a sample of the API browser program and ERwin Spy utility. Details of the sample and utility installations as well as short instructions how to use are provided in Doc\ReadmeApi.txt.
First of all it is hard to overstate the importance of using ERwin Spy utility. It provides a view on internals of ERwin models and it is must to use for anyone who wants to write applications with ERwin API. You could find that every model is a complicated net of model objects, their properties and cross-references. No wonder! ERwin provides sophisticated and extensive mechanisms for data modeling and it should not be of any surprise that to represent the data in all it complexity, such complicated metamodel is indeed in need. However, let see for our self how ERwin Spy can help us to simplify the task of understanding details of ERwin model.
Lets run ERwin Spy utility. Please, use the version from ERwin Spy directory and, please, use add-in variation of it. See ReadmeApi.txt for details. Lets start with an empty logical-physical model. Please, create an empty logical-physical model and run ERwin Spy. Lets expand (double click) Model object in the utility left panel. As a result of expansion, quite a number of new model objects appear. All these objects are the default one. Even though the model is 'empty', these objects represent ERwin defaults. Please, note such defaults as Domains, Main Subject Area, Trigger Templates, etc. All of them have Default flag shown in "{}" next to the type of the model object.
Lets add some information to the model. Please, return to ERwin and create a couple of entities (Ent1 and Ent2), add a primary key attribute 'a' to Ent1 and migrate it to Ent2 with identifying relationship. Then open ERwin Spy again. Please, note the difference. Now, when you expand Model object, you could see two entities we have just created. Select Ent1 and click on the button located in the center of the screen. With this the utility shows the selected object properties in the right panel. Here is what we can see:
- The first column shows property name. Name, Physical Name, etc. for instance;
- The second column, with title DT, shows property data type. For instance: Str for a string, I4 for a number, Bool for a Boolean, Id for a reference to another object, etc.;
- The third column, titled Value, displays property value in native format;
- The forth column, titled As String, displays the property value re-interpreted as a string. For instance, take a look on Physical Name property for entities. The value is %EntityName, which is a macro, while As String holds the macro expansion;
- The rest of columns represent property flags, which are: NL for properties with Null/ no value (the flag is never on for ERwin Spy), UD for user defined properties, VC for vector properties (please, expand the table row down to see more values), TL for properties that are maintained by ERwin and can not be changed directly via API, RO for read-only properties, DR are derived properties which value was inherited for instance form a parent domain;
-
Lets take a look on one more example. Please, locate an attribute 'a' for entity Ent2 in the left panel of the utility. For this you would have to expend Ent2 to see children objects. Select the attribute object and take a look on the properties in the right panel. Point of interest is 'Parent Relationship'. Since the attribute is a product of migration, this property provides information what relationship was used. The property is a reference (Id value in DT column) and the value is a unique id of the involved relationship. In order to locate the relationship, use a name from As String column or locate an object by it unique id. In order to see objects ids, please, enable this option by checking Show Ids under File\Options menu. With Show Ids enabled, when a cursor locates over an object in the utility left panel, the object unique id is shown in a pop-up window.
At the end it worth to re-iterate, that the best way to learn details of ERwin model available via ERwin API is to take advantage of ERwin Spy utility. If you need to learn how particular data represented in ERwin model, please, use the following easy scenario. Start with an empty model, create minimum data model that necessary to represent a feature in question and then use ERwin Spy to look in details of data representation in ERwin model.
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Q: Is there an equivalent for the custom interface in the 4.0 API? 3.5.x API has custom interfaces, available via GetAccessor method, targeting specifics of particular model object types? 
A: No, ERwin API 4.x is strictly object/property based and has generic interfaces. All modeling information expressed as a collection of model objects and their properties. For instance, ERwin API 3.5.x has a custom interface for Subject Area model object with IsMember method. That method allows telling if an entity in question is a member of a subject area. Subject Area model object in ERwin 4.0 has 'Referenced Entities' vector property with list of entities enlisted as members to the subject area.
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Q: How to detect if an attribute is a duplicate, and for duplicates, if it is the master version and will be displayed in the data model? 
A: As a result of migrating attributes from one entity to another by means of relationships it is possible to have in the same entity one or more 'duplicate' attributes. Attributes migrated from the same master attribute are recognized as duplicates. ERwin employs a unification procedure to detect such situations and avoid displaying multiple copies of the same attribute in UI.

Check and compare 'Master Attribute' property for all attributes of an entity. This is a ReadOnly property and as a value has Object Id of a master attribute. For owned attributes, i.e. attributes that are not a part of migration, 'Master Attribute' value matches object own Object Id. Attributes with identical 'Master Attribute' values are candidates for unification.

Additional note on duplicates:
For performance reasons, ERwin does enforce sync of 'master version' of properties for duplicate attributes all the time. Therefore, it is possible via the API to set some of properties for migrated attributes not in sync with its master copy. Hence, in order to avoid undesirable side effects, all related attributes must have identical sets of properties. It is guaranteed with the API enforced migration as well as ERwin UI might fix up such discrepancies when Attribute Editor or Relationship Editor called. However, it is bettor not to rely on such leniency.
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Q: Is there a trick in re-ordering key groups with the API? I'm trying to re-order the columns in a primay key by setting the Key Group Sort Order properties on the Key Group Member objects. All looks fine just prior to commit but the changes do not register (no error, other model updates all ok). 
A: You have to match 'Key Group Sort Order' on Key Group members of a primary key index with 'Order' property of Attribute. 'Physical Order' of Attribute reflects the way columns arranged in database. This will match the screen if you select 'Physical Order' option in Display Level (right click pop-up menu). The 'Order' property always in-sync with 'Key Group Sort Order' and displayed when Display Level set as Column.
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Q: How do I know which objects support which properties. Looking at ERwinSpy led me to believe that "DB2 UDB Summary Table" was an optional property of an Entity. Since there is no indication that the entity is a sub-class, I assumed that it was just like any other entity and expected HasProperty() to return false.
This behavior seemed logical since I can add extended properties to an entity and they appear as named properties on the Entity. Will I have similar issues if I use HasProperty to determine if a user defined property exists on an Entity? If I miss-type the UDP name? 
A: There are a number of properties and objects in a model that are related to physical models. These properties/objects are target specifics. For instance, for ORACLE you would have Oracle specific physical object types such as 'Oracle Tablespace' and for DB2 the Attribute object could have 'DB2 UDB Datalink Options' property. Because ERwin API is metamodel driven, property and object types have to be listed in the metamodel in order for the API to recognize them. This is different from a case when certain property instance or object instance are not present. The stringency is similar to a case when a property name was mistyped. Just the same - a property with such name is not listed in the metamodel.
In ERwin Spy, in order to see metamodel information for a specific physical target, create an empty physical, logical-physical model, or use an exist one with an appropriate target. Open ERwin Spy. Click on the model in question name in the second half of the Models menu - you will have metamodel information instead of model data. In contrast, Intrinsic metamodel lists all possible object and property types available for different physical targets combined and in logical models.
The same information is available programmatically, via the API calls, if you open a session on metamodel level (SCD_SL_M1).

In regards of UDPs. This is similar to physical properties above. When a new UDP introduced in a model, by means of creating of the UDP Definition object, this is equivalent to modifying a metamodel data for a particular model. Hence, if a UDP was not introduced and we attempt to use the name, the API treats it as misspelled and returns an error.
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Q: What is the correct connection string to Model Mart 4.1 via the API? 
A: In Add method of PersistenceUnitCollection interface, the first parameter describes a model location in ModelMart and has the following format:

mmart://pathinfo[?param=value[;param=value]…n] 

,where pathinfo is something like:

<Database Name>/<Library Name>/<Model Name>

and some of param options are described in the following table:

Complete Name

Abbreviation

Description



Server

SRV

ModelMart server.

Server Type

SRT

Type of server connection.

User

UID

Login user name.

Password

PSW

User login password.

For instance:
mmart://SqlDatabase/MyMart/MyLib/MyModel?SRV=SqlServer;SRT=SQL Server 2000 (using db-lib);UID=<mm user id>;PSW=<password>

For more details, please, see Chapter 4, Location and Disposition in Model Directories and Persistence Units
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Q: Does ERwin 4.0 have an API and if yes, is there any documentation on it?
A: Yes. ERwin 4.0 comes with SCAPI and is bundled with the application. It can be launched either Standalone or from the Add-in Manager using ERwinSpy that is also included with the application. Both, "ERwin API Sample Client" and "ERwin Spy Utility" can be installed by checking the box during the install. If somehow these were not checked during the initial install, reinstall ERwin and it will prompt with the options - Modify, Repair or Remove. Check Modify and select the two boxes to install these. The documentation, ERwinAPI.pdf, ReadMeAPI.txt is also available in the Docs which is in the same folder where ERwin is installed.
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Q: How do you add ERwinSpy in the Add-in manager?
A: This is described in the ReadMeAPI.txt file, in the "Doc" section. To register the add-in with ERwin, on the Tools menu in ERwin, choose Add-Ins, then choose Customize. In the Add-In Manager dialog, click the Add Menu Item button from the toolbar. In the Add New Menu Item dialog, set Name to ERwin Spy, set COM ProgId to ERwinSpy_AddIn.ERwinSpy, and set Function Name to Run. Note that in the Menu Type box on the dialog, you should select Command and Com Object. In some cases, the ERwinSpy_AddIn.dll may need to be registered. To register that, from the RUN menu, run regsvr32 "C:\Program Files\Computer Associates\ERwin 4.0\Samples\ERwin API\ERwin Spy\ ERwinSpy_AddIn.dll". Note the path is for the default installation and may need to be modified depending on the actual path..
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	02/21/03
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: Can you change the model name from that of the the actual .er1 file name?
A: Yes. In the 4.x versions of AllFusion ERwin Data Modeler the file name and the model name can be different. When a new diagram is created, the model name is created from the file name by default. However, the model name can be changed at any point in Model | ModelProperities | General Tab. Please note, that Complete Compare uses the model name and not the file name.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: How do I turn off the display of my foreign keys in a logical model?
A: Right mouse click on the background of the logical model, select Display Options/Entities, and uncheck show migrated attributes.
	
	
	
	

	Working With ModelMart
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	11/12/02
	Product: ModelMart
Version: 4.0
OS: Windows 
Q: I installed Model Manager but cannot add any users when the security manager comes up at the end.
A: The user doing the install did not have DBA (Oracle, Informix) or System Administrator (Sql Server, Sybase) privileges. You will need to delete the database and install with the correct privileges.
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OS: Windows
· If you are saving a ModelMart diagram, ERwin might display the message "invalid access id presented on object unlock request." If this is the case, be sure that you are the only user who logs on to ModelMart with your login name. 

· When you share a data model with other users, be sure that the same fonts are installed on everyone s workstation. Otherwise, ERwin chooses a font on the current workstation that closely matches the font selected by the user who last updated the ModelMart master diagram. For example, if User1 and User2 are working on copies of the same ModelMart diagram and User1 changes the point size of a text block in the diagram and saves the change back to ModelMart, when User2 refreshes his diagram ERwin will show the new point size on the font and color toolbar but the actual text object (CUSTOMER) will remain unchanged. 

· ModelMart displays a message indicating that an "illegal cycle" has occurred when you merge two diagrams that contain the same pair of entities. This will occur if the pair of entities is engaged in relationship engaged in a parent-child identifying relationship in one diagram and a child-parent identifying relationship in the second diagram. ERwin does not support recursive relationships between two entities (i.e. an entity cannot be both the parent and a child), which would be the result if the merge went through. ERwin will complete the merge, but keeps only the relationship that existed in the target model. If you are not satisfied with the results of the merge, you can delete the existing relationship and create a new one after the merge is complete. 

· If you save your ModelMart diagram as an ER1 file and choose the PVCS Version Management option in the ERwin "Save As" dialog, you will find that the PVCS check box is unavailable. ERwin/ERX for ModelMart does not support the PVCS Version Management feature. You can access the PVCS application directly and use its features to select and manage ER1 files. 

· When you save a diagram to ModelMart with attribute names longer than 130 characters, ERwin automatically truncates attribute names when you open the diagram. Before you save a data model to ModelMart, shorten the name of any attribute greater than 130 characters. 

· When you save a diagram to ModelMart and receive error messages that interrupt the save, none of your changes are saved. Try again to save the diagram to ModelMart. 

· To optimize response time when you merge two diagrams that are significantly different in size, choose the smaller diagram as the source and the larger diagram as the target. 

· Occasionally when you and another user try to access ModelMart at exactly the same time, you may receive a message indicating that a dead lock has occurred. If the message displays while you are saving, none of your changes are saved. Wait a short while and try to save again. If you receive the message again, check with your ModelMart Administrator. 

· When you merge two data models, the unique name option set in the target diagram determines how an object is named in the merged diagram. 
	
	
	
	

	Miscellaneous

	Date
	Question and Answer
	
	
	
	

	10/11/04
	Product: AllFusion ERwin Data Modeler 
Version: 4.1, 4.1.4
OS: Windows
Q: When I launch the software I get an error that reads, "mmopn32.exe caused invalid page fault in MFC42.dll".
A: You may have a spyware installation that is causing a conflict. Contact your network administrator and have them search your PC for any spyware installations. If any spyware is located, it should be deleted. Please see the following Microsoft link for more details: http://support.microsoft.com/?kbid=813181.
	
	
	
	

	09/27/04
	Product: AllFusion ERwin Data Modeler 
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: It is possible to launch a particular .er1 file with AllFusion Erwin Data Modeler via command line and the model name as a parameter?
A: Yes, running from the command line is supported. Simply type "mmopn32". This will start AllFusion ERwin Data Modeler, from AllFusion ERwin Data Modeler's path (e.g. "C:\Program Files\CA\AllFusion ERwin Data Modeler"). If you add AllFusion ERwin Data Modeler's path to the PATH environment variable, you can run it from anywhere on the command prompt or from the Windows "Run" dialog. The same command in a script (thinking .bat file here) will run AllFusion ERwin Data Modeler too. If you include a model's path\name after "mmopn32", AllFusion ERwin Data Modeler will open the file. 
For example: mmopn32 C:\test\model.er1 -- starts AllFusion ERwin Data Modeler, and opens the "model.er1" file. 
	
	
	
	

	08/23/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: My Column Denormalization Transform button is inactive. How can I use it? 
A: The column being denormalized needs to first be highlighted or selected.
	
	
	
	

	08/23/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I'm using the drawing tools, it is a bother to have to go back to the toolbar and pick up the same tool again and again to create multiple objects. Isn't there some way I can "hold onto" the same tool until I'm done? 

A: AllFusion Erwin Data Modeler 4.1.4 sp1 solves this problem with a new feature called Multi Object Create or "sticky" tools. The Multi Object Create makes it easier for the user to create multiple occurrences of an object from the Erwin toolbox toolbar and the Drawing object toolbar, without having to reselect the object each time.

To begin creation of multiple objects,

1. First select the object from the toolbar. 

2. Then press and hold down the CTRL key. 

3. Then Left mouse click on the diagram for each location you wish to place the object. 

4. While you have the CTRL key depressed, you may select a different object and begin placing it on the diagram. As soon as you release the CTRL key, the selected icon will become inactive and the Arrow (Select) icon will become active
	
	
	
	

	08/23/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I install the Erwin Resource Kit it causes a lot of problems with my other Java applications.
A: The AllFusion ERwin Resource Kit was built with a particular version of Java plug-ins. It may cause problems with other JAVA applications if they are using a newer version of Java. While the AllFusion Erwin Resource Kit is still available, all the material has been copied to SupportConnect.CA.com. SupportConnect.ca.com has a central search point like the AllFusion Erwin Resource kit, has additional new material, and will be the main electronic resource for the AllFusion Modeling Suite going forward.
	
	
	
	

	08/12/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How can I find a list of all the fixes in a particular version of AllFusion ERwin Data Modeler, like 4.1.4 sp1 for example? 
A: All Problems and their Solutions are listed in:

1. A text file located in the /DOC folder of your ERwin product, for example "c:\Program Files\CA\AllFusion ERwin Data Modeler\Doc\ERwin 414 sp1 Solutions.txt" 

2. In the On-Line ReadMe for the product on the SupportConnect/Product News/Solutions and Patches/your product version, for example, http://supportconnectw.ca.com/premium/erwin/downloads/erwin-updates.asp 
	
	
	
	

	04/01/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Using Volumetrics, the Average Row Size is less than what it should be. For example, with Oracle 8i as my target database, if there are three (3) columns with decimal(7,2) datatype, Average Row Size shows as 11 when it should be 12 (4*3). Why this difference? 
A: The Average Row Size is not a simple multiple of 4*3 (for 3 columns...). It is also calculated taking into account the volumetric information.

The formula for calculating the row size is:
row_size = round((( length((p) + s) / 2)) + 1
where:
p - for varchar2 expected number of characters for column, for number
where p = number of digits and s = 0 for positive and 1 for negative,
for date use 7
+ 1 byte per column in row
+ 3 byte row overhead per row
...so, for a table with three (3) decimal(7,2) columns (i.e. 7 digits), it'd be
((7 + 0) / 2) + 1 = 4.5 bytes
4.5 + 3 (columns) = 7.5 bytes
7.5 + 3 (overhead) = 10.5 bytes
Rounded, this would be 11 bytes which is what ERwin shows.

Another way to look at it is as follows:
The data map table in ERwin specifies that each digit in decimal data type occupy 4 bits. Therefore, the total number of bits for decimal (7,2) is 7 * 4 = 28, which is approximately equal to 32 bits (after rounding). 32 bits is 4 Bytes. For three columns the average row size is (7 * 4) * 3 = 84 bits, which is 11 Bytes after rounding. The reason for the difference is to control the propagation of the round off error. format.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: We need to know what format the foreign (French) characters are stored in. In the generated XML file - as we are trying to export and import data using this mechanism - the NLS data is not being interpreted correctly. What should we do?
A: The NLS characters in the XML files are stored in Unicode UTF-8 format.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Is there any size limit on an ER1 file?
A: There is no size limit on ER1 files. You can run into memory limitations however. If the size model you are opening is larger than the physical memory on your computer, and Windows goes to virtual memory, it may appear to "hang". The minimum memory requirements noted in he manual are for minimum size models of only a handful of entities. Larger models may need more memory. 512MB seems to be the "sweet spot" for most clients.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Where do I find the Registration ID for AllFusion ERwin DM?
A: Refer to "What's New" section included with the online HELP.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: When will AllFusion ERwin DM 4.1 be compatible with the Advantage Repository?
A: There is now a Scanner for the OS390 Advantage Repository and 4.1, but not yet for the distributed version of the repository. It is planned for a future release.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: How do I contact eSupport for any access problems to the eSupport website?
A: You can get help by calling the following support number 631-342-6364.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Do I need to apply the GA version of the product before I can apply the Service Pack or Patch?
A: No. Each Service Pack or Patch Build is a full release of the product. You will need, however, to have at least one registered version of ERwin 4.1 on your PC in order to install a Service Pack.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Why does AllFusion ERwin DM application sometimes crash when opening an ER1 file?
A: These types of errors can sometimes be fixed by re-naming the ERwin40.ini file and then restarting the AllFusion ERwin DM which will generate a new ERwin40.ini file. Please note that you will lose some information kept in the .ini file such as the last file opened, and database connection info. If this does not solve the problem, you can delete the new .ini file, rename the previous file back to ERwin40.ini. If the problem persists please call Technical Support.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Are there Tutorials/Books to learn more about AllFusion ERwin DM?
A: There is an online tutorial as one of the options in the HELP menu. There are AllFusion ERwin DM education classes offered by CA. There is an on-line course in the ERwin Resource Kit which can be ordered on the any of the AllFusion Modeling Suite eSupport pages. There are many AllFusion ERwin DM user groups that can give you a lot of helpful information. The user groups can be found by going to http://causergroups/usergroups/.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: How do I know if a published fix solves a problem I previously reported as an issue to Computer Associates?
A: You will be notified based on your contact preference that the specific issue is being addressed in a particular release.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Is it possible to convert Advantage Gen logical models into AllFusion ERwin DM?
A: There is a solution from Jumar that provides a two-way bridge between Advantage Gen and AllFusion ERwin DM (http://www.jumar-solutions.com). The product has been recently branded as Jumar:Links for AllFusion ERwin DM and Advantage.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Where can I find the list of databases supported by AllFusion ERwin Data Modeler 4.1?
A: Choose the physical view of the Data Model and go to "choose database" under "database" from the menu bar and a screen of all supported databases will be displayed or go to the Compatibility Matrix link on the appropriate product page on http://esupport.ca.com.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Can Sybase Power Designer models be converted to AllFusion ERwin DM models?
A: Yes, with the use of a third party tool from a company in Germany called the Reischmann Bridge (www.reischmann.com).
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Does AllFusion ERwin DM come with any type of manual or instructions on paper or is everything included electronically?
A: If you purchase the box product it comes with the Getting Started Guide in hardcopy. Otherwise all documentation is available electronically in the doc folder under the AllFusion ERwin DM folder and via the Product Documentation link on the appropriate product page on http://esupport.ca.com.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: How come AllFusion ERwin DM 4.x is not supporting the Microsoft repository? Is there any way for AllFusion ERwin DM to import or export to the Microsoft Repository?
A: Microsoft Repository is no longer being developed and marketed by Microsoft as a general purpose repository. Its purpose has been more closely aligned with SQL Server itself. Taking this into account, it no longer made sense to have a specific function in AllFusion ERwin DM to support MSR. It may be possible to accomplish this integration through a 3rd party like Reischmann or MetaData Integrations.
	
	
	
	

	07/18/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I recently installed ERwin 4.1 SP2b build 2771, to evaluate it. Shortly after using it, the Model Explorer window no longer shows up, even though I clicked on View|Model Explorer. Why?
A: This problem has been previously reported but we have not been able to reproduce it. The recovery, however, is quite simple by renaming your ERwin40.ini file so ERwin will automatically create a new one. Note, however, you will lose and have to recreate some previous settings such as the most recent file saved, DB connection strings.

Please open an issue with AllFusion ERwin Model Manager support via the web or by calling 866.210.9330 so we can obtain your original ERwin40.ini file to inspect it.
	
	
	
	

	07/18/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: My copy of ERWIN 4.1 SP2b build 2771 has the Drawing tool bar but no "T" text tool showing on the display. Instead there is a "many to many" tool in the "T" tool's place. Another person has the "T" on their Drawing tool bar. The versions of the software on all PCs are the same. Why?
A: This problem, ERWIN #3206, has been previously reported and is being investigated. The recovery, however, is quite simple by renaming your ERwin40.ini file so ERwin will automatically create a new one. Note, however, you will lose and have to recreate some previous settings such as the most recent file saved, DB connection strings.

1) Exit ERwin.
2) In Windows explorer, locate the ERwin40.ini file (usually in the WINNT directory).
3) Rename the file to something else such as ERwin40_old.ini.
4) Restart ERwin. The text tool bar should be there.
	
	
	
	

	11/25/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows
Q: I cannot open an .ER1 file - it errors out because it is not compatible. What is the reason?
A: It is most likely because of a file format change between the various releases of ERwin., e.g. there was a file format change between ERwin 4.0 SP1 (Build 1511) and SP2 (Build 1687) as well between 4.1 GA (Build 2208) and SP1 (Build 2522). .ER1 files saved in later version sometimes cannot be opened from the earlier version, especially if the format has changed. The workaround is to upgrade to the latest version. The later versions can open the files saved in previous versions.
	
	
	
	

	05/15/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows
Q: I am using ERwin 4.0 Build 1511 (SP1). I cannot open this .ER1 file - it errors out because it is not compatible. What is the reason?
A: There was a file format change between ERwin SP1 (Build 1511) and SP2 (Build 1687). .ER1 files saved in SP2 cannot be opened from the earlier version. Upgrade to SP2 to use that file.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 4.x
OS: Windows 
Q: I get a mmopn32.exe error when opening a model in or launching ERwin. How is this solved?
A: It may be resulting from an unstable .ini file. If you get a crash while opening a model, creating a new model etc., the ERwin40.ini may not have been refreshed. To resolve this, close ERwin, find the ERwin40.ini file and either rename or delete this file. Re-launch ERwin (a new ERwin40.ini file will be created, if none exists. If you continue to have crashing problems, you should contact CA Technical Support for further investigation.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 3.5.2
OS: Windows 
Q: Where did my ERwin toolbox go?
A: You can toggle the display of the ERwin toolbox on and off using the Window|ERwin Toolbox menu option or by pressing CTRL-T (press the control and T key simultaneously).

If you recently changed your video driver from a higher resolution (i.e. 800 x 600) to a lower resolution (i.e. 640 x 480), or changed the operating system on a dual boot machine, you may have to edit your ERwin.INI file. The ERwin.INI file is located in the WINDOWS directory. The TOOLBOX = X,Y entry determines the location of the toolbox. Exit ERwin and open then ERwin.INI file using NOTEPAD. Change the X value to 100 and the Y value to 100, save your changes and restart ERwin. The toolbox should now be visible.
	
	
	
	

	11/12/01
	Product: ERwin
Version: 4.0
OS: Windows
Q: Why are there three options to save: Save, Save As, and Save As New?
A: This is relevant for the Model Source diagrams where derivation is involved. While doing "Sync with Model Source", the source and the target models need to be identified to ensure that the two models being synched are the right ones. ERwin does that by allocating the IDs at the model level so if Model Source selection is somehow incorrect during the "Sync with Model Source", it can check the source and target models and caution the users before comparing all other objects. The following describes the three options:
Save: Simply save the diagram
Save As: Save it but allows you to Rename and/or save in a different place while still preserving the model IDs
Save As New: Save it but allows you to Rename and/or save in a different place without preserving the model IDs.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 4.0
OS: Windows 
Q: How can I find if my problem is already a known one?
A: Registered ERwin users can also register for esupport. Therein is a section for StarTCC, which further has StarTCC Knowledge Base. This knowledge base can be searched to find out the known issues and can be customized as per the key word. There is also a section for registering for enews that keeps you updated with the latest developments.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: When I open my model, I see a message stating that my file is read only.
A: Whenever ERwin opens a file, that file is marked as read only. This is to prevent a second user from editing and saving a file that the first user has opened. If ERwin does not exit cleanly (e.g. shutting off the computer with ERwin and Windows still running), the file will remain marked as read only. To recover, close the file, go to File Manager, highlight the read only file, choose File | Properties and clear the checkbox next to the read only attribute. Alternatively you can do this with the DOS Attrib command.
	
	
	
	

	Printing and Reporting

	Date
	Question and Answer
	
	
	
	

	09/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows

Q: I just upgraded my Microsoft Internet Explorer to Version 6. Now when I open a .jpeg file created in the Report Template Browser, the image is compressed and too small to read. How can I expand it to the original size?
A: In your Microsoft Internet Explorer, go to Tools, Internet options, Advanced tab. Scroll down to the Multimedia section and check Enable Automatic image resizing. Close and re-launch your Microsoft Internet Browser.

Now when you open the JPEG, it may appear compressed or smaller than original size, but if you place the pointer over the image, an icon will appear, which when clicked, will return the image to its original size.
	
	
	
	

	07/23/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows

Q: There is no folder under All Reports in the AllFusion Erwin Data Modeler Data Browser. How can I get it back?

A: First try to open report.erp from Menu/Erwin reports. If the Folder still does not display rename LWBRWS32.INI in the C:\WINNT directory. 
	
	
	
	

	06/15/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows

Q: When exporting the report output to a .rtf format in the Report Template Browser, I see strange characters - what are these and how can I fix it?

A: There may be hidden text present, in Microsoft Word, under Tools | Options | Tab view, unselect hidden text; this may remove the strange characters in your .rtf format.
	
	
	
	

	04/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4 
OS: Windows

Q: After installing and running RegisterIT, I tried to launch my AllFusion ERwin Data Modeler but I got the message, "failed to update the system registry, please try using regedit." Why?

A: You probably did not have Administrator rights on your PC when you ran the install. If not, have your rights changed and re-run the install, or have the PC Administrator run the installation.
	
	
	
	

	04/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4 
OS: Windows

Q: I installed AllFusion ERwin Data Modeler and Registered in the past without any problems. Recently, however, I received a new PC, re-installed, and tried to register again, but now I get an error message saying I have exceeded the valid number of licenses. How can I have this corrected?

A: Contact our Total License Care Group (TLC) on SupportConnect or by telephone.
	
	
	
	

	03/19/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4 
OS:   Windows

Q: How do you Save a Report View in Data Browser?

A: Follow these steps:
· Click in the Standard toolbar to start the Data Browser. 

· Double-click on a report to display the result set. 

· Customize the report format. More 

· Click to open the Save Report View dialog. 

· Type a name for the report view in the View Name box. 

· Optionally, if you want to include one or more parameters as part of the report view, select the check box next to each parameter you want to include. 

· Optionally, enter a description of the report view in the Description box. 

· Click OK. The Data Browser saves the report view with the name you specify and adds a report view icon () to the tree control under the report from which the view was generated.
	
	
	
	

	03/11/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I generate an Entity or Attribute report using the Report Template Builder the definition for Entity or Attribute doesn't wrap. They go across the page. How can I get them to wrap?
A: Go to the Report Template Builder and highlight HTML under report layout. Right click and go to the export tab in the properties. Set up the number of characters you want to wrap in a wrap option window. 
	
	
	
	

	01/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When running a report from RTB, the error "Cannot Create Directory <Path name\Untitled>, is encountered.
A: Within RTB, go to Edit -> Properties -> Export Tab. Under "Generated File" please specify a valid location for the report to be generated.
	
	
	
	

	01/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Within an HTML report produced from RTB, clicking on an entity or table on the diagram graphic fails to produce a pop-up window.
A: In RTB, select the "Picture" option, and bring it over to the right pane. Right-click on "Picture section" and go to Properties. Under the property tree, select the Entity and Table objects that you would like on the pop-up. After regenerating the report, we will be able to click on a Table or Entity and view a pop-up box with the additional information about that object.
	
	
	
	

	01/16/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows
Q: How can I improve DDE to Word reporting performance?
A: Prior to setting off the process go into Word | Tools | Options | Spelling and Grammar - and uncheck

· Check Spelling as you type 

· Always suggest corrections 

· Check Grammar as you type 

· Check Grammar with spelling 
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1.4
OS: Windows
Q: I recently upgraded to AllFusion ERwin Data Modeler 4.1.4. Now, when I try to print to my PDF Writer, the image does not scale correctly to the specified paper size but, rather, prints an 8 1/2 by 11 page size image.
A: The appears to be a new problem and is being investigated. In the meantime, an easy workaround has been discovered and is as follows: 

  Exit AllFusion ERwin Data Modeler 

  In your System Settings set PDF Writer to be the default printer 

  Launch ERwin again 

  Print your model 

The scaling and printing issues should be resolved. 
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1.4
OS: Windows
Q: I recently upgraded to AllFusion ERwin Data Modeler 4.1.4. Now, when I try to print to my plotter, the image does not scale correctly to the specified paper size but, rather, prints an 8 1/2 by 11 page size image.
A: The appears to be a new problem and is being investigated. In the meantime, an easy workaround has been discovered and is as follows: 

  Exit AllFusion ERwin Data Modeler 

  In your System Settings set your plotter to be the default printer 

  Launch ERwin again 

  Print your model 

The scaling and printing issues should be resolved. 
	
	
	
	

	11/08/03
	Product: ERwin
Version: 4.1
OS: Windows
Q: Exporting from the Data Browser into Excel does not export my entire Definitions. It stops at 220 characters? Is this an ERwin limitation?
A: No, it is a DDE length limitation. To workaround this, please do the following:

1. In Data Browser, go to Export, select Export format HTML
2. Click Export button, save the file.
3. In Microsoft Excel, open the saved file.
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I've changed the preferences settings in the RTB but they don't seem to affect the current template. Why? 
A: In the Report template builder, when changing preferences while a report template is open, be sure to click on the Apply to Current Template button. The preferences changes will not take in the current template unless the button is clicked. Remembering this could save you a lot of aggravation trying to figure out why when changing the cell background color the old color is still there.
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I created a graphical report and exported the report file. When I sent the file to a co-worker, the co-worker cannot open the file. Basically, I am not able to email the report folder --Untitled to the co-worker. She also found that there is a subfolder called Image in the Untitled folder. There is a diagram0.jpeg file in the Image folder. If I cut the diagram0.jpeg file and paste it, then click untitled.htm file, it only gives the frame, not the diagram. 
A: This is the standard that AllFusion ERwin DM follows. The following are the possible solutions: 

  Create a folder on the share drive to save the report. 

  Use Winzip and Zip the files to send to co-workers. 

  Instruct the Co-worker to create a sub folder IMAGES and copy the jpeg files in it. 
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I want to create a report from AllFusion ERwin DM that will output only 2 columns. In the left-hand column I would like to display all attributes within the model and in the right-hand column I would like to display their associated entities. How do you do this? I would also like to do the opposite with Entities in the left-hand column and associated attributes in the right-hand Column.
A: The following steps will give you the report that you are interested in: 

  Create a new Report Template via Tools | Report Builder 

  Change the document properties (Title, Export As) as desired 

  In the "Available Sections" on the left-hand side, select Attribute and click the arrow button to add this to the Report Layout 

  Right-click on "Attribute" section and select Properties 

  Expand the list and select "Name" 

  Expand "Entity" and select "Name" 

  Click on the "Section" tab and change the "Section Layout" to "Hierarchical" 

  Save and Run the report. You should have 2 columns with the Attributes on the left-hand side and the associated "Entities" on the right-hand column. 

  To do the opposite, select "Entity" instead of "Attribute" in Step (3) and expand "Attributes" and select "Name" in step (6). 
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Using the data browser report the Entity Parent Relationship Child-to-Parent Phrase and Parent-to-Child phrase are being incorrectly matched to the corresponding associated foreign key attribute. 
A: The reason for this is that you are selecting items from the same level of the hierarchy and there is no means to match the attribute name with the relationship. Selecting attribute name will report on all attributes in the entity, not just the ones that are part of a relationship. To get the report you want, you should not select Attribute Name property and instead select under both Child Relationship and Parent Relationship -the Migrated Attribute Name property. That will produce the report you are looking for.
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: When using a simple diagram with some entities with relationships. In the RTB, selected:
Picture -

Relationship -

Parent Entity - Name

Run an html report and note when selecting the relationship line in picture, it returns "There is no information associated with this object" 
A: The following selections made in the Properties Dialog for the Pictures section, will take care of this problem:

Need to select:

Picture -

Relationship - Parent to Child Phrase

Parent Entity - Name

Also make sure that the Parent to Child Phrase is placed directly underneath Relationship option. 
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: How can I make sure that the diagram printout matches the image on the screen?
A: Before printing the diagram turn ON the "Match Print to Screen" option in the Format-Preferences dialog.
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: How to scale printing in AllFusion ERwin DM? 
A: Go to Format | Show Page Grid. If you don't see the page grid after selecting this then zoom out and it will then appear. Note that the page grids represent the Page Layout for printing and mimic the orientation and the X:Y ratio. So, the page grid you see on the screen can represent an E size or A size sheet if your printer/plotter has that size capability. So, you first want to be clear as to what size your printout sheet will be. You adjust this in File | Print Setup. Given that, you then can make a rational determination as to how the page grid size should be in relation to the objects on the screen. To adjust the page grid size, grab the grid at one of the intersections and move the grids to be larger or smaller. If you make the grids smaller you are essentially making the objects larger on the sheet. If you make the grids larger you are making the objects smaller on the print out sheet. The appropriate size of the grid is dependent upon the size of paper you are using. When you do a File | Print you will clearly see how the objects will print as well as how many sheets will be required. Increasing the sheet size will reduce the number of sheets needed. Determining readability may require a test print giving you guidance as to what final sizing tweaks are required.
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: How to produce a print report in PDF format with AllFusion ERwin DM 4.1?
A: In order to print in PDF format, you will need to install the Adobe Acrobat PDF Writer which will need to be purchased from Adobe. After you install the Adobe Acrobat, all you need to do is make the PDF Writer your default printer and simply send your AllFusion ERwin DM reports to that printer which will allow you to save your report as a PDF file. (NOTE: A comparable product such as "Click2PDF" may also be used.)
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: When attempting to print diagrams to an HP Design Jet 750C+ plotter it won't print the diagram correctly on A2, A1 and A0 paper. The print job constantly fails with an "out of memory" error. What should I do? 
A: There is an option within the latest driver for the HP750C+ printer (version dated 02/2002 or later) to process the print job using the memory of the computer as opposed to the printer memory. To change the printer driver options in AllFusion ERwin DM, perform the following: 

  Select File | Print Setup 

  Ensuring the HP Design Jet 750C+ (E/A0) by HP is listed, select
<Properties> 

  Click on the 'Advanced' tab 

  Click on <About> at the bottom of the tab and ensure that you are using the latest driver. 

  Click on <OK> 

  At the top of the tab you should see the 'Process Document' option. You can select '...In computer' so that all print processing is carried outon your PC. You will get a confirmation message so hit <OK>. At this stage you should also ensure that you have selected the right paper size etc. Once everything is set, click <OK> twice to come out of Print Setup 

  Select File | Print to print the diagram. 
	
	
	
	

	10/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Sometimes I have a problem printing my model. What should I do?
A: The first thing you can do is to try creating another Stored Display, especially in complex models. AllFusion ERwin DM's display functionality works more effectively when there is more than just the default Display1. If an existing Stored Display has a problem, then don't use it. Create another one.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: With Erwin 3.5.2, the Model Web Publisher was available to create PDF reports of Erwin models. Is there a similar facility in AllFusion ERwin DM 4.1? 
A: AllFusion Erwin Data Modeler 4.1 now has the Report Template Builder. You can use the Report Template Builder to easily and quickly create reports about your model. You can create reusable report templates and export reports in txt (.CSV), HTML and RTF formats. You can publish HTML output from the Report Template Builder on a Web server or company intranet, replacing features formerly supported by the ERwin Web Publisher software. If, however, you still need to create a PDF you will need to use a product like the Adobe Acrobat.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: In Erwin 3.5.2, in the report result set, if you modify some fields (which have a pen icon), the new change will go back to the model automatically. In AllFusion ERwin DM 4.X why doesn't the model reflect the changes made in the report result set?
A: In AllFusion ERwin DM 4.X, after you have made modifications in the field (which have pen icon) in the result set, changes will go back to the model automatically as soon as you "click" off of the cell you were editing. This functionality works just as it did in 3.5.2, Alternatively, you can click the COMMIT Change button, the yellow icon in the Toolbar when making a change to a field. After doing so, the model will reflect the changes made in the result set.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: There are no fonts displayed in the font toolbar or any of the font list-boxes in dialogs like "Default Font & Color," "Entity Font & Color," etc.? 
A: AllFusion ERwin DM uses printer fonts. The decision to use printing-capable fonts was made to minimize any discrepancies between the way a diagram is displayed on the screen and the way is printed. A printer needs to be attached to the computer on which AllFusion ERwin DM is running.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: How can you publish a very large diagram in HTML while all the objects are viewable? 
A: Try to create smaller subject areas then publish those as size of the picture is limited by available memory needed to produce a bitmap image.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I need to send my AllFusion ERwin DM data model to another user who does not have the AllFusion ERwin DM software installed. How can they read the model?
A: You can use the Report Template builder to create an HTML report with a JPEG picture of the model that you can publish to the Web. All the user would need to view this report will be a Web browser such as Internet Explorer. You can also purchase AllFusion ERwin Data Model Navigator to allow another user to view the model in a "read-only" format.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Datasource information is not available in the picture section for RTB. It is selectable in the property tree for columns.
A: If you select some information for the table, say, the "name" property, the report will work as you would expect it to. This is happening because you did not select any properties for the table in the picture section of the report. This is why it will not show the popup window.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Why does the RTB have options for reports "Attribute with duplicate name in Entity" and "Column with duplicate name in table" when these are no longer allowed in AllFusion ERwin DM?
A: Though these scenarios are currently not possible in a new model, these entries are kept for earlier model report generation where it might be possible.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: The options I expect to be available in RTB aren't there. 
A: Options available in the Report Template Builder depend on the model display when the RTB is launched. For example, if a logical/physical model is displayed in physical when opening the RTB, Picture annotation report choices will be Table, View and Relationship rather than Entity and Relationship.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: When using the data browser, how do I get the output to show duplicate entries ? 
A: What you need to do is:

- Edit the report format
- Select the column that you want to duplicate
- Click on heading
- Insert ! (exclamation mark) in the first position of the heading i.e. !Table Name
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: When running RTB reports on certain double-byte platforms (Chinese, Japanese, Korean, etc.) the text is not properly rendered (in RTF or HTML reports). Why? 
A: This happens when using non-localized version of AllFusion ERwin DM. The reason is that, by default, RTB uses a set of fonts ("Arial", "Times New Roman", etc) that are appropriate for English (or other one-byte languages). The default fonts can be modified using the Preferences dialog. Also, for an individual report, the fonts can be modified using the Properties dialog associated with each template item. Either way, the fonts need to be changed to something appropriate for the platform/language on which AllFusion ERwin DM is installed.
	
	
	
	

	10/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: What is the difference between the RTB properties and RTB preferences? IS there an overlap between these two functions? 
A: In RTB, "Properties" are at the document level. It is there you can put the Title, Header, Footer etc.. for the whole RTB output, either the web published out put of the rich text formatted document. "Preference" also has these but also allows for drilling down more into report details(e.g. Column etc)..
But the major difference is that Preferences can be saved as a template and whatever is saved therein will be the default. It can then be overwritten for a specific report in the Properties. In addition, it is only in the Preferences that you can change the logo that shows up in the report.
	
	
	
	

	12/30/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows

Q: When I use the Report Template Browser (RTB) to create an HTML Picture Report of my diagram, I sometimes get an error message that says that the diagram is too large. The message also suggests I breakup the diagram into smaller Subject Areas. How large is too large? And why does this process take so much of memory?
A: The RTB will attempt to generate the full image in the current stored display/subject area. Depending on the current zoom level, your screen may display only see a small piece of the actual "print area" or "picture area". Look at the scroll bars to gauge how large the whole image is. Now, to create the HTML Picture Report, ERwin first generates a bitmap, and then converts the bitmap to a .jpg file. In the bitmap, of course, each pixel in the total image, not just what is immediately visible on your screen, is represented. And, of course, even white background is part of a bitmap. This means that the model size has only an indirect bearing on the memory requirements to create the HTML Picture Report. A large model, with a smaller picture area, may be able to have pictures generated with x amount of memory, while a smaller model, zoomed out with a large area, may not. Creating a Subject Area, with only the elements you wish to depict, as opposed to being zoomed in to a small part of a large area, will minimize the amount of memory required to create you Picture Report. If you choose the option to select stored display at runtime, you will have the option to select a zoom level when you run the report.
	
	
	
	

	07/11/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: When printing (saving) to an Acrobat PDF to create the PDF, the file would complete but a few pages would be missing e.g. a 57 pages report would only have 55 page, missing 2 pages. What could be the reason?
A: The printer to be used must be set as the DEFAULT "before" launching the application. The page formatter uses the default printer immediately and does not re-adjust if you select a different printer.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 3.5.2, 4.x
OS: Windows

Q: How do I email an HTML report?
A: HTML reports, by default, are placed in a new folder in the C:\Program Files\Computer Associates\ERwin 4.0 (or 4.1)\Reports directory. This entire new folder (which will have the same name as the report) and all of its contents (including the Image files) must be supplied to the viewer, for them to be able to see the report in its entirety. If the file structure is changed, appropriate changes must be made in the HTML file to correctly map the references.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 4.x
OS: Windows

Q: How do I customize the logo for reports generated by Report Template Builder (RTB)?
A: Within the Report Template Builder (RTB) - Tools | Report Builder | Report Builder | New - go to Edit | Preferences, and in the General tab there is the option to change logo.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 4.0
OS: Windows

Q: I am using Report Template Builder but cannot get the annotations to work for HTML report. Why ?
A: Make sure that you are using IE 5.0 or later. ERwin 4.0 requires at least IE 5.0 to work with HTML and also XML format.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 4.0
OS: Windows 
Q: How do I email an HTML report?
A: When an HTML report is generated, it is placed by default in a new folder in the C:\Program Files\Computer Associates\ERwin 4.0\Reports directory. This entire new folder (which will have the same name as the report) and all of it's contents must be supplied to the viewer, for them to be able to see the report in it's entirety.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: Sometimes my diagrams do not print correctly. What could be the reason?
A: The printing issues are multi-fold and can be attributed to different reasons. The most common is the printer driver. Upgrading to the latest printer driver addresses most of them. In some cases using the post-script printer driver is a better alternate. If your issues are not resolved after updating/reinstalling the printer driver, please call technical support to look further into it. Some suggestions: True Type font prints better than the printer font. Also, under Format | Preferences | Display, there is a check box "Print Match to Screen" which can also be used for better results.
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	09/21/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am reverse engineering a SQL script generated from Microsoft SQL Server 2000. After it's finished, however, there are no tables, only a blank diagram.
A: Your SQL script generated in Microsoft SQL Server 2000 probably used international text (Unicode) format that Erwin does not support. Regenerate your script by going to Microsoft SQL Server Enterprise Manager, locate the database, right click to go to all tasks, generate sql script. This time, however, go to the Options tab, and select Windows Text (ANSI). The Reverse Engineering the ANSI format .sql file, and you should see all the tables.
	
	
	
	

	09/21/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When Reverse Engineering an SQL file, I get an error report containing "Error Token; Error Line; Skipped Section". Why?
A: These 'Error Tokens' are SQL clauses that are not currently supported by AllFusion ERwin Data Modeler version for this DBMS.
	
	
	
	

	09/21/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I Reverse Engineer just a few Tables from a Database?
A: Use Complete Compare by doing the following Steps:

1. Click File/New. 

2. Choose either Physical Only or Logical/Physical Model. 

3. Choose the Database to import Tables from. 

4. Click OK Button. 

5. Switch to Physical Side of Model, if Logical/Physical Model is chosen. 

6. Click Tools/Complete Compare. 

7. Choose Database Level Compare. 

8. Choose Database for Compare Current Model with. 

9. Choose Bi-directional for Sync Action. 

10. Click Next Button until Resolve Differences Screen and after Connecting to the Database. 

11. On the Resolve Differences Screen, you can scroll down to Table Section and choose the desired Table(s) and then click the Import button to the right. 

12. Once you have chosen all the desired Tables to Import, click Next Button.
Note: If you want to choose multiple Tables at the same time, hold down the Shift Key and use the up and down arrows to select Tables. 

13. Then the Import Changes Dialog will appear. 

14. Click the Start Import Button. 
	
	
	
	

	09/13/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am receiving an "ORA-01403 Data not found" error while Reverse Engineering from my Oracle database. Why?
A: One possibility is that you do not have sufficient privileges for all the system tables that Allfusion ERwin Data Modeler needs to read from.

In SQL*Plus, connect to the database that you are trying to connect from AllFusion ERwin Data Modeler. You will need permission to select from v$ system tables. Query the table v$nls_parameters as follows and make a note of the returned values. For example:

Select * from v$nls_parameters where parameter = 'NLS_LANGUAGE',
Example value: American.
Select * from v$nls_parameters where parameter = 'NLS_TERRITORY',
Example value: America.
Select * from v$nls_parameters where parameter = 'NLS_CHARACTERSET'.
Example value: AL32UTF8.
Next, concatenate above values as:

'NLS_LANGUAGE'_'NLS_TERRITORY'.'NLS_CHARACTERSET'
Using example above, you would get:

American_America.AL32UTF8,
Then go to Start/Setting/Control Panel/Advanced tab (this may vary depending on your operating system), click on the Environment Variables button, and then enter a System Variable:
Variable Value

Value

NLS_LANG
American_America.AL32UTF8
If this variable already exists, please consult your DBA as to how to proceed. Modifying this variable may affect your connection to other databases. 
	
	
	
	

	09/03/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How can I use AllFusion ERwin Data Modeler Naming Standards with Reverse Engineering to standardize the table/column names?
A: First reserve engineer the DMBS or DDL into an Erwin model, then follow these steps to convert the names using naming standard abbreviations:

1. In the physical model, on the Tools menu, choose Names, and then choose Model Naming Options. 

2. Click the Name Mapping tab. 

3. Select the Use Glossary check box for an object type. 

4. Click in the Abbreviation Type row for the model object type, and then select Abbreviation from the list. You must include abbreviations in the naming standards glossary before you can perform this step. 

5. Select RESET NAME and then click OK.
	
	
	
	

	07/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When Reverse Engineering from Oracle 8.x, I am getting the error message: "ORA-00942 TABLE OR VIEW DOES NOT EXIST".
A: Select permissions on the following nine tables are required for Reverse Engineering: 

1. dba_ind_partitions 

2. dba_part_indexes 

3. dba_free_space 

4. dba_segment 

5. dba_part_key_columns 

6. dba_part_tables 

7. dba_tab_partitions 

8. dba_tablespaces 

9. dba_data_files 

Check to ensure you have Select permissions on these tables. 
	
	
	
	

	07/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am Forward Engineering to Oracle 9i with partition info in model and am getting the error message "ORA-00439 feature not enabled: Partitioning."
A: Partitioning is an add-on cost option kin Oracle and needs to be installed. When it is installed you will see a message in SQL Plus similar to:

Connected to: 
Oracle8i Enterprise Edition Release 8.1.7.2.0 - Production 
With the Partitioning option
JServer Release 8.1.7.2.0 – Production
	
	
	
	

	07/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: The error "Extended Dynamic Support Disabled" is generated by AllFusion ERwin Data Modeler when Reverse Engineering from AS/400.
A: In your ODBC Data Source Administrator, go to the User DSN tab, highlight the AS400 DSN being used, and click Configure. Select the Packages tab, and deselect "Enable Extended Dynamic (Package) Support".
	
	
	
	

	07/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am getting "Error Sql code 551: Auth-id does not have the privilege to perform operation on object", when connecting to DB2 OS/390.
A: Verify that the correct Target Server is selected. This may occur if Version 5 is selected when actually connecting to a Version 6 of DB2 OS/390.
	
	
	
	

	06/21/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q: In Volumetrics, why are Sizing Estimates for Initial Table Size and/or Initial Size of Index (es) displayed as 0 K? 
A: Go to the Parameters tab and make sure that values of Table Factor and/or Index Factor are non-zero values. If these values are set as any character or 0, Sizing Estimates would display as 0 K since these values are used in estimating for Initial Table Size and/or Initial size of Index (es).
	
	
	
	

	06/21/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Microsoft Access 2002 database is not in the Target Database list. How can I Reverse Engineer from my Microsoft Access 2002 database? 
A: In the Reverse Engineer – Select Template dialog box, select Database: Access and Version: 2000. Use Admin as the User Name and leave the password blank. These options will Reverse Engineer a Microsoft Access 2002 database.
	
	
	
	

	05/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I create a DB2 Alternate Catalog using Erwin? 
A: Complete instructions on how to create a DB2 alternate catalog using ERwin at: Using the DB2 Alternate Catalog 
	
	
	
	

	05/03/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q: I am Reverse Engineering DB2/UDB 8.1 to an existing template that only has Domains and Validations, and I am getting the error: "IBM CLI Driver DB2/Linux SQL0206N." Why? 
A: The existing template is DB2/UDB 7.1 version, but you are actually Reverse Engineering the database is DB2/UDB 8.1 version. Resave the existing template as DB2/UDB 8.1 version, Reverse Engineer again, and the problem should be resolved. 
	
	
	
	

	03/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I'm getting duplicate trigger names. The trigger name is derived by appending the table name to some pre-set characters, then it truncates the name to meet the length restriction. How can I avoid getting duplicate trigger names?
A: Generating unique trigger name is especially difficult for databases, like DB2, that restrict the trigger's name to only 18 characters and for models whose table names are similar. However, by changing the built-in trigger Header template you can make the trigger name more unique. The default trigger name is generated using the following : t%action_%15 tablename. By using the substr macro you can help make the name more unique by grabbing the last 10 characters of the table name t%action_%substr(%tablename,8,10). Depending on the length of the names of the table in our model, you might need to adjust the beginning position and length in the substr macro above.
	
	
	
	

	03/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I reorder the columns that make up my PK constraint, Erwin automatically reorders the PK index columns to match but it does not automatically reorder the FK index columns to match. Why not?
A: Erwin needs to allow for maximum flexibility in designing databases. Since most databases allow some flexibility in column order for the FK index, Erwin by default does not automatically propagate a change in the column order to the FK index. It does of course propagate it to the FK constraint. A user can always reorder the columns in the index by opening up the index editor and using the up/down arrow to order the columns.
	
	
	
	

	03/11/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I generate scripts to my database every week. Is there anyway to export only the differences to a script rather than the entire script?
A: Use the Complete Compare tool to do a database level compare using the current model and the existing previous script. Once you get to the resolve differences screen, use the Preview Option to generate a script that can be saved. This generated script will include only the differences between the model and the script.
	
	
	
	

	03/01/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: My comments are not being generated during Forward Engineering, either for tables or columns. I'm using SQL Server 2000, and I can see them in the model, why is this?
A: In SQL Server, the table/column comments are stored using a Stored Procedure "sp_addextendedproperty". This procedure requires "Owner" as one of the parameters and, therefore, it is mandatory that tables be qualified with an owner. It does not mean that the tables have to be appended with an owner during Forward Engineering as the "Owner" option is different than the "Comment" in the Option Set. However, in Tables | Physical Property, the owner needs to be populated to satisfy the requirement of the procedure.
	
	
	
	

	02/20/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why do I get ORA-00942 'Table or View does not exist' error when Reverse Engineering tablespaces from Oracle?
A: Information for Tablespaces is stored in the DBA_DATA_FILES view. There are no Data Dictionary views similar to USER_DATA_FILES or ALL_DATA_FILES. Therefore ERwin queries the DBA_DATA_FILES view which some users do not have a SELECT privilege on. Ask your DBA to adjust your privileges and the RE again.
	
	
	
	

	02/17/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I reverse engineer a script, ERwin replaces existing default values (e.g. called DEFAULT_36) with a value in the script. Why?
A: ERwin generates defaults incrementally, based on the DEFAULT_N name (where N is a number). One should avoid using defaults based on this naming scheme in existing model templates.
	
	
	
	

	02/17/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I Forward Engineer, ERwin fails to generate its own default triggers for non-identifying relationships.
A: ERwin will not generate built-in triggers for relationships where the RI actions are set to NONE. Change them to NO ACTION instead, or another RI type.
	
	
	
	

	02/17/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: ERwin fails to parse a script where I have a reserved word as a name.
A: One should ensure the name used is delimited using the servers relevant operator. For example, "quoting" the name will remove any ambiguity, so will [square brackets].
	
	
	
	

	01/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Where is the ERWQUERY.TXT file saved during Reverse Engineering or Complete Compare?
A: During Reverse Engineering (RE), it is saved in the same folder where mmopn32.exe resides. In general it is same where ERwin is installed. If you have multiple mmopn32.exe on your PC, then it is saved in the same folder as mmopn32.exe where ERwin was launched. While Complete Comparing (CC), it is saved in the same folder where the current file was opened.
	
	
	
	

	01/16/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: In any DB2/UDB Database the column length is 40 characters but when it is Reverse Engineered the column length gets truncated to 18 characters. How can I reverse engineer the entire column name?
A: Go to Tools|Names|Model Naming Options and tab to Physical tab and change the default column length from 18 to 40 characters.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: I cannot get the objects that I expect to, when I Reverse Engineer from my Oracle database although I have appropriate privileges in Oracle. Why?
A: Spool erwquery.txt by pressing ctrl-shift-Q all together and look at the select statement of the objects not coming in to the model. Run this statement in SQL Plus to see what is returned. This method will give you a very good idea of what the database is being returned to AllFusion ERwin Data Modeler.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How can I Reverse Engineer just a part of the database and not the entire database?
A: A user can do this by using the complete compare function instead of Reverse Engineer, by running a compare of a blank model and the database. Then from the Complete Compare difference screen you would just import those objects that you are interested in.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How can you see which system tables queries are generated during RE? 
A: CTRL+SHIFT+Q hot key generates the log file ERWQuery.txt that shows which system tables queries are generated during RE.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How can I exclude relationships from being forward engineered to the database?
A: For individual relationships, In a Logical/Physical model mark the relationships as Logical Only. For all relationships in the model, you can un-check the RI options when Forward Engineering.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How can I exclude FKs from being forward engineered to the database?
A: In a Logical/Physical model individual FKs can be marked as Logical Only. Another way to do it is to mark the relationship Logical Only and uncheck the "Display FKs in the physical model for Logical Only relationships" option in the Preferences dialog.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How do you control column Order?
A: Concern yourself with 3 things

1. The display itself
2. Tools | Forward Engineering/Schema Generation | Options tab | Column | Physical Order check box (Click OK to set)
3. Tools | Complete Compare | Option Set | Column | Order and Physical Order check boxes.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How do you generate DDL according to the default Column order in your diagram, not the physical order? 
A: Go to Tools->Forward Engineer, click on Column in the left pane, and uncheck Physical Order on the right pane.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: When inserting a new column in a table's column list, the change would require renaming the existing table, creating the table with the modified structure and inserting from the renamed table. Before dropping the old table, how can you include statements in the DDL that AllFusion ERwin DM generates that would grant the privileges that used to exist on the table to users on the re-created table? 
A: The only way to do this is by adding a post script to the table with the appropriate GRANT statement in it.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: When Using an IBM UDB IEEE DB/2 7.1 Database, the generate create index statements include index names longer than 18 characters although the DB only accepts indices of up to 18 chars. Why?
A: From AllFusion ERwin Data Modeler: select TOOLS--->NAMES--->MODEL NAMING OPTIONS--->Physical, then set maximum length for INDEXES to 18.
	
	
	
	

	11/24/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: When reverse engineering a large databases, is there any trick to organizing the tables since they come back all bunched together? 
A: The following approach can help:

1. Layout model using FORMAT --> Preferences --> Layout model
2. Click the 'No Magnification' icon
3. Click 'Fit Model' icon
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: I am connecting to Oracle, DB2, etc. and specifying Owner, Tablespace or Database Names and AllFusion ERwin DM is not retrieving any Tables. What is the likely cause? 
A: Starting with 4.1 SP 1 build 2522, Owner, Tablespace and Database Name fields for Reverse Engineer and Complete Compare are Case Sensitive.
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: When attempting to reverse engineer from Access 2000 it is failing with Error -2146825259: Unknown error 0x800A0BD5. What are the possible reasons? 
A: The error message numbers returned during the reverse engineering process are as follows: 

  using an incorrect database password gives: Error -2146825257: Unknown error 0x800A0BD7 

  using an incorrect Password gives: Error -2146825259: Unknown error 0x800A0BD5 

  using an incorrect user name gives: Error -2146825259: Unknown error 0x800A0BD5 

  using an incorrect database gives: Error -2146825264: Unknown error 0x800A0BD0 

  using an incorrect system database does not seem to matter as the RE still goes through ok. 

  The user name should be set to Admin and the password left blank. The remaining three fields will be specific to the system the RE is being performed on. 
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Why is it that Reverse engineering via the catalog does not presently capture the table space container strings for example: 'MANAGED BY SYSTEM | DATABASE <container-string>' ?
A: AllFusion ERwin DM can only retrieve information from the catalog tables. Since DB2 doesn't record this information in the catalog tables, AllFusion ERwin DM is unable to capture that information via Reverse Engineering. The container-string specification can only be obtained through the DB2 Command window - for example: LIST TABLESPACE CONTAINER FOR <id> .
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: What are the different types of Reverse Engineering? 
A: There are two types: Catalog RE and Script RE. You can choose which one to use by setting either the Database or Script File radio button on the Reverse Engineer Set Options dialog. Catalog RE interrogates the DBMS catalog and uses the information it finds there to construct a model. AllFusion ERwin DM's catalog RE component knows the catalog structure of most contemporary DBMS systems. Script RE constructs a model by parsing a DATA DEFINITION LANGUAGE file. AllFusion ERwin DM has a sophisticated parser that is capable of interpreting the Data Definition Language of almost any available database.
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: In the Schema Generation dialog “Index” options, why is the PK Index option initially disabled for certain databases and enabled for others? 
A: Some database like DB2 UDB automatically create a PK index for a PK column. For such databases, the PK Index option is specifically disabled on invoking the FE dialog. AllFusion ERwin DM does this to avoid the creation of more than one PK index for the same table.
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: How does AllFusion ERwin DM determine that a relationship exists between two tables when Reverse Engineering a database or a script file? 
A: Normally, AllFusion ERwin DM uses Foreign Key constraints to determine that a relationship exists. For an identifying relationship the constraint looks something like this: 

(CONSTRAINT MY_REL FOREIGN KEY (KEY) REFERENCES E_1)
While for a non-identifying relationship it looks like this:

(CONSTRAINT MY_REL FOREIGN KEY (KEY) REFERENCES E_1 ON DELETE SET NULL)
However, you can ask AllFusion ERwin DM to infer relationships based on names or indexes. This is done by setting the Infer Relations checkbox on the Reverse Engineer Set Options dialog.
	
	
	
	

	11/17/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: After reverse engineering a SQL Server script file, no objects are created in the AllFusion ERwin DM model. Why could this happen?
A: This could be because the script file is in Unicode format. A solution is to save the script file as a MS-DOS text file.
	
	
	
	

	08/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Why doesn't the View DDL generated by AllFusion ERwin Data Modeler look like what is previewed in the Views Editor SQL Tab?
A: The Views Editor SQL Tab functionality does not reflect options that can be set at Forward Engineering time that may alter the generated SQL schema syntax. Because of this it may not show the exact syntax generated, this is an area of the product under review for future enhancement.
	
	
	
	

	08/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Reverse-engineering an Oracle (or DB2) database with the using the "Include only tables in TABLESPACES" filter set to a particular Tablespace, sometimes imports other Tablespaces too. Why does that happen?
A: When the Tablespace filter is specified during RE, AllFusion ERwin DM imports database objects from that Tablespace. If any object already imported is dependent on any other object for its completeness, then those parent objects also get imported independent of the filter. This behavior is not confined to just Tablespaces, but most other objects as well.
	
	
	
	

	08/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: While reverse-engineering from a DB2 390 catalog / database, Tablespace and index partition values such as ( 49,, 999999,0 ) get imported as ( 49., 999999.0 ). Why?
A: DB2 390 database allows COMMA to be the Decimal Point Indicator which is a custom setting during the database installation. Since AllFusion ERwin DM does not recognize this customization, say, a value such as 49, which means a decimal value 49.0 followed by another value would be read by AllFusion ERwin DM as 49 with one too many commas following it. AllFusion ERwin DM ignores the extra commas and just accepts a value 49. This situation can be presently resolved within Partition values, by manually editing the values after import.
	
	
	
	

	07/15/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: I want to use MySQL with ERwin but it is not listed as a supported database. How can I do this?
A: You can use the ODBC option as your Target Database. Help on using ERwin on non-supported DBMSs is available in the Tech Doc Using AllFusion ERwin Data Modeler with Unsupported DBMSs.

If you are using MySQL for prototyping, and then want to generate your model to another DBMS later such as Oracle, the default datatypes may not convert exactly as you would like and you may receive DBMS errors when you generate. You can override the defaults and specify how you want the datatypes to convert. If you have not used this functionality previously, simply go to the ERwin Help system, choose the Index tab, and enter the string "Datatype mapping:attaching datatype standards" for further instructions.
	
	
	
	

	07/15/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: How do you create a Forward Engineering option set?
A: You can create a Forward Engineering option set by clicking on the "New" button at the top of "FE Schema Generation" editor dialog, give the option set a name and then click OK
	
	
	
	

	07/15/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: Why does a DATA DEFINITION LANGUAGE script generated from an AllFusion ERwin DM model have "!!" (double exclamation marks) between trigger statements?
A: For certain databases like DB2 for 390, DB2 UDB and Interbase, there is a text-box in the Database -> Choose Database dialog, where the Trigger Delimiter can be specified by the user. Any text mentioned by the user here will be used as a suffix to a trigger.
	
	
	
	

	07/15/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: When I forward engineer a DB2/390 model why do the comments have a maximum line length of 72 characters?
A: This is done in order to make the DATA DEFINITION LANGUAGE compatible with SPUFI. This can be turned off by un-checking the wrap file output checkbox under “Other Options” in the Forward Engineering Schema Generation dialog.
	
	
	
	

	07/15/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: When I forward engineer a DB2/390 model why is the DATA DEFINITION LANGUAGE for “comments” formatted differently from the way they appear in the editor?
A: By default, all tabs in comments are replaced by one space. This can be turned off by un-checking the replace tabs with spaces checkbox under “Other Options” in the Forward Engineering Schema Generation dialog.
	
	
	
	

	06/23/03
	Product: ERwin
Version: 4.1
OS: Windows
Q: I'm Reverse Engineering from an Oracle database but I'm getting the error, "ORA-01403 no data found." Why?
A: This error message is probably due to an incompatible dharacter set in the client environment.

Run the query, "select * from v$nls_parameters" against your DBMS to determine the character set being used. If the NLS_CHARACTERSET parameter is set to UTF8, the NLS_LANG variable is probably not set correctly in your in environment/registry.

Go to Start - Settings - Control Panel and double click on the System icon. Click on Advanced tab. Change the NLS_LANG variable to AMERICAN_AMERICA.UTF8. Click on set-apply, then OK. If ERwin is running, close and relaunch, they try to Reverse Engineer again.
	
	
	
	

	05/29/03
	Product: ERwin
Version: 4.x
OS: Windows
Q: I am Forward Engineering using Access 2000 but am getting an "Unknown error" message on one FK constraint on one specific table. What could be the reason?
A: In Access 2000 or earlier versions, there is a limit of 31 Foreign Key constraints for one Table (31 Relationships on your diagram). Check to see if you are trying to generate a 32nd FK constraint. It could also be that the Verb Phrase in you diagram, which generates the FK constraint names in you database, has been left blank (or is a duplicate). Access must have a name for the constraint and will not accept duplicate names.
	
	
	
	

	05/27/03
	Product: ERwin
Version: 4.1
OS: Windows
Q: I'm Forward Engineering a database to Access and on one Table when I'm creating recursive foreign key constraint Access is giving me an "Unknown Error".
A: This can happen if you have created a recursive relationship (aka "fish hook") in an Entity and you have not role named the foreign key. Access does not allow a constraint where the primary key and foreign key have the same name. You will be able to see this easily in your diagram because the primary key and froreign key will be unified. Put a role name on the relationship, then FE again (or CC this one change), and you should be OK.
	
	
	
	

	05/15/03
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: How can I speed up Forward Engineering for large models?
A: When generating a Forward Engineering schema, if the Foreign Key Constraint Generation is selected as ALTER, then the tables are all defined alphabetically, followed by the ALTER statements. This is fine, since the tables have all been defined before any constraints are enforced. However, if you select the CREATE FK syntax, the tables are all generated in hierarchical order (i.e., grandparent, parent, child, grandchild). This ensures that a constraint does not reference a table that has not been created yet. The amount of time it takes to calculate the precedence of all these relationships on a few tables is negligible but in a rather large diagram with, it could be substantial.
	
	
	
	

	12/30/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: I'm trying to Reverse Engineer (RE) only the tables I own in my Oracle DBMS but ERwin won't pick up my tables or columns? I'm sure I have the Owner Name spelled correctly, and when I choose to RE all the tables and columns they show up, so what's going on?
A: The Owner name in Oracle is case sensitive and so ERwin passes it to the DBMS as a literal string. Make sure you have type the Owner Name with the correct case. Also, if you have chosen Current User in your RE options, you need to be sure you entered the User Name and Password with the correct case mixture for all characters.
	
	
	
	

	12/30/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: Is there any way to see the queries ERwin issues to the DBMS when it retrieves information during a Reverse Engineer (RE) or Complete Compare (CC) operation? If so, how would I do this?
A: Yes. Before Reverse Engineering or performing Complete Compare, press <ctrl><shift><Q>. ERwin will now prepare a text report of the queries used during the operation. Before the RE or CC, ERwin will prompt you to either to save the report as a file or display it on your screen. When the process is completed, press <ctrl><shift><Q> again to deactivate this functionality. If you chose to save the query information to a file, ERwin will have saved the query to a file name, ERWQUERY.TXT. This text file can be opened using any text editor.
	
	
	
	

	09/09/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows
Q: Reverse Engineering from Oracle 8.1.x starts retrieving the objects but stops giving errors ORA-3113 and ORA-3114. What could be the reason?
A: It is most likely the incompatibility of the characterset as defined in the Oracle database and as set in the environment on the client PC. To check this, run the following query from SQL*Plus:

Select * from V$NLS_PARAMETERS;

Most likely it is set to UTF8. If so, then on the client PC, go to the Environment and set the following variable:

Variable: NLS_LANG
Value: AMERICAN_AMERICA.UTF8

This should fix the problem, as the client PC is now able to handle the characterset from the database. In some cases, you may need to reboot the PC for this change to take effect.
	
	
	
	

	09/04/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows
Q: Does ERwin support Linked tables in Access 97/2000?
A: Yes, ERwin does Reverse Engineer the tables that are linked to other databases in Access. However, just as you cannot change the actual table while working with a linked table within Access, you must Forward Engineer any changes to the to the database where the actual tables reside.
	
	
	
	

	08/15/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows 
Q: When Reverse Engineering from DB2 AS/400 database, I get various errors that seem to be ODBC related. Any Suggestions?
A: Various problems Reverse Engineering from AS/400 can be addressed by ensuring the following settings in your DSN ODBC setup configuration: 

  Uncheck Enable extended dynamic (package) support 

  Select Do Not translate CCSID 65535 will solve other problems. 
	
	
	
	

	07/11/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1
OS: Windows 
Q: Is Reverse Engineering from AS/400 impacted by the settings in the ODBC / Data Source?
A: Reverse Engineering from AS/400 requires "IBM Client Access for AS/400" which also installs the required ODBC. While creating the data source:

  Deselect "Enable Extended Dynamic (Package) Support" 

  Select "Do Not Translate CCSID 65535". 
	
	
	
	

	05/15/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: Does ERwin support DDS for DB2 AS/400?
A: ERwin does not support DDS. If the database has been created using DDS, then the index information is stored in the logical files within AS/400. ERwin does not query that and without that sometimes the PK and FKs are not brought in and as a result relationships are also not created.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 3.5.2, 4.x
OS: Windows 

Q: Can ERwin import from an external data file?
A: Not directly but if the data file can be converted into MS Excel, it can be imported into MS Access database. ERwin can then Reverse Engineer from there.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 3.5.2, 4.x
OS: Windows 

Q: Reverse Engineering (RE) from a .sql file created by SQL Server 7 but no tables were created in the model. What could be the reason?
A: If the script file was created using International Text Unicode there may be some hidden characters in it. Select Windows Text (ANSI) format or MSDOS text (OEM) file format. In Enterprise Manager, you could right click on the Database | All Tasks | Generate SQL scripts. On Options tab, select either ANSI or OEM from File Format when creating the script file.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 3.5.2, 4.x
OS: Windows 

Q: Why does my Column Order differ in Forward Engineer Preview SQL Script, compared to my Diagram?
A: ERwin has two different orders for Columns. There is a Column Order, which is typically the same order as the Logical side of a Logical/Physical model, or what ERwin defaults to in a Physical model. There is also a Physical Order, which typically is in sync with the database column order. The display is different between the two orders. Column Order will have a line between Primary Keys and non-Primary Keys, but Physical Order will not. In Forward Engineering (FE), the default is Physical Order. If you want Column Order, you need to deselect the option "Physical Order" in Column section in the schema generation option in FE. The same is valid for Complete Compare (CC) as well.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 4.0
OS: Windows 

Q: Is it possible to have partial migration of the key(s) from a composite Primary Key in a parent table to the child table ?
A: Yes. Create an Alternate Key index with just the desired member(s) of the PK as the member(s) in the index. The key(s) will now be in both, a PK and AK indexes. Then, select the migration of the AK instead of the PK.
	
	
	
	

	03/06/02
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: After reverse engineering, my ERwin diagram does not have relationship lines.
A: Reverse engineering from SQL DDL scripts requires explicit SQL commands that define the foreign keys. Just because a column in one table has the same name as a column in another table does not mean that ERwin will assume a relationship. Such commands are usually found in SQL ALTER TABLE statements (the exception to this is Sybase and Microsoft SQL Server which also defines foreign keys through the execution of system stored procedure sp_foreignkey. ERwin will alsouse the sp_foreignkey statements in the DDL to draw the relationship lines).

ERwin 3.0 introduced the ability to infer relationships from indexes and same name keys. If you select this option, ERwin 3.x and 4.x will infer the relationships by examining the column names and indexes of each table. If two tables have a column with the same name, and one table has a unique index but the other does not, ERwin assumes the column with the unique index is a Primary Key. If a table has more than one unique index, ERwin infers the Primary Key and Relationships based on the criteria list in the ERwin help system. Search on "infer" to find this section.

Reverse engineering foreign keys through ODBC requires the ODBC driver to be LEVEL 2 compliant. A LEVEL 1 ODBC driver will not retrieve foreign key information from the database catalog (Please contact the ODBC driver manufacturer for information regarding the availability of LEVEL 2 drivers).
Reverse engineering Xbase databases will not retrieve foreign key information. Most Xbase databases do not support referential integrity constraints. Such constraints are usually found in application code and ERwin reverse engineers only the database catalog, not the application code.
	
	
	
	

	02/15/02
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows
Q: Reverse Engineering from Oracle 8.x does not bring in Primary Keys (PKs) and Indexes?
A: Check the database to verify that the Primary Key constraints or Unique indexes are there in the database. Another possibility is the character set - if it is UTF8, then the client needs to be set for UTF8 as well. To verify this run the following statement in SQL*Plus:
select * from v$nls_parameters;
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: SQL DDL generated by ERwin results in "<object> Already Exists" errors from the server.
A: You are trying to CREATE an object that already exists.

If this message appears after an ALTER TABLE statement that is defining a foreign key, look at the statement that immediately precedes the offending statement. If it is identical to the problem statement, you must choose the constraint name option from the "other options" group on the schema generation dialog box. Choosing this option will use the relationship physical name to uniquely name the foreign key constraints. This also requires uniquely named verb phrases.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: SQL DDL generated by ERwin results in "Table or View Does Not Exist" errors from the server.
A: You are trying to DROP a table that doesn't exist.
	
	
	
	

	05/10/00
	Product: ERwin
Version: 3.5.2, 4.0
OS: Windows 
Q: I was generating an Access Database, but I got the message "Execution Failed".
A: When forward-engineering to a Microsoft Access 7 database, be sure all relationships are named. Otherwise, you will see an "Execution Failed" message.
	
	
	
	

	Conversion from 3.5.2 to 4.0

	Date
	Question and Answer
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: With ERwin 3.5.2, the Model Web Publisher was available to create PDF reports of ERwin models. Is there a similar facility in AllFusion ERwin DM 4.1?
A: AllFusion ERwin DM 4.1 now has the Report Template Builder. You can use the Report Template Builder to easily and quickly create reports about your model. You can create reusable report templates and export reports in txt (.CSV), HTML, and RTF formats. You can publish HTML output from the Report Template Builder on a Web server or company intranet, replacing features formerly supported by the ERwin Web Publisher software. If, however, you still need to create a PDF, you will need to use a product like the Adobe Acrobat.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: When opening a 3.5.2 model in 4.1, the converted model has transforms. How were these transforms created? 
A: Supertype Subtype Identity(SSI) and many-to-many(M2M) transforms are being created by default for all supertype-subtype and many-to-many relationships that exist in the 3.5.2 models. Options are being introduced above 4.1 Service Pack 2b to provide control over creation of each of the two transform types when converting the 3.5.2 models to 4.1 format.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: When converting 3.5.2 models to AllFusion ERwin DM 4.1, there are some changes to Text Blocks and Subject Areas that I don't understand.
A: For instance, each Text Block is converted to separate text boxes for each subject area that it belongs to. When changing the content of a Text Block in AllFusion ERwin DM 4.1, the text is only changed in the Subject Area that is current. Why is the text block seen as a separate object in each subject area?

In ERwin 3.5.2, the user had the option of choosing which text blocks to include in different subject areas, thus when making a change to the text block it would change it wherever it was being used. However, in AllFusion ERwin DM 4.x, the text block is seen as a drawing object and these drawing objects are specific to the current stored display or the current subject area in which they are created. The implication of this is that you cannot link a drawing object in one subject area/stored display with another. You can copy and paste it, but they will not be linked and therefore, any changes in one will not be reflected in the other. The functionality of text blocks in 4.x is not the same as in 3.5.2.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: When migrating a 3.5.2 SP3 data model to version 4.X, the views are getting corrupted. Why are the business names displayed instead of the physical names? 
A: In ERwin 3.5.2, you had the option to View Column Alias under Display Options/Views, where by the user could turn ON or OFF the display of View Column Alias name. You could have both the View Column Alias and the view column expression or only the view column expression for display. But in AllFusion ERwin DM 4.X, the view design has been changed. You can have the View Column Alias and the view column expression both or only the View Column Alias (Business Name).
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: In ERwin 3.5.2, in the report result set, if you modify some fields (which have a pen icon), the new change will go back to the model automatically. But in AllFusion ERwin DM 4.X, the model does not reflect the changes made in the report result set. Why is this?
A: In AllFusion ERwin DM 4.X after you have made modifications in the field (which have pen icon) in the result set, you need to click the COMMIT Change button, the yellow icon in the Toolbar. After doing so, the model will reflect the changes made in the result set.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: What is the checkbox labeled "Display FKs in the physical model for logical-only relationships" under Preferences for?
A: This option affects the display of migrated foreign keys on the physical side of a logical physical model, when the Logical Only check box is selected in the Relationships dialog. This is documented in Help under "Set FK display options for logical-only relationships." It is important to note that changing the selection on this checkbox will affect not only the new relationships and FKs, but the whole model so it is by design that it changes the existing selections of logical-only properties on the foreign keys.

To provide compatibility, by default every 3.5.2 model, when opened in 4.1, will have this checkbox checked.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: Why are the format settings on all text boxes in my model lost on opening a model in AllFusion ERwin DM 4.1?
A: In ERwin 3.5.2, text in text boxes would automatically wrap to the next line at 40 characters. There were no user controls to modify the format settings. However, in 4.1, various formatting options have been provided for all Drawing Objects. On opening a 3.5.2 model in 4.1, the "Wrap Text" and other default settings are reset. The user can however, easily update the global settings to match his preferences (as described above).
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: Some foreign keys are not shown on the physical side of the model where they were shown in ERwin 3.5.2. Why is this?
A: The foreign keys for logical only relationships are by default not shown on the physical side. These are shown in 3.5.2. They can be shown by checking the display foreign keys in the physical model for logical only relationships checkbox under format preferences display.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: Why are the supertype/subtypes on 4.1 displaying differently on the physical side from 3.5.2? 
A: An identity transform is performed on the supertype/subtype when it is loaded from 3.5.2.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: Why are transforms being performed when I load 3.5.2 models when I didn't ask for it?
A: The transforms are performed to make the physical model appear the same as the generated DDL.
	
	
	
	

	12/31/03
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: When I load a 4.0 model into 4.1, why are the UDP values being shown in the wrong place?
A: Save your model as a 3.5.2 model in 4.0. Then when you load the 3.5.2 model into 4.1 they will be shown in the right place. This will only work if you have not made any 4.x specific changes to your model.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 3.5.2, 4.x
OS: Windows 
Q: What is the recommended conversion procedure from 3.5.2 to 4.x and vice versa?
A: While converting models from one version to another, it is suggested that you use the most recent build for each. Models from ERwin 3.5.2 should be from build 466 (SP3) or greater. If you have a 3.5.2 model, you simply open and save it in ERwin 4.x. If you have a 4.x model, and you would like to convert it back to 3.5.2, go to File | Save As and change the save as type to ERwin 3.5.2 (*.er1).
	
	
	
	

	Evaluation

	Date
	Question and Answer
	
	
	
	

	04/24/02
	Product: ERwin
Version: 4.x
OS: Windows 
Q: Where can I download the evaluation version from and how is it activated?
A: Evaluation downloads are now easier to get. These are under their respective categories and brands. For AllFusion ERwin Data Modeler, go to http://ca.com/products/ and select "Application Life Cycle Management". Click on "Data, Component and Business Process Modeling" which will take you to AllFusion ERwin Data Modeler. Under "Information Center", select "Downloads and Trials". Fill in the short form and you will promptly receive the site to download it from along with the evaluation key code to activate it.
	
	
	
	

	Complete Compare

	Date
	Question and Answer
	
	
	
	

	11/04/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In the Complete Compare - Items To Compare dialog, I check the radio button for Database and the enter a database name in the text box below but I still get all databases in the Teradata server. Why? 
A: That text box is part of the Tables/Views in Database control and enables you to filter all Tables/View with that database name, but it does not prevent ERwin from listing the other database available in that server.

If you want constrain your Complete Compare to only one database, do the following:
In the Items to Compare Option Set, uncheck the Database branch in the tree control so all other objects below (such as name, permanent, spool, account, etc.) become unchecked. In the Table/View in Database section, enter the database name you want. This will bring in Tables/Views only from the database you specified and no objects or names from other databases.
	
	
	
	

	11/04/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I check the Prefix Owner in my Complete Compare options because I want tables with different owners, but same names, to match; but the tables still show as unmatched in the Complete Compare (CC) Resolve Differences screen.
A: Table Prefixes are a way to aggregate tables (search Help under Prefix for an in depth explanation), but this option does not control the Table Owner property. On the Complete Compare - Other Model Filter Options dialog, you want to uncheck the Using Owner option. AllFusion ERwin Data Modeler will now ignore owner properties in both the model and database side and Complete Compare will show the tables as in sync. 
	
	
	
	

	11/04/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I used Complete Compare or Model Sync to export my changes from one diagram to another. When I examine the resulting model I find I am missing columns. What am I doing wrong?
A: If you are working with a logical/physical model, check the Logical Only property on one of the attributes of the source model that match the missing columns on the target model. If attributes are set to Logical Only, the columns will not appear in the physical model and will not be generated.
	
	
	
	

	11/04/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am using the Complete Compare feature of AllFusion ERwin to compare a model to a database. When I get to the Resolve Differences dialog, it updates the database, but I would like to see the DDL first. How can I do this?
A: When you are at the Resolve Differences dialog, and you have selected objects to Export, you can click on the Preview button to see the DDL script AllFusion ERwin Data Modeler will issue to the database. To save the script, press the diskette icon and you will presented with a File Save dialog.
	
	
	
	

	09/21/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When doing a Complete Compare, and while exporting column comments, my alter script says: "Action is no action".
A: Go to Tools, Forward Engineer, and in the Other Options window, checkComment, then do Complete Compare again and is should generate the comment script.
	
	
	
	

	08/12/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do you generate HTML in the Report Template Builder for a large diagram when you get an error that the diagram that is too big?
A: Try changing the Display settings on your PC True Colors. This may reduce the size of the JPEG being generated as part of the HTML process.
	
	
	
	

	08/12/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am doing a Complete Compare between a model to a database. At the Resolve Differences dialog, it updates the model or database but gives me no option to see or save the DDL script. How can I do this?
A: When you are at the Resolve Differences dialog and you have selected objects to Export, you should be able to press the PREVIEW button to see the DDL script. To save the script, press the save icon (it looks like a diskette).
	
	
	
	

	07/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am doing a Complete Compare against my Oracle 8i database and getting the error message, "Ora-01036 Illegal variable name/number."
A: Your current Oracle connectivity client may not support all objects is supported by your current version of Oracle Server. For example, you may be using Oracle Client 8 with Oracle DBMS 8i. Upgrading the client to Oracle 8i or 9i will likely resolve the problem. Check with your DBA if your are unsure of the version of your connectivity client.
	
	
	
	

	07/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am getting the error "ORA-01036: illegal variable name/number" when doing a Complete Compare/import. I have Oracle 9i as my client and Oracle 8.1.6 as the server.
A: You will get this error if you choose Oracle version 7.x from the Menu / Database / Choose Database window. Changing the Oracle version number to Oracle 8i should resolve the issue.
	
	
	
	

	06/21/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q: My change script during Complete Compare is using Insert SQL syntax. How do I change the syntax to Drop and Recreate syntax?
A: When you are on the "Complete Compare - Export Changes" Screen with the Insert Statements, click Save Data Button. On the "Data Preservation Options Dialog", check the "Force DROP/re-CREATE Table" checkbox. Then Click the OK Button. You will now see the Drop and Recreate syntax, instead of the Insert syntax.
	
	
	
	

	06/15/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am doing a Complete Compare with a database using Owner Name option but the Resolve Difference screen shows no tables on the left side. There are tables in the model so why is Complete Compare not showing them?
A: This is because either the "owner" field of the tables is not populated or there are no tables "owned" by the specified owners you specified. When you put "owner" name to do Complete Compare (CC) in "Items to Compare" section, and there are no tables matching the specified owners, it shows a blank on the left (model) side. Select 'All' in "Items to Compare" section to compare all the tables in the model. Then examine the Owner Names (or lack thereof).

In order to filter the tables from the database by owner(s), specify "Owner(s)" in the "Other Model Filter Option" section that is for database side. Add Owner Name(s) in uppercase (separated by comma if you have multiple names, and AllFusion ERwin Data Modeler which will retrieve the tables created by the owner you specified.
	
	
	
	

	05/26/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am Complete Comparing my model with a SQL Server 2000 database. When importing tables from my database I get the error:
'indexkey_property' is not a recognized function name" - what does it mean?
A: This message is displayed when your target database version in your model is different from the actual database to which you are connecting and Complete Comparing. For example, you might be connected to SQL Server 7.0 database, but the Target Database in your model is SQL Server 2000. Change the Target Server in your model to the same as your physical database, and try again. 
	
	
	
	

	05/26/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When doing a complete compare with my database I added a column at the end of a table. Why is AllFusion ERwin Data Modeler generating drop and recreate table syntax instead of alter table add column syntax?
A: Most probably you added the new column to the end of the list of columns while in Column Display and it is not really the last column. Right Mouse Button on the background of you display, choose Display, Physical View, and then view where your new column is in relation to the other columns. If you truly want it at the end, then move it there and AllFusion ERwin Data Modeler will use Alter Table Syntax when you do Complete Compare again. If you truly do want to insert a column between existing columns, AllFusion ERwin Data Modeler will user Drop and Recreate syntax since this is what is required by most databases to insert a new column between existing columns. 
	
	
	
	

	05/03/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q: I did a complete compare with SQL server 2000 database When importing tables from the database I received an error:
"'indexkey_property' is not a recognized function name." Why? 
A: This message may appear when your target database version is different from the database version. For example you may be comparing a SQL Server 7.0 database, but in AllFusion Erwin Data Modeler you selected SQL Server 2000. Reset the database in AllFusion Erwin Data Modeler to SQL server 7.0 to resolve the problem. 
	
	
	
	

	03/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am comparing my model with Informix 9.x database. In the model I have defined a new PK that does not exist in the database, but in resolving differences, Erwin does not pick up the PK in the model side. I am not able to export this PK into the database.
A: In compare options, you need to check on Type under column. In resolve differences dialog box it will show PK type: yes on the model side, on the database side it shows PK type: no. Highlight the PK type: yes, and click on export button, this will export the PK to the database.
	
	
	
	

	03/01/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In my Complete Compare, a difference shows for comments, even though the model was Forward Engineered to SQL 2000 database with comments selected. Comments on the database side were not picked up - why this difference? 
A: In SQL Server, the table/column comments are stored using a Stored Procedure "sp_addextendedproperty". This procedure requires "Owner" as one of the parameters and, therefore, it is mandatory that tables be qualified with an owner. It does not mean that the tables have to be appended with an owner during Forward Engineering as the "Owner" option is different than the "Comment" in the Option Set. However, in Tables | Physical Property, the owner needs to be populated to satisfy the requirement of the procedure.
	
	
	
	

	02/06/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am running a complete compare and exporting changes that require a table to get dropped and recreated. The indexes attached to the table do not get recreated. How can I recreate the indexes?
A: Before exporting the changes after a Complete Compare, you must go to Tools->FE->Index, and select the kind of index needed to be recreated under the Create Index section.
	
	
	
	

	11/17/03
	Product: ERwin
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Exporting a new column following a complete compare will generate an ALTER TABLE statement to add the column, but the COMMENT ON statement is not generated when there is a comment on that column. What should I do? 
A: When doing a complete compare export AllFusion ERwin DM uses Forward Engineering options to do the export. So, when you do a Complete Compare Export, select the items to export and click on Next. The Impact Analysis Report in the Complete Compare - Export Changes screen will not show the statement for comment export as the comment option is not selected by default. Now, click on the Gen Option button and check the comment check box in the options set. Click on Ok. You will see the Impact Analysis Report showing proper statements for comments. Click on Start Export button and the export completes successfully. You can also set the comment option in FE options set before starting the complete compare.
	
	
	
	

	11/17/03
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: How can you turn off the comparing of FK Indexes?
A: Uncheck the Generate property for each FK index that you don't want to appear in the Complete Compare - Resolve Differences screen.
	
	
	
	

	11/17/03
	Product: ERwin
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Complete Compare with a script file shows differences if the same tables are present in the script file and in the model. If either the script or the model has owners for the tables then Complete Compare will show mismatches. How do I avoid this? 
A: To match without owners, deselect the 'using owner' and 'using id' options from the "other model filter options" dialog. Then select the option "current model objects only." Performing the Complete compare will now match owned/un-owned tables based on their name.
	
	
	
	

	11/17/03
	Product: ERwin
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When using Complete Compare and you are comparing table definitions/comments, will any differences between the following comment delimiters /* and */ be ignored? 
A: If you would like for the differences to be displayed when using Complete Compare to compare table definitions and/or comments with delimiters, remove at least the leading delimiter from each example being compared.
	
	
	
	

	11/08/03
	Product: ERwin
Version: 4.1, 4.1.4
OS: Windows
Q: During Complete Compare, ERwin does not allow the export of Physical Properties only. If I add a DB space (for DB2) in an existing table, DB space difference is not identified during CC. It also looks different than 3.5.2, why?
A: At this time, AlFusion ERwin Data Modeler 4.1 does not support some "Alter" statements - e.g. "Alter Table modify..." syntaxes. Physical Storage Properties would also fall in that 'modify' category. Since that is not supported, ERwin generates DROP TABLE instead of ALTER statement and export is allowed only at the table level. This is why you can not choose to export at the physical property(ies) level. To get the Physical Properties, select the parent table, which will create the same code as 3.5.2. Make sure the FE option "Physical Storage" under the table section is selected. The change in functionality from 3.5.2 is only in the Complete Compare UI.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: When doing a Database-Level Complete Compare, my model and database UDPs (User Defined Properties) are not showing in the compare. Why?
A: When doing a Database-Level Complete Compare of a model with a database, UDPs are not considered for compare. There is no concept of AllFusion ERwin Data Modelers UDPs in a database, and hence complete Compare does not compare UDPs for Database-Level compare.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: Why might I see unexpected column order differences in Complete Compare?
A: If the column order difference is unexpected and unexplainable, you should check whether the original database tables were generated with Column - Physical Order checked. If it was unchecked, and the physical column order and display order are different, then the differences are expected. Complete Compare will always show the difference on the one that was not forward engineered to the database. That difference is useful information because it helps to determine which order was used by forward engineering. If you do not want to see any differences then you should decide to consistently use either of the orders (say the Physical Order), in your physical models.

You can uncheck the Column -> Physical Order option in Items to Compare list if you don't want to see them.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: I have the "Triggers" option disabled during a Complete Compare with the database, but when I export changes trigger code gets generated. Why? 
A: Options specified in the Complete Compare option set only govern the objects that will be compared. If the Triggers option is disabled in the Option set, it means that the triggers existing on the 2 sides will not get compared at all. However, while exporting any changes, the SQL is generated based on the Schema Generation options. Thus, trigger code would get generated if the Triggers option in FE is selected.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: Using AllFusion ERwin DM 4.1 and doing Complete Compare with an Oracle database, why don't I see all the tables on the database side? 
A: It may be that you are affected by the "case" of the Table Owner. You need to enter the Owner name in upper case. This is to address the situation where there are two users in the database with the same user id but different case (e.g. JOHN and John). AllFusion ERwin DM used to convert Owner names to ALL CAPS to match Oracle's system of storing them as ALL CAPS unless they were within quotes. However, if there was a user with a lower or mixed case, AllFusion ERwin DM's query would have missed it as the Owner name was always converted to ALL CAPS. This enhancement was implemented in AllFusion ERwin Data Modeler 4.1(SP1 and higher) and it is now possible to query the user with case sensitivity.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: What filtering options are available in Complete Compare? 
A: Complete Compare provides three filters presented as three dialogs. The "Items to Compare" dialog allows you to filter objects by type. You can include or exclude entire classes of objects by checking or un-checking the options shown in the tree. The "Object Filter Options" dialog allows you to include or exclude specific object instances of the current model. This is the model that appears on the left side of the resolve differences dialog. The "Other Model Filter" provides some filtering of the target model that appears on the right side of the resolve differences dialog.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: How does matching work in Complete Compare? 
A: Complete Compare builds a tree structure of the two models being compared and displays these side-by-side in the Resolve Differences dialog. Complete Compare attempts to match the objects in the tree based on various attributes such as name, GUID, etc. Matching means placing objects next to each other so that you can see the differences in the property sets. You can then import or export properties, objects or entire trees of objects from one model to the other. If AllFusion ERwin DM fails to match two objects that you know should match, you can force the match using the "Match" button in the "Alignment" group box.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: Why are you not able to de-select the Domains in the Complete Compare Option Set? 
A: The fact that the "Domain" item in the Complete Compare options is grayed out is by design. The user can deselect all the sub-items (properties) of the 'Domain' option but not the checkbox for the "Domain" object itself. This is because Complete Compare needs to consider the comparison of domains for objects based on domains, like attributes for example. User-defined domains, for example, would need to be compared because there may be attributes based on them inheriting domain properties.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: When I Forward Engineer a model to a database or script file, and then Complete Compare the model to the database or script file, the relationship names do not match? 
A: By default, AllFusion ERwin DM creates unnamed foreign key constraints in the database or script file. You can change this behavior by checking "Constraint Name" check box in the "Other Options" item of the Schema Generation dialog. Now AllFusion ERwin DM will assign a name to the Forward Engineered foreign key constraints and the relationship names will match during Complete Compare.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: How is Sync With Model Source different than Complete Compare? 
A: Sync with Model Source can only be used between two related models and matches all objects by an internal GUID id. You can use multiple filter options to exclude category of objects from Sync with Model Source. These filters are related with the link between the objects of the two models and are not available in a standard Complete Compare. The rest of the compare process is the same as in a standard Model Level Complete Compare.
	
	
	
	

	11/03/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: When comparing two models, Complete Compare offers me options of Database Level Compare and Model Compare specifying either Logical or Physical levels. What are the differences?
A: A Database level compare of two models will only involve objects in the model that can exist in the database.

In a Model level compare specifying the Physical side, you will compare both database objects and non database objects, such as UDP's and diagram specifics such as font and color.

In a Model level compare specifying the Logical side, you will the logical objects of the models. Some of the model properties are specific to a particular side of a model (e.g. physical storage, Stored Procedures etc Logical compare with another physical only model is not possible.
	
	
	
	

	06/13/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: When doing a Complete Compare between two models, only the Update Current is active in the Update Model - Set Options dialog. The Bidirectional and Update Other radio buttons are greyed out. Why?
A: When the target model's properties are set to Read Only, this will happen. Go to the target model through the Browse button on the same dialog box, or your Windows explorer, select the file, and RMB to see it's properties. If it is Read Only simply uncheck the Read Only.
	
	
	
	

	05/27/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: Where is the 'Gen As Constraint' set or established in ERwin Data Modeler? I can't find where to specify this in the model and when you do a complete compare it doesn't match the database. I'm working with an Oracle database. My compare report looks like the following:

PhysicalName:XAK1RENT_CNTRCT _CHRG

Gen As Constraint:-- -- -- Ignored Gen As Constraint:1
A: There are Two ways a constraint can be created under Oracle using the ERwin Forward Engineer settings: the constraint/index can be created either Implicitly by selecting 'Primary Key (PK)' - ALTER/PK' under Referential Integrity (then Oracle itself automatically creates an Index like 'SYS_C003760') OR by Explicitly by selecting Primary Key (PK) under the Index settings (and not selecting 'Primary Key (PK)' under Referential Integrity (then Oracle creates an index like 'XPKC_GEN').

Since for the 'Gen As Constraint' the Complete Compare shows '- - -' on the model side and a '1' on the db side, that means the index/constraint was generated Implicitly using an Alter Primary Key statement. You probably have an index that looks like 'XPKC_GEN' on the db, not 'SYS_C003760'.

So there are two options available to us at this time. We can either:
1. Drop the Primary Key Constraint ('XPKC_GEN) and then export a Unique Index.
OR 2. Deselect the 'Gen As Constraint' option in the Complete Compare so the difference no longer shows in the report.
	
	
	
	

	05/27/03
	Product: ERwin
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows
Q: I'm doing a complete compare using the default option set. The Complete Compare Resolve Difference screen shows nothing on the database side. I know the database has tables, so why does it not show anything?
A: Your option sets may be filtering out these objects. To shotgun them, try deselecting the check boxes 'Using Owner' and 'Using ID' in the option set under 'Complete Compare Other Model Filter Options' to turn these filters off. If the tables re-appear, you will know this is the case. The problem could be that your privileges give you access these objects, but you may not be the owner and they were simply being filtered out. Another possibility is that the name of the table owner is in a different case than what you specified.
	
	
	
	

	05/27/03
	Product: ERwin
Version: 4.1, 4.1.4
OS: Windows
Q: When Complete Comparing with Oracle 8i database, some of my tables whose names are identical to the triggers are missing. Why so?
A: The most likely reason could be that the database connection on ERwin is pointing to Oracle 8.0 instead of 8.1.x (8i). With ERwin 4.1, queries that retrieve information from the database were modified and are distinct for different versions of Oracle. Verify your selected database is the correct version of Oracle.
	
	
	
	

	02/21/03
	Product: ERwin
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In Physical Complete Compare, what is the difference between Database Level and Model Level compare? Also, how does it differ from the Logical side Model compare?
A: In Physical side, Complete Compare using Model level will compare against the Physical side of another .ER1 file. Some of the physical side properties are different from logical side (e.g. physical storage, Stored Procedures etc.) and this compare will only use the properties from physical side. The logical compare is for the logical side of another model. Logical compare with another physical only model is not doable as those two have varying properties and are not comparable.
	
	
	
	

	12/30/02
	Product: ERwin
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows 
Q: In the AllFusion ERwin Data Modeler 4.0 and 4.1, Complete Compare does not have a check box in the Option Set tree selection that allows me to compare the default triggers. ERwin 3.5.2 had this checkbox. Where did it go and/or how can I tell AllFusion ERwin Data Modeler to compare default triggers?
A: In 4.0, the Complete Compare default trigger compare option was omitted. It has been returned in 4.1, but it has been moved from the Option Set tree selection to a check box just to the right of the Option Set selection tree. Check that if you would like to compare the default RI triggers.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 3.5.2, 4.1.4
OS: Windows 
Q: Is the Owner name in Complete Compare case sensitive?
A: In the 'Items to Compare' | 'Compare Tables/Views owned by' screen, the owner name is case sensitive. When sending the select statement to the database to retrieve information, ERwin puts this owner information within quotes and it is treated as literal. If tables are not seen in Resolved differences screen, it could be one of the reasons.
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	Date
	Question and Answer
	
	
	
	

	08/12/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows 
Q: I am trying to update to or install the latest Service Pack, in this case 4.1.4 sp1, but it is taking a long time. The Task Manager shows that the CPU usage as being up to 95% at the silent.bat file.
A: The User Name with which you logged into Windows does not have Administrator privileges. You will need to get Administrator privileges for your User Name and re-run the install, or ask the Administrator to install your AllFusion product.
	
	
	
	

	05/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1.4
OS: Windows 
Q: I am trying to create a ModelMart on MS SQL Server and my db is named '2771' or similar number.
I get error, "SQL Server Vers. 7.x (using db-lib) error 170, severity 15: Line 1: Incorrect syntax near '2771'".
Why can't I connect to the db to create the mart? 
A: That can occur in MS SQL Server 2000 or v. 7. This issue will be addressed in a future build. The workaround is to specify a db name that begins with a letter (e.g., 'b2771').
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: AllFusion ERwin Data Modeler 4.1 is installed. How can I install the ERwinSpy utility?
A: Run the AllFusion ERwin DM installation CD, select Repair when the Modify, Remove or Repair menu appears and select to add the ADDIN ERwinSpy to complete the installation.
	
	
	
	

	08/04/02
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: I'm trying to install AllFusion ERwin Data Modeler, but the installation status bar keeps stopping at zero. Why?
A: Check to make sure you have administrator privileges on your PC. Depending on the state of your privileges, if you are less than an administrator, all sorts of odd things can happen during installation. This is definitely one of them on Win XP and other flavors of Windows.
	
	
	
	

	07/11/02
	Product: ERwin
Version: 4.0, 4.1
OS: Windows 
Q: There is no "Uninstall" option in ERwin. What is the recommended way for a clean uninstall?
A: The recommended way is to run the setup.exe again. If that build is found, the setup will provide three options - Modify, Repair or Remove. Use "Remove" to uninstall. It does not remove the ERwin folder so that still needs to be removed manually. The "Add/Remove" option in Windows also removes the application but some registry and CA-License files are not cleaned which can potentially cause problems while reinstalling the application. Also, when uninstalling and then reinstalling, it does not have to be registered again - simply hit cancel to the Register IT screen and it will pick up the previous registration.
	
	
	
	

	04/24/02
	Product: ERwin
Version: 4.x
OS: Windows 
Q: In 3.5.2, during installation, there was a visible bar indicating installation of DAO components. Now, Installing 4.x, it is not there; does ERwin still install the DAO?
A: DAO is now part of the install, just not separate like previously.
	
	
	
	

	Modeling

	Date
	Question and Answer
	
	
	
	

	11/04/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I have Recursive Relationship, known as Fish hook. However, I do not see a foreign key (FK) column in the table. How do I show the foreign key column in a recursive relationship?
A: Go to the Logical model and Right Mouse Click anywhere on the background. Select Entity Display and make sure Foreign Key Designator (FK) is checked. Right Mouse Click the relationship line. Select Relationship Properties and select the Rolename tab. Type a rolename into the Rolename field and click OK. Now the rolenamed column will appear as a foreign key.
	
	
	
	

	11/04/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I have a dimensional model and I am trying to create a view from two base tables. I am also trying to add another view relationship to a fact table but I got the message: "view relationships must be terminate on a view table."
A: A view is based on a table. The reason you got this error message is because you tried to add the view relationship from the view to the table. Try again, but after you select the view relationship line tool, click the fact table first, and then click the view; this will build the view relationship from the fact table to the view table.
	
	
	
	

	10/25/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In my modeling design, is it possible to have a primary key (PK) value as Null using AllFusion ERwin Data Modeler?
A: There are instances where AllFusion ERwin Data Modeler allows you to bend basic relational database principles, but this is not one of them. All elements of a primary key must have a value and cannot be null.
	
	
	
	

	10/25/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Does AllFusion ERwin Data Modeler handle DB2 Identity Columns?
A: Yes. To automatically generate a unique numeric value for each row in a table for DB2/390 7, or DB2/UDB, go to the Column Editor, select a datatype that supports Identity such as Decimal, Int, or Number, and you will see 'Generated Options' button appear on the right. Click that button and you will get a 'Generate' window. Here you can select Always or Default. Then check the Identity Box and you can enter the Start With, Increment By, Min Value, Max Value, Set Cache, and Cycle Values (if all needed).
	
	
	
	

	10/25/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I display the cardinality for a one-to-one relationship?
A: Turn on Cardinality in the display by right mouse clicking on the model background. In the shortcut menu, choose Relationship Display and then Cardinality. Then right mouse click on the relationship you are interested in, and select 'Relationship Properties...'. In the Relationship Editor, select the radio button 'EXACTLY' and type a '1' into the EXACTLY field. Press OK to exit the relationships editor and now a '1' should display alongside your relationship in the diagram.
	
	
	
	

	10/11/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How can I find all the tables related to a specific table? How can I then separate those tables from all the other tables in my model?
A: Go to the subject area editor and create a new subject area. Select the 'members' tab and in the Available Objects window select the table you are interested in. Now click the second button from the bottom. That will pop up the 'Spanning Neighborhood' window. In Spanning Neighborhood select the desired level of Ancestors and Descendants and click OK. That will populate your new subject area with all the tables that are related to that particular table.
	
	
	
	

	10/11/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How can I check my model for Third Normal Form?
A: That option is available with the purchase of an additional product called AllFusion Data Model Validator. AllFusion Data Model Validator can perform normalization analysis.
	
	
	
	

	10/11/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows
Q: Is there a way to incorporate the Oracle 9I XMLType into AllFusion ERwin Data Modeler? I don't see that as a selection under the column datatype.
A: You can make the XML type datatype available in AllFusion ERwin DM by modifying the Datatype Standards file. Here are the steps to do that:

1. Make sure your target database is specified as Oracle 9.x 

2. In the Logical View, Go to Tools | Datatypes | Edit Datatype Standards. 

3. Cancel the Model Manager connection box. 

4. In the 'Erwin Datatype Standards Editor' Select Mapping | Insert New Mapping. 

5. In 'From' choose LOGICAL and 'To' choose Oracle 9.x. 

6. Scroll to the bottom of the list and type XML (or any other name you want for this new datatype) in the 'From' Datatype. 

7. In the 'To' Datatype, scroll the list of available datatypes until you find SYS.XMLType. 

8. Choose to map XML to SYS.XMLType and save the DSM. 

9. Return to Tools | Datatypes | Model Datatype Options and apply the DSM file. 

Now all attributes assigned to the XML datatype in the logical diagram will translate to the XMLType in the physical diagram.
	
	
	
	

	09/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I selected 4 entities and press the right mouse button to access fonts/colors. I changed the fill color to yellow and hit OK, but only one entity was changed to yellow. How can I do this for all selected entities or tables in a diagram?
A: Yes it is possible. 

1. Make sure that you have the fonts and colors toolbar icons turned on. You can do that by selecting VIEW/TOOLBAR/FONTS & COLORS. 

2. Select all the entities/tables you want to change (use the shift + select or lasso select to highlight the objects you want). 

3. Select the appropriate icon from your toolbar to change the color of the text or the background or the outline. The icons look like a T with a colored rectangle for the text color. A paint can with a colored rectangle for the background or the pencil with a colored rectangle for the outline. Once you select a color it will apply to all object selected. 

You can also change the style and size of the fonts for selected text using the icons on the toolbar. Similarly, you can select multiple attributes or columns from your diagram and change their colors and fonts simultaneously.
	
	
	
	

	09/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How can I globally reset all my physical constraint names to the logical relationship names?
A: Go to Tools, Names, and the Model Naming Option dialog will appear. Select the Name Mapping Tab. Click the Reset Name button and the Globally Reset DBMS Property box will appear. Uncheck all options except All Relationship Names and click OK.

Caution: Be careful in choosing your options and in using this functionality. Global resetting cannot be undone. It is wise to have a backup file before performing any global resets. If you reset other names or properties accidentally, your only recourse is to go to a backup file or earlier version of your model. 
	
	
	
	

	09/21/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I checked off the "Many to Many Relationships With Associative Table" option under the Model Properties General tab, yet my physical diagram still does not display the association tables.
A: Checking that option will affect only new entities/tables created from this point forward. To create the association table on an existing many to many relationship do the following:

1. Select the m-m relationship 

2. Click the right mouse button 

3. Select create association table 

4. Run the Many to Many Relationship Transform Wizard that appears 
	
	
	
	

	09/13/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I copy and paste a child table with a FK, the pasted FK is missing on the diagram. Why?
A: This is as designed. The AllFusion ERwin Data Modeler Help System notes:

When you copy two or more entities or tables, any relationships between them are automatically copied, as are the foreign keys that are migrated through these relationships. However, if you copy only one entity or table in a relationship, ERwin does not copy the relationship. As a result, foreign key attributes or columns become "orphaned" and are included in the resulting entity or table as owned attributes. For example, if a child entity is copied but not its parent, foreign key attributes that migrated to the child from primary key or alternate key attributes in the parent entity become owned attributes of the child entity. 
	
	
	
	

	09/13/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Do I need to have Erwin installed in the machine in order to work with API coding?
A: Yes, API coding requires many dlls that come with Erwin installation.
	
	
	
	

	09/13/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I get the NSM Alternate Abbreviations to work?
A: Go to Tools | Names | Model Naming Options | Name Mapping tab and toggle the Abbreviation Type from Abbreviation to Alternate Abbreviation. You will only be able to do this for those lines where the Use Glossary check box is checked.
	
	
	
	

	09/13/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I can connect to Oracle database using SQL+, however, I get the error ORA-01041 while trying to connect from AllFusion ERwin Data Modeler. 
A: ORA-01041 is a very generic error message. On possibility is that the server to which the client is trying to connect to has not been started. Try pinging the server through SQL Plus.

Another possibility is that AllFusion ERwin Data Modeler cannot find the Oracle connectivity middleware. Try changing the Oracle entry in the PATH statement so that the Oracle home you are trying to connect to is the first entry among Oracle entries. 
	
	
	
	

	09/13/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When we execute a CC between an Oracle 7.3 model and the respective database, the error "ORA-01036: illegal variable name/number" pops us repeatedly. Why?
A: Here are a few suggestions to handle this issue: 

1. Make sure the Target Server Version of your model is the same as that of the DBMS you are working with. Often this message occurs because the wrong version of Oracle for the model does not match the version of the database.

The database User Name does not have adequate priveleges to access some system tables. Ask the DBA, who has all privileges, to login and try the same operation. If this works, the problem is probably your privileges. Please make sure you have select privilege for following tables for oracle database: 

1. dba_ind_partitions 

2. dba_part_indexes 

3. dba_free_space 

4. dba_segments 

5. dba_part_key_columns 

6. dba_part_tables 

7. dba_tab_partitions 

8. dba_tablespaces 

9. dba_data_files
	
	
	
	

	08/23/04
	Product: AllFusion ERwin Data Modeler Version
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do you show columns with indexes that are not Primary Keys or Foreign Keys?
A: AllFusion ERwin Data Modeler uses the concept of Alternate Keys and Inversion Entries for this purpose. You can show Alternate Keys and Inversion Entries in this way: Right click on a blank space in the workspace, select Table Display / Alternate Key Designator (Physical model) or Entity Display / Alternate Key Designator (Logical Model).
	
	
	
	

	08/23/04
	Product: AllFusion ERwin Data Modeler Version
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I change the names in my model from lower case to upper case?
A: Go to Tools--Names--Model Naming Options. Select the Logical tab--case and from the drop down list choose UPPER. Now select Physical tab-case, and from the drop down list, choose UPPER.
	
	
	
	

	08/23/04
	Product: AllFusion ERwin Data Modeler Version
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am using IBM iSeries. Where can I specify Allocate () for a VarChar datatype in AllFusion ERwin Data Modeler?
A: Go to the Column Editor, click on the iSeries Tab next to the Type drop down list. Allocate () is the place you can enter the number of bytes for a Char or VarChar datatype. 
	
	
	
	

	08/12/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I would like to create an AK/unique constraint, but not an AK index. However, ERwin always generates an AK or unique index. How can I create an AK constraint?
A: Go to tools/FE - Referential Integrity and check "Unique AK". Also uncheck "Alternative key AK" in FE/index/create index.
	
	
	
	

	05/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do you copy the tables from one Subject Area to a new Subject Area without creating duplicates?
A: Go to Model - Subject Areas. Highlight the Subject Area to copy and click New. Type in a new subject area name, then check the box "Copy members from <subject area name>" 
	
	
	
	

	05/27/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why am I getting the error "Column '<Column Name>' in Table '<Table NAME>' has word(s) which are NOT defined in the Naming Standards File's glossary" when I run the Tools/Names/Check Standards Compliance... on the Physical Side of a Model?
A: Check Standards Compliance expects to see all words for Table, Column, or Domain Names in the Abbreviation Column of the Tools/Names/Edit Naming Standards/Glossary Tab. Makes sure all words appear in the Word/Words and Abbreviation Columns, even if they are the same.
	
	
	
	

	03/01/04
	Product: AllFusion ERwin Data Modeler
Version: 3.5.2, 4.0, 4.1, 4.1.4
OS: Windows
Q: When I copy a table and then past it again within the same model, I always get a warning of duplicate names for each table/column. How can I avoid this?
A: In Erwin you have a choice over how to handle duplicate names. Under the Tools/Names/Model Naming Option/Duplicate Names you can tell Erwin exactly what to do when duplicate names are encountered while creating/copying objects.

The choices are: 

1. Allow duplicate names 

2. Automatically rename duplicate names 

3. Ask 

4. Disallow duplicate names.

The Allow Duplicate Name selection will eliminate the warning message, but you may be inadvertently be creating duplicate names which may generate errors when you Forward Engineer to your database. The Ask option will alert you of duplicate names, but then give you the option of renaming them at that moment so you can decide whether or not you really want duplicates, or to change the names. If the latter is the case, you are forced to do it immediately and this eliminates the possibility that you might forget to return to the pasted table/columns to rename them later. The choice is up to you.
	
	
	
	

	02/17/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In a logical/physical model, if the PK is marked logical only, the physical side does not have a PK but the relationship is still there. What is the purpose of displaying the relationship in the physical if the corresponding PKs are not there?
A: This is by design. Consider the possibility of a composite PK. If the PK is composite and there is more than one PK members and only one is marked Logical only, the other members would be expected to migrate to the Child via that relationship. You will want the relationship in that case. Therefore, ERwin allows both - the attributes as well as the relationships to be marked logical only, depending on the design needs.
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Is there a way within AllFusion ERwin DM to do a find and replace for the occurrence of a certain pattern in an attribute name with another name?
A: Not within AllFusion ERwin Data Modeler, but you can work around. For example, to change "country"' to "cnty" (just as an example) whenever it appears even as part of an attribute name, save the model in XML and do a find/replace in MS Word on the XML file. Then open the model back up in AllFusion ERwin DM. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Is there a way within AllFusion ERwin DM to search for a column name and then "drag and drop" and send it to a new table? 
A: Not only will the Data Browser allow the user to search for a column name, it permits users to copy and paste column names right in the report text thus directly updating the model through the report. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How can you get Comments from the Physical model to appear in Logical model Definitions? 
A: This state can occur if a person enters comments on the physical side or by a CC import. A RE will place comments into definitions by default. A CC import will not. In ERwin 4.1.4, there is a new checkbox in the comments box which will force the comment back to the logical side of a logical/physical model. For version 4.0 and 4.1 it was not so easy, but you can workaround it this way:
The following steps will help you get the Comments from the Physical model into the Definitions of the Logical model. 

1. In the Logical/Physical model derive a Physical Only model. Save. 

2. From the Physical Only model derive a Logical Only model. Save. 

3. Now Complete Compare the logical side of the Logical/Physical model to the Logical Only model. 

4. Import the Definitions into the logical side of the Logical/Physical model. Note: If you derive a Logical Only model directly from the Logical/Physical model you will not get the Comments to appear in the Definition. Why? Because the derive is pulling from the logical side of the model. However, initially deriving into a Physical Only model does capture the Comments because it is pulling from the physical side of the model. Now when you derive a Logical Only model from the Physical Only model there is no other place to pull information from other than the physical model so the Physical Comments in the Physical Only model are transformed into logical Definitions in the derived Logical Only model, thus setting up the Complete Compare import Definition scenario where you can do a Model Level Compare on the logical side of the Logical/Physical model to the Logical Only derived model. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do you Control column Order? 
A: Concern yourself with 3 things: 

1. The display itself 

2. Tools | Forward Engineering/Schema Generation | Options tab | Column | Physical Order check box (click OK to set) 

3. Tools | Complete Compare | Option Set | Column | Order and Physical Order check boxes. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When changing the length of column datatype on a domain, e.g. change varchar (20) to varchar (50) and then assign the domain to the column, in model display I do not see the datatype length for that column change. Why? 
A: Go to the column editor, click on reset button, reset the domain properties of datatype, click OK. The column will inherit the domain datatype change. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: My model has a FK column in a table that has no relationships going to it and it cannot be deleted. 
A: Open the model having first selected Tools - Diagnostics - FK Migration Check and Apply Check File Open options. The erroneous FK columns will be removed. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I decided to create User-Defined Domains. Through the attribute editor I linked the regular attributes to the corresponding UDDs, clicked "Reset"and in the next dialog clicked "Select All" and "OK." 
A: Now my attributes are named after one of AllFusion ERwin DM default domains. Why?

The above are the right steps, but make sure to deselect "Domain Parent" after you click "Select All" and before you click "OK" in the Reset Attribute Property dialog. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When trying to apply Domains to columns, applying them works fine, but if I later make changes in the datatype of the Domain (e.g. changing "Varchar2(128)" to "Varchar2(2000)"), the change is not reflected in the attached columns. 
A: Click the Reset push-button after changing the domain value to reset it. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In my model, the physical column names are different from the logical attribute names. How can I get them back in sync? 
A: Go to Physical Model, click Reset and you can select a partial column or all columns in the table or all columns in the model, check on physical name, click OK, this will reset column properties to the correct inherited name (based on either an associated domain or the model-defined naming standards), and make the column names in Physical Model in sync with attribute names in Logical Model, but the reset needs to be done at the physical level. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: After deriving a physical model from a logical model I tried to do a compliance check against the physical model, but none of the multi-word physical names passed the check. 
A: Probably your Naming Standards Model file contains multi-word abbreviations without underscores between them (since AllFusion ERwin DM automatically provides underscores when creating the physical names).

Export the NSM file, open it in Excel, and replace the blanks between the multi-word abbreviations with underscores. Import the updated file back into a new NSM file and run the compliance check against the new NSM file. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I messed up the relationship line. How can I bring it back to the default drawing? 
A: Right click on the relationship line and select "Relationship Auto Layout". 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When performing a roll-up or roll-down transform, I get warnings regarding attribute/column name changes because they are based on User-Defined Domains. What is the easiest solution to get around this issue? 
A: Rename the attribute/column and color-code the renamed object. All other properties will still be inherited from the related UDD. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I have to make a lot of comment changes. What is the best way for me to do this? 
A: Exploit the Data Browser as a huge productivity enhancer for editing text properties in the model. Any column displayed in the result set with a pencil icon in the column header can be edited and the edit can be committed to the model-not just the report. The grouping that is built into the reports can be broken to provide access to every row in the column by renaming the column header and inserting an exclamation point ("!") as a prefix. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Is there a way to group together supertypes and subtypes such that when one of these objects is moved around the screen, the whole lot moves? 
A: Use the CTRL key to highlight all of the objects that you want to group together (including the subtype relationship symbol) and press the 'Group' button on the AllFusion ERwin DM Alignment Toolbar (second button in from the right-hand side). 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How do I reuse some of my model objects and properties like domains, UDP, colors and fonts in different models? 
A: Create a template with the desired UDPs, domains or colors and fonts and when creating a new diagram, simply use this template instead of the default blank diagram. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Where is the logical-to-physical comment/definition synchronization check box (one for tables and entities and one for columns and attributes) in AllFusion ERwin DM 4.0/4.1? 
A: Just delete the physical comments. AllFusion ERwin DM will automatically sync the logical with the physical. You will then see the little asterisk on the top of the Description text box. This indicates that the logical and physical comments are in sync. No asterisk means that the link between the logical and physical has been broken. 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Is there is a way to concatenate physical names whose logical names have spaces rather than fill the physical names with underscores in place of spaces? 
A: Try the %Substitute macro, which performs a find and replace function: %Substitute(abcdfgdh,d,@) gives as output: abc@fg@h More complicated actions containing spaces to be replaced are also possible: %Substitute(abc fg h," "," @ ") gives as output: abc @ fg @ h 
	
	
	
	

	01/09/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I have a model that is generated in Oracle as well as SQL server using the "Choose database" option under the Database menu. The problem is when I convert from Oracle to SQL Server it asks me if I want to convert the datatypes. 
A: I opt for it and it converts the Oracle datatypes into SQL datatypes:
Number(1) --- Numeric(1)
Decimal(19)-- Decimal(19)
What I want is that the number(1) in oracle should be converted to TinyInt and Decimal(19) in Oracle to be converted to Numeric(19) datatype.
How can I achieve this? 

You need to define a data type mapping file (.dsm) and associate it to your model. This allows you to define exactly how you want to map data types between dbms' rather than accepting the AllFusion ERwin DM default mappings. The .dsm file is created in the Data Type Standards Editor, found under the TOOLS menu. 
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Definitions assigned to Entities and Attributes in AllFusion Process Modeler cannot be amended once they have been exported to AllFusion ERwin Data Modeler via .bpx. Why?
A: This is correct behavior. Once an object has been exported to AllFusion ERwin DM from AllFusion Process Modeler, it is considered to be owned by AllFusion ERwin DM and therefore, flagged as read-only in AllFusion Process Modeler. The same is true for objects exported from AllFusion ERwin DM to AllFusion Process Modeler via EAX. These too remain owned by AllFusion ERwin DM.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Is there a way to completely disassociate the logical model from the physical model for any given model? 
A: "Save As New Model" will totally disassociate the model source link. The result is two separate logical and physical models. To unlink related models all you need to do is to open the target model (the physical model) and go to Model-Model Sources menu to bring up the Model Sources Properties dialog. In the drop-down list, select the Model Source you want to remove and click on Delete button. From there on the two models are no longer related in any way.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When creating standard names in the glossary, how is it possible to have duplicate names within a given NSM that have different primary abbreviations? For example, they wanted the primary name, "CUSTOMER," to have two different abbreviations such as CUST and cu. 
A: Yes. It is possible to achieve this by using the "Alternate Abbreviation" function when creating the glossary.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Where can I find the list of databases supported by AllFusion ERwin Data Modeler 4.1?
A: You can look under the physical view of the Data Model and go to "choose database"' under "database" from menu bar, a screen of all supported databases will be displayed.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why are primary keys "NOT NULL" or "NULL"? 
A: Logically, a primary key (PK) can never be null. AllFusion ERwin DM does enforce this rule for most of the databases, but not all. There are databases which accept schema that specify the column as null, though it is a part of the PK. For example, Oracle accepts schema that says a column is null, though part of the PK, without throwing out an error. Oracle forces the column to be converted to a not null column internally. Please note that when reverse engineer brings this column into the model it will detect that Oracle has set it to NOT NULL.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is the relationship between Referential Integrity and Indexes?
A: Referential integrity refers to PK/foreign key (FK) generation. Referential integrity basically generates either triggers or declarative referential integrity SQL statements to enforce the relationships between the parents and child tables. Indexes are a database construct used to speed access, to order data, and optionally to enforce uniqueness.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What are identity columns? Why is it that you cannot create more than one in table? 
A: Most databases allow only one identity column per table, these columns maintain unique values in each row. If a user specifies an identity column as (7,2), what it means is the first row in the table will be 7 and the subsequent rows of the column are incremented by 2.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is the checkbox for that is labeled "Display FKs" in the physical model for logical-only relationships under Preferences?
A: This option affects the display of migrated foreign keys on the physical side of a logical physical model, when the Logical Only check box is selected in the Relationships dialog. This is documented in Help under "Set FK display options for logical-only relationships." It is important to note that changing the selection on this checkbox will affect not only the new relationships and FKs, but also the whole model, so it is by design that it changes the existing selections of logical-only properties on the foreign keys. Every 3.5.2 model when opened in 4.1 will have this checkbox checked.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I do not see a corresponding logical Datatype for the physical Datatype that I am using. Why?
A: There is one set of logical data types in AllFusion ERwin DM which is used across all supported DBMS. If you require a different logical datatype, the solution is to take advantage of the Datatype Standards Mapping feature. You can enter new logical datatypes in a mapping and correspond these to physical datatypes. If a Logical Datatype is not matched, AllFusion ERwin DM uses the domain default data type.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I tried to create a Datatype Standards file with a couple of datatype conversion matrices, but when I save the file and re-open it the matrices have disappeared. What should I do? 
A: ERwin will not save a mapping if nothing has been modified. In each of the matrices, make a change to one of the datatype conversions then the matrices will be kept. If you don't have a real change, make a "fake" change to each matrix. Then run a second pass and reverse the "fake" changes.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why is Derive New Model disabled in the drop down menu? 
A: You need to save the current model before you can initiate a Derive New Model process.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why is Sync with Model Source disabled in the drop down menu? 
A: Because this model was not derived from another model, no models were added to this model through the "Add Model Source" process and this model was not created from a split of a Logical/Physical model, therefore a Sync with Model Source cannot be performed for this model.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Dangling references are being displayed, and they cannot be deleted. What should I do? 
A: You need to uncheck the show dangling relationships from the format - relationship display menu option.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Can formatting options be applied globally to Text objects in a model? 
A: Yes. There is a feature in 4.1 that will help you to apply formatting options globally. Setting properties under Format -> Default Fonts and Colors -> Drawing Object Text will apply the settings globally.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In the Column editor, AllFusion ERwin does not recognize comments entered beyond a certain length. Why? 
A: In prior releases of AllFusion ERwin Data Modeler, lengthy comments could be entered in the Column editor for table columns. At the time of generating the column comments to the database, the comments were truncated to the length acceptable by the target database. However, this was inconsistent with Table comments. In the Table editor, comments can only be entered in lengths acceptable by the database. As part of recent changes, the behavior in Column editor has been made consistent with that on the Table editor.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Is there a shortcut to getting a readable model layout after a reverse engineer? 
A: Yes, if you go to "Format" in the main menu, select sub-menu "Preferences...", and choose "Layout" tab in "Format Preferences" editor. This will move and resize all the objects (including relationships) in the model.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I change my display level and then change it back, my user defined relationships move. Why? 
A: AllFusion ERwin Data Modeler attempts to keep the user defined relationship endpoints in the same place on the screen. This may not be possible if the display level changes. When you switch the display level back AllFusion ERwin DM will again try to maintain the same positions of the relationship endpoints so the original positions may not be maintained. This can be solved by using stored displays to store the different display levels.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why is the Row Guid checkbox in the Domain Dictionary disabled in a SQL Server model for the "unique identifier" datatype? 
A: SQL Server 2000 specifies that only one uniqueidentifier column in a table can be the ROWGUIDCOL. If AllFusion ERwin DM supported the ROWGUID property on user-defined domains, attaching a domain to more than one column in a table would create duplicate ROWGUID columns.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I create a user defined domain and drag and drop the domain on an entity, then make the domain physical only, the name of the column changes from the name of the user defined domain to the domain name. Why?
A: This is working as designed because the default name for columns %AttName and the default Name for the attributes is %AttDomain. Here we are not explicitly setting the name of the column. So it takes %AttName, which in turn takes %AttDomain and since the user defined domain is not available on the logical side, the name of the parent domain is used.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Some foreign keys are not shown on the physical side of the model where they were shown in Erwin 3.5.2? 
A: The foreign keys for logical only relationships are by default not shown on the physical side. These are shown in 3.5.2. They can be shown by checking the display foreign keys in the physical model for logical only relationships checkbox under format preferences display.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: Why are the CREATE INDEX statements not being created in the Forward Engineering script ddl? 
A: Check whether in the index editor the index has the "Generate" option as unchecked.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: How come AllFusion ERwin DM does not validate my user defined scripts? 
A: User defined scripts, such as views and triggers, are outside of AllFusion ERwin DM's control and it will not validate the script; it allows users to pretty much do what they want with a bit of SQL.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is reset of domain/datatype? 
A: On migration of FKs, the columns carry the same domain/datatype to the child table. If user edits the child column's datatype/domain, then this will be overridden over the parent value. If the column is further migrated down to other tables, the new value will be maintained. At any instant, if a user decides to go back to the original parent table domain/datatype anywhere in the chain, then AllFusion ERwin DM does offer the flexibility to do so by using the reset functionality. This can be done either on a chosen column or table or the whole model.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is the difference between the modeling Notations IDEF1X and IE? 
A: The IDEF1X and IE notations use different symbols to graphically represent entity and table relationships. The default notation that AllFusion ERwin DM uses for both the logical and physical model for the Blank model template is IDEF1X, but you can switch to IE notation at any time in either model.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I use the NSM file attached to my L/P model, Physical model table and column name do not change. Why? 
A: Make sure that in the Name mapping TAB, use glossary is checked on entity to table and attributes to column.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: When I user a hyphen in my names, it doesn't pass the compliance check. Why? 
A: Hyphen is not considered a valid character in name compliance check. For example, Word1-Word2 should not pass compliance check even if word1 and word2 are in the glossary and "-" is not in glossary.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is a Materialized View? 
A: In a physical model based on Oracle 8i or later, you can create a Materialized View which is a view that stores the result set of a query against any number of other views and tables. Materialized views can be used to improve the performance of queries. To the database user, a materialized view looks like a real table with a set of named columns and rows of data. However, a materialized view is not a permanently stored set of data values. The rows and columns of data visible through the materialized view are the result of the database query that defines the materialized view. You can use materialized views to:

· Create a customized presentation of the data stored in a database. 

· Restrict access to data, allowing different users access to only certain rows or columns of a materialized view. 

· Simplify database access by creating customized structures tailored to the needs of individual users. A user can write a simple query on a materialized view rather than a complex query on the actual database tables. 
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What are dangling relationships? 
A: Say you have two tables E_1 and E_2 in your main subject area with a relationship between them. Now you create a new subject area and move just E_1 into it. The new subject area has a dangling relationship from E_1 that does not connect to E_2 because E_2 is not in the new subject area. But, you can only see the dangling relationship if you select "Show Dangling Relationships" on the "Relationship Display" submenu of the "Format" menu.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: The Views Editor SQL Tab does not display an example Oracle 8 script exactly as it is in the file that is loaded into AllFusion ERwin DM? 
A: The Views Editor SQL Tab functionality needs enhancing. In essence, the SQL tab previews the SQL and shows correct syntax. It is not intended to show the exact syntax generated by FE as various options could and do change the generated SQL schema syntax.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I closed the Model Explorer; how do I get it back? 
A: If you have a model open, there is a Menu Item under View that will Show / Hide the Model Explorer. You can also use Ctrl + M to toggle it on and off.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I am unable to initialize when creating a new project from an AllFusion ERwin DM 4.1 model. Why?
A: Run the regsvr32.exe scapi.dll in the AllFusion ERwin Data Modeler, as the scapi.dll file is probably not registered properly.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What are effects of transforms on a model? 
A: Transforms help to resolve logical relationship like subtype or many-to- many relationships on the physical side. These relationships cannot be represented in the database directly, they have to be resolved to do so. AllFusion ERwin DM has the capability to do so automatically so that the user has the flexibility to keep the model as is on the logical side and on the physical side maintain the same information in the form consistent to the database.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: In the logical side I select a supertype-subtype symbol. Why isn't the transform button enabled so I can create a transform?
A: A transform already exists for that relationship but was applied on the physical side.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What are Transforms? 
A: Normalization is the process of putting one fact in one appropriate place. This optimizes updates at the expense of retrievals. When a fact is stored in only one place, retrieving many different but related facts usually requires going to many different places. This tends to slow the retrieval process. Updating is quicker, however, because the fact you're updating exists in only one place. Denormalization is the process of attempting to optimize the performance of a database by adding redundant data. It is sometimes necessary because some current DBMSs implement the relational model poorly. A true relational DBMS would allow for a fully normalized database at the logical level, whilst providing physical storage of data that is tuned for high performance.

Transforms are a way to denormalize a relational model in AllFusion ERwin DM.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is Horizontal and vertical partitioning transform? 
A: If separate pieces of one normalized table are accessed by different and distinct groups of users or applications, then consider splitting the table into two (or more) denormalized tables -one for each distinct processing group. The original table can also be maintained if other applications exist that access the entire table. In this scenario, the split tables should be handled as a special case of mirror table. If an additional table is not desired, then a view joining the tables could be provided instead. Tables can be split in one of two ways: vertically or horizontally. Vertical cuts a table column-wise, such that one group of columns is placed into one new table and the remaining columns are placed in another new table. A horizontally split table is a row-wise split. To split a table horizontally, rows are classified into groups via key ranges. The rows from one key range are placed in one table, those from another key range are placed in a different table, and so on.

Vertically split tables should be created by placing the primary key columns for the old, normalized table into both of the split tables. Designate one of the two, new tables as the parent table for the purposes of referential integrity unless the original table still exists. In this case, the original table should be the parent table in all-referential constraints. If this is the case and the split tables are read only, do not set up referential integrity (RI) for the split tables as they are being derived from a referentially intact source. RI would be redundant.

When a vertical split is being done, always include one row per primary key in each split table. Do not eliminate rows from either of the two tables for any reason. If rows are eliminated the update process and any retrieval process that must access data from both tables will be unnecessarily complicated. When a horizontal split is being done, try to split the rows between the new tables to avoid duplicating any one row in each new table. This is done by splitting using the primary key such that discrete key ranges are placed in separate split tables. Simply stated, the operation of UNION ALL, when applied to the horizontally split tables, should not add more rows than contained in the original, un-split tables. Likewise, it should not contain fewer rows either.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is 2-table denormalization Roll down Transform? 
A: If tables exist with a one-to-one relationship consider combining them into a single combined table. Sometimes, even one-to-many relationships can be combined into a single table, but the data update process will be significantly complicated because of the increase in redundant data.

For example, consider an application with two tables: DEPT (containing department data) and EMP (containing employee data). Combining the two tables into a large table named, for example, EMP_WITH_DEPT. This new table would contain all of the columns of both tables except for the redundant DEPTNO column (the join criteria). So, in addition to all of the employee information, all of the department information would also be contained on each employee row. This will result in many duplicate instances of the department data. Combined tables of this sort should be considered pre-joined tables and treated accordingly. Tables with one to one relationships should always be analyzed to determine if combination is useful.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is 2-table denormalization Roll Up Transform? 
A: Sometimes one or more columns from one table are accessed whenever data from another table is accessed. 

If these columns are accessed frequently with tables other than those in which they were initially defined, consider carrying them in those other tables as redundant data. By carrying these additional columns, joins can be eliminated and the speed of data retrieval will be enhanced. This should only be attempted if the normal access is debilitating.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is super type/ sub type Roll up and super type/ sub type Roll down transforms? 
A: A supertype/subtype roll up is a transform that is used to move all primary key and non-key attributes in the subtype entities up into the supertype entity. AllFusion ERwin DM creates a single entity to contain all primary key and non-key attributes from both the supertype and subtype entities.

A supertype/subtype roll down is a transform that is Used to move all primary key and non-key attributes in a supertype entity down into the subtype entities. AllFusion ERwin DM creates multiple entities to contain all primary key and non-key attributes from both the supertype entity and the subtype entities.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: If a date type UDP has been assigned to a column and a date has been entered for a particular column, if the type of the UDP is changed to text in the UDP Editor a number is left in the column's UDP field -most likely the Julian date. The new default value of the UDP is the only value that makes sense to replace the date with. Why? 
A: AllFusion ERwin DM is trying to represent the same value with a new form as dictated by the new datatype. If you restore the original datatype the correct original value is restored too. The conversion takes place even if the value was overridden on the column property because the property datatype was changed and now it needs to represent the same value in a new format dictated by the new datatype. Leaving the data in the field after the user has changed the datatype is simply doing what the user has asked.
	
	
	
	

	12/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What is a unified attribute?
A: Normally AllFusion ERwin DM does not allow more than one attribute of the same name within an entity. However, if several relationships migrate foreign keys of the same name into the table AllFusion ERwin DM "Unifies" the foreign keys into a single object. Internally, these foreign keys are stored as distinct attributes but are always displayed as a single foreign key.
	
	
	
	

	07/01/03
	Product: ERwin
Version: 4.1
OS: Windows
Q: Can I turn off the Relationship Lines in my diagram?
A: There is no specific functionality to do this because fK migration is at the core of almost all ERwin functionality. However, from a visual perspective, you can change the color of the Relationships to match the background and that essentially makes them become invisible (thought they are still there). For example, if you have a white background, Right Mouse Click on the background and choose Default Fonts & Colors from the pop up menu. Then go to the Relationship tab, change the color to white, specify that you want All Objects (i.e. all Relationships already created and those which will be created, click OK, and voila, the lines are gone.

The one drawback of this workaround is that if a Relationship line crosses a drawing object, it will still show up as a white line, so you may have to re-arrange a few lines, but for the most part, it accomplishes the task. To see the lines again, reverse the above procedure.
	
	
	
	

	06/06/03
	Product: ERwin
Version: 4.1
OS: Windows
Q: I notice some column comments have unexpected "funny" characters in them. How did these get here?
A: If the comment was copied from a Word document some formatting characters may have been copied also. Because ERwin comments are displayed as text only, they may appear as black boxes or other "funny" characters. Be careful to copy only text.
	
	
	
	

	05/27/03
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: How do I get column comments in a Logical/Physical model to appear as attribute definitions?
A: This is one client's suggestion to accomplish this and not necessarily a part of the design functionality. Migration from Physical comment to Logical definition is an outstanding enhancement request. 
  Derive a Physical Only model from the physical side of the model. Note how the column comment appears in the model. Save the new diagram. 

  From this new Physical Only diagram, derive a Logical Only model. Note how the column comment appears as an attribute definition. Save this diagram. 

  Open the original Logical/Physical diagram, and do a Model Level Compare on the logical side against this new derived Logical only model. 

  Note how the attribute definition appears as a difference enabling you to import the attribute definition. 

Note that if you attempt to initially derive to a logical only model, you do not get the column comment. By first creating a Physical Only model you force the derive functionality to include the column comment when you derive a Logical only from a Physical only model. 
	
	
	
	

	05/27/03
	Product: ERwin
Version: 4.1
OS: Windows
Q: I am trying to derive a model from a Logical/Physical model but the Derive option under the Tools menu is grayed out. Why?
A: You can derive only from a model that has been saved. Save the current diagram being used to Derive from and the option will be available.
	
	
	
	

	05/15/03
	Product: ERwin
Version: 4.0, 4.1
OS: Windows
Q: I tried deriving a new model but the menu ‘Derive New Model’ under Tools is grayed out. How can it be activated?
A: Derivation is possible only off a diagram that has been saved. To activate the ‘Derive New Model’, simply save a diagram and it will no longer be grayed out.
	
	
	
	

	Volumertics
	
	
	
	

	Date
	Question and Answer
	
	
	
	

	08/18/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Using Volumetrics, the Average Row Size is less than what it should be. For example, with Oracle 8i as my target database, if there are three (3) columns with decimal(7,2) datatype, Average Row Size shows as 11 when it should be 12 (4*3). Why this difference?
A: The Average Row Size is not a simple multiple of 4*3 (for 3 columns...). It is also calculated taking into account the volumetric information.

The formula for calculating the row size is:
row_size = round((( length((p) + s) / 2)) + 1
where:
p - for varchar2 expected number of characters for column, for number
where p = number of digits and s = 0 for positive and 1 for negative,
for date use 7
+ 1 byte per column in row
+ 3 byte row overhead per row
...so, for a table with three (3) decimal(7,2) columns (i.e. 7 digits), it'd be
    ((7 + 0) / 2) + 1 = 4.5 bytes
    4.5 + 3 (columns) = 7.5 bytes
    7.5 + 3 (overhead) = 10.5 bytes
Rounded, this would be 11 bytes which is what ERwin shows.

Another way to look at it is as follows:
The data map table in ERwin specifies that each digit in decimal data type occupy 4 bits. Therefore, the total number of bits for decimal (7,2) is 7 * 4 = 28, which is approximately equal to 32 bits (after rounding). 32 bits is 4 Bytes. For three columns the average row size is (7 * 4) * 3 = 84 bits, which is 11 Bytes after rounding. The reason for the difference is to control the propagation of the round off error. 
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	Date
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	11/25/02
	Product: AllFusion Model Validator
Version: 4.1
OS: Windows
Q: How do I Export a Report to HTM?
A: To export a report to HTML, follow these steps:

  Select the report you want to export. 

  Click the Export to HTML toolbar button (between the Zoom (Magnifying Glass) and About (Questions Mark) Icons). 

  Choose the Directory you want to save the HTML File to. 

  Give the HTML File a File Name. 

  Click OK. 

  To display the report in your browser, go to the directory you specified in Step 3 and double-click on the name you specified in step 4. 
	
	
	
	

	11/25/02
	Product: AllFusion Model Validator
Version: 4.1
OS: Windows
Q: "Getting Error Unable to initialize ERwin interface", when trying to open an Erwin model in Examiner/Validator.
A: Go to Tools...Preferences...General Settings. If the "Use ERwin 3.52 API" checkbox is on, turn it off. Now open the Erwin Model again in Examiner/Validator.
	
	
	
	

	11/12/02
	Product: AllFusion ERwin Data Modeler
Version: 4.0
OS: Windows
Q: I get the error message: "Cannot open model", for both new and existing models. I have the correct version of Erwin for my AllFusion Model Validator (See Product Compatibility Matrix).
A: Check the version you have loaded of the OCX "Tab32x20.ocx". If it is version 2.0.0.45, then please contact CA AllFusion Modeling Suite Technical Support to get an updated OCX.
	
	
	
	

	09/04/02
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows
Q: Which versions of AllFusion ERwin Data Modeler (formerly ERwin) are compatible with AllFusion Model Validator (formerly ERwin Examiner)?
A: In general, the the two products move in lock step with regard to versions and service packs. The one exception is ERwin Examiner 4.0 SP2 works with both ERwin 4.0 SP2 and SP3. For a complete listing of all versions for both products, please inspect our Product Compatibility Matrix
	
	
	
	

	Licensing/Registration

	Date
	Question and Answer
	
	
	
	

	01/30/04
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: What my Registration ID is for my Allfusion product? I no longer have the original installation CD that included the Registration CD on the packaging.
A: To locate the registration ID that you used to register your software originally, you can open the file C:\CA_LIC\regit.log in your notepad and look for the Registration ID in this log file. The one you would be interested in for Erwin would read as follows: 

<date> <time> RegIT (License Generation): AllFusion ERwin Data Modeler 4.1 Registration ID = <registration ID> Product code = 3ER1.

Where the values in <> are variable. Also, note that this can be used for any other CA software but the description would coincide with that software.

For example: AllFusion Process Modeler (BPwin 4.1) Registration ID = <Registration ID> Product code = 3BP1, would be the entry for Process Modeler.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: WINDOWS
Q: After I apply the patch, do I need to rerun RegisterIT to register the software again?
A: No. You only need to register once on a machine for a product.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: WINDOWS
Q: Where do I find the Registration ID for AllFusion ERwin DM?
A: It should be on the back of the AllFusion ERwin DM CD Sleeve or the License Certificate.
	
	
	
	

	10/10/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: WINDOWS
Q: Is there a way to install the licensing files and ca_lic directory to a location other than the root of the c:\ drive? What if my machine has no C:\ drive, for example, on a CITRIX system?
A: In order to alter the installation path of the CA license subsystem, a modified product installation is required. When a CA product is installed, the installation routine calls the silent.bat file, which performs an unattended installation of the CA license subsystem, using the install.rsp response file for its input. In order to alter the default installation path of the license runtime and its associated files, the install.rsp file must be modified to reflect the desired installation paths prior to product installation.

Follow the following steps to alter the installation location of the CA license subsystem for a clean product installation:

1. Copy the product installation CD to a temporary directory on your hard drive.

2. Locate the install.rsp file and remove the read-only attribute. (The exact location of the install.rsp file on the install media will vary from product to product, but generally may be found in a common directory called 'license' or 'licfiles'. Use the find feature to locate the file in the temporary directory, if necessary)

3. Open the install.rsp file with an ascii text editor, such as notepad, and edit all the installation paths under the following headings to the desired path for your installation:

[destination_path]

[caapps_path]

4. Run the product setup as normal, it will now use the edited values for the installation path of the CA license runtime and common applications.

Please note that subsequent installations of other CA products or options would need to be performed with this modified installation method, otherwise, they will by default install the license system and its associated registry values to the c:\ca_lic directory path again. 
	
	
	
	

	10/10/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: WINDOWS
Q: What if the machine I am registering doesn't have Internet access to RegisterIT Online?
A: Assuming you do have at least one internet-capable windows machine in your environment, you can use one of the Remote registration methods available in RegisterIT. Consult the RegisterIT How-To for step-by-step instructions on the Remote RegisterIT method. Otherwise, follow the prompts for Register Now > By Phone, and a TLC representative will assist you with the registration.
	
	
	
	

	10/10/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: WINDOWS
Q: Can I make a backup of my RegisterIT license file so that I do not need to run the RegisterIT wizard to reinstall on the same machine?
A: Yes. The license file used by all of CA's Workgroup-, Advanced-, and Enterprise- Edition products is the ca.olf, which resides in the ca_lic directory. After completing the RegisterIT wizard, backup the ca.olf to a floppy disk and label it with the machine's name. In event of a disaster, restore the backed up ca.olf to the ca_lic directory of the rebuilt machine. Note that the ca.olf is machine specific, and would not be valid on another piece of hardware- you would need to re-register the product on a new machine.
	
	
	
	

	09/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: After I apply a Service Pack, do I need to rerun RegisterIT to register the software again?
A: No. You only need to register once on a machine for a product when initially installed.
	
	
	
	

	09/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Will I get notified when the new AllFusion ERwin DM Service Pack is released? 
A: You need to register with the eSupport newsletter under E-News on the http://esupport.ca.com page. To register and access archived newsletters, click the E-News link on the left hand side bar.
	
	
	
	

	09/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Is there a way to retrieve the Registration IDs I used on a particular machine? 
A: RegisterIT maintains a log file, regit.log, in the local directory (usually ca_lic) which contains a complete history of RegisterIT's actions on the machine, including what customer id, zip code, and registration id was used.
	
	
	
	

	09/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: What is the difference between my RegisterIT Customer ID and my Support Site ID?
A: Your RegisterIT Customer ID is an 8-digit number that identifies your organization (or data center location for larger enterprises) in CA's RegisterIT registration database; this is the number under which the history of your workgroup/advanced edition product registrations will be recorded. You would use this number when registering additional products via RegisterIT such as AllFusion Model Validator or AllFusion.

Your Site ID is a 6- or 7-digit number that identifies your organization in our support call tracking database. You use this number when contacting CA support.
	
	
	
	

	09/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I'm trying to install ERwin on a Server, but how do I work around the RegisterIT part so that each person does not have to run RegisterIT?
A: AllFusion ERwin Data Modeler is licensed per user (actually per PC). Each person who will be using ERwin must run RegisterIT and the installation from their workstation so that workstation can be registered as having ERwin installed on it.
	
	
	
	

	09/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I've recently purchased (or been assigned) a new PC. When I install ERwin and run RegisterIT, it tells me that ERwin is already installed on another PC. How do I get the registration records updated?
A: Contact the CA Total License Care (TLC) group at http://esupport.ca.com/index.html?tlc or by calling your local Technical Support # which can be found at http://esupport.ca.com/public/ca_common_docs/tlckeyreg/contact_tlc.asp.
	
	
	
	

	09/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I've been using AllFusion ERwin Data Modeler with a trial license which has now expired; how can I get this renewed?
A: The trial license is good for 30 days. After that you must call CA Sales at 1.800.78ERwin to have it renewed for a limited time while you make your decision to purchase.
	
	
	
	

	09/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: I'm running RegisterIT during my AllFusion ERwin Data Modeler install, but my company's firewall does not seem to be allowing the behind the scenes registration. How can I complete my installation?
A: You can call CA's Total License Care Group by through your local # which can be found at http://esupport.ca.com/public/ca_common_docs/tlckeyreg/contact_tlc.asp. You can also register by email per the instruction on the RegisterIT screen. As a last resort, you can choose Register Later and then the installation will complete. However, if you choose Register Later, you will still need to Register on-line, by phone, or by email at some point. Although "Register Later" will provide you with a permanent license, you will receive periodic messages stating "License key produced by Register Later". Also, you will not receive any email updates or other benefits to registered users since your product registration information will not be in the CA database. To realize the full value of your investment, be sure to Register by contacting CA with one of the alternative methods above.
	
	
	
	

	09/05/03
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows
Q: Where can I go for general information about RegisterIT, registration and licensing?
A: http://esupport.ca.com/index.html?tlc
	
	
	
	

	08/04/02
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: Do I need to run RegisterIT again if I'm upgrading from ERwin 4.0 to AllFusion ERwin Data Modeler 4.1?
A: No. If you had previously registered ERwin 4.0, when upgrade to AllFusion ERwin Data Modeler version 4.1 you do not need to register again. Your registration information is stored on your local hard drive. When the registration appears, just cancel it.
	
	
	
	

	08/04/02
	Product: AllFusion ERwin Data Modeler
Version: 4.1
OS: Windows 
Q: If I have AllFusion ERwin Data Modeler installed on my office PC, is it legal to install it on my laptop or my home PC?
A: No. AllFusion ERwin Data Modeler is not licensed by the "seat" so that regardless of the number of installations, as long as the number of "seats" is within the license, you are legal. In the case of AllFusion ERwin Data Modeler, and most development tools, each product license is for one particular copy of the product installed on one particular PC. You would need an additional license to legally run AllFusion ERwin Data Modeler 4.1 on another PC either at home or on your laptop.
	
	
	
	

	Upgrade

	Date
	Question and Answer
	
	
	
	

	07/23/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: How do you retain the check box of Allow Manual Layout for models created in AllFusion Erwin Data Modeler 4.1 and opened in AllFusion Erwin Data Modeler 4.1.4?
A: The check in the box of Allow Manual layout will be lost after marking it and saving the model. The workaround is to mark it from Format/Preferences and then scroll to the top left of the diagram (the purpose being to put diagram in beginning position). Now save the model. This will retain the check box. 

This has been resolved and improved in 4.1.4 sp1. Details can be found in the 4.1.4 sp1.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Will I get notified when the new AllFusion ERwin DM Service Pack is released?
A: You need to register with the Technical Support newsletter under E-News on the http://esupport.ca.com page. To register and access archived newsletters, click the E-News link on the left hand side bar.
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: How can I order any product upgrade in the AllFusion Modeling Suite?
A: There is an Upgrade link on the CA support web page for the following products:
- AllFusion ERwin Data Modeler   http://esupport.ca.com/public/erwin/erwin_supp.asp
- AllFusion Model Manager   http://esupport.ca.com/public/modelmart/mdlmrt_supp.asp
- AllFusion Process Modeler   http://esupport.ca.com/public/bpwin/bpw_supp.asp
- AllFusion Component Modeler   http://esupport.ca.com/public/paradigmplus/paradigmplus_supp.asp
- AllFusion Data Model Validator   http://esupport.ca.com/public/erwin/erwinexam_supp.asp
	
	
	
	

	12/29/03
	Product: AllFusion ERwin Data Modeler
Version: 4.0, 4.1
OS: Windows 
Q: Where do I get the most recent patch release?
A: At the following Web site: http://esupport.ca.com/
	
	
	
	

	Macros

	Date
	Question and Answer
	
	
	
	

	05/03/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: I want to replace the values in a string with spaces but when I use the %Substitute(<value>,<pattern>,<substitute>), there is no way to put in a blank space for the value.
A: This is a known limitation of this macro but here is a workaround:
Lets say that we want to replace the underscores in the "table_name" with spaces. We could use:
%Substitute(%TableName,_,%Substr(a,2,1))
The trick is that we have used the %Substr (sub string) macro to request the second character of the string 'a' that has only one character. 
	
	
	
	

	ERWDB

	Date
	Question and Answer
	
	
	
	

	05/03/04
	Product: AllFusion ERwin Data Modeler
Version: 4.1, 4.1.4
OS: Windows 
Q: How do I Reverse Engineer AS/400 version 4 since it is no longer on the Database list?
A: AS/400's name has been changed to ISeries, so choose that as the Database. 
	
	
	
	

	Design Layers

	Date
	Question and Answer
	
	
	
	

	09/03/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I want to derive a logical/physical model from an existing logical/physical model, but AllFusion Erwin Data Modeler does not allow it. How can I work around this?
A: This is by design, but you can work around it by deriving a logical or physical model from your logical/physical model, and then deriving a Logical/Physical model from that logical or physical model. The link of object to object however only allows on "generation" so the original logical/physical model would not be a model source for the end result logical/physical model.
	
	
	
	

	09/03/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I want to derive a logical/physical model from an existing physical model, but AllFusion Erwin Data Modeler does not allow this. How can I work around this?
A: You can derive the physical only model to a logical only model first. Then derive a Logical/Physical model from the logical only model. The link of object to object however only allows on "generation" so the original logical/physical model would not be a model source for the end result logical/physical model.
	
	
	
	

	Data Exchange

	Date
	Question and Answer
	
	
	
	

	09/21/04
	Product: AllFusion Erwin Data Modeler
Version: 4.0, 4.1, 4.1.4
OS: Windows
Q: I have an ER/Studio model that needs to be imported into AllFusion ERwin Data Modeler, but AllFusion ERwin Data Modeler does not have interface with ER/Studio. How can I do it?
A: Go to http://www.reischmann.com, to find their TOOLBUS Interface for AllFusion ERwin Data Modeler and ER/Studio.

"The TOOLBUS Interface for AllFusion ERwin Data Modeler and ER/Studio enables the migration of Logical Models (Entity-Relationship Models) and Physical Models (DB2 and Oracle Models) from AllFusion ERwin 4.0, 4.1 or 4.1.4 to ER/Studio 5.1, 5.5 and 6.0, and vice versa". - Reischmann 
	
	
	
	


14. AllFusion Model Manager FAQ
Da http://supportconnectw.ca.com/public/modelmart/infodocs/afmodelmgr_faq.asp 
	General

	Date
	Question and Answer

	06/06/03
	Product: Model Manager
Version 4.1
OS: Windows
Q: I just finished cutting and pasting column comments into my ERwin model. When I save it to MM and try to open it, I get a crash. Going back to a previous version fixes the problem. It seems the comments I entered are the cause. How can this be?
A: If the comments were copied from a Word document some formatting characters may have been copied also. These will appear in the ERwin text editor as black boxes or other "funny" characters. When saved to Model Manager, however, those annoying-but-benign characters may have a special function in the database and cause the application to crash. If you are doing a lot of copying and pasting from other documents, save them first as text, and then copy and paste to avoid this possibility. An enhancement request has been submitted for ERwin to filter out any non-ASCII characters. 

	05/27/03
	Product: Model Manager
Version 4.1
OS: Windows
Q: All the Model Manager Documentation seems to 'require' Model Navigator for the 'Guest' profile in Model Manager. Can the 'Guest' profile be used for a regular ERwin Data Modeler licensed user?
A: Since a Model Manager Administrator can specify a user as Guest in the Security Manager, an Erwin User can use a Guest license, just like a Navigator user.

	05/15/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows
Q: We are getting the following error when trying to retrieve models from Model Manager: 

Session Component ! ERwin does not support requested level of access for the specified persistence unit
A: If you receive this error message, you must update your database client software to a version which is compatible with the database server. For example, if your database server is Oracle 9.2 and your database client software is Oracle 8.0.5, you will need to upgrade the database client software on your machine to the Oracle 9.2 version. This also applies to all other database versions supported by AllFusion Model Manager

	04/25/03
	Product: AllFusion Model Manager
Version 3.0.2, 4.1
OS: Windows

Q: I was updating a number of Column or Table Comments today. Now when I go to save my model into ModelMart, the application crashes yet I can save it as an ER1 file. Why?

A: Recall how you entered your comments. If you copied and pasted the comments directly from another document, you may have inadvertently included some non-printing characters. ERwin doesn't mind these characters, but when you save them to the MM database, if those characters have a specific database function, they may cause problem. To recover, look at your comments again either through the Table or Column editors, or through the data browser. If you see any black boxes, hash signs, or other odd looking characters, delete them, then try saving your model again.

	04/07/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: I tried to save a .er1 file to my Model Manager 4.1 just now and received an error "Object Creation Failed". Why?

A: If you initially opened your model by double-clicking the .er1 file name/ icon while in the Windows Explorer, or if you right-mouse-buttoned on the .er1 filename/icon and clicked Open in the Windows Explorer, this can happen. This issue is under investigation by our Level 2 staff. However, you can easily work around this issue by using File|Open from with ERwin, or by dragging the file name from the Windows Explorer and dropping it on an open instance of AllFusion ERwin Data Modeler. You will then be able to save to Model Manager without any problem.

	01/13/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: When I try to connect to ModelMart I get an error, "unable to find SQL Server library functions". Why is that?

A: You need to install the Sal Server Client software. You probably use ODBC on your workstation to connect to your database with other applications, but ERwin cannot connect through ODBC.

	01/13/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: I opened a 3.5.2 model with ERwin 4.1 and then saved it to Model Manager 4.1. Now when I open it from the Model Manager, I get the error message: "Session Component! Transaction failed with error 24630 Operation Failed. Failed to create an object of Key Group type with id <string>." Why?

A: This particular Session Component error is being researched by Level 2, however, there is a quick workaround. Open the 3.5.2 model in Erwin 4.1 and then save it as a 4.1 .er1 file. Then close and reopen the model with 4.1. Then do a save to Model Manager with this model, and you should be OK.

	01/13/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: Is there a diagram of the Model Manager database?

A: A schema is not shipped with the product, but you can easily reverse engineer the Model Manager schema using Erwin to get a model of the mart.

	01/13/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: Some users, get the error message, "Error Ora-06550 mm_repository_status must be declared". The Model Manager Administrator does not. Why?

A: This is generally a permissions problem. Verify that the user has execute permissions on mm_repository_status. If not, the install may not have succeeded as recommended. Verify the MMUSER role was set up correctly and the setup completed without error. Call Ca Technical Support if this does not resolve the problem.

	01/13/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: The Model Manager 4.1 administrator can connect to Model Manager but other users get the message, "Your ModelMart Client is incompatible with the ModelMart you are trying to connect to. Please acquire a compatible copy of ModelMart Client." when connecting from the same Erwin client.

A: If you migrated your database all of the grants and public synonyms were not copied correctly. Please contact technical support for scripts to fix this problem.

	01/13/03
	Product: AllFusion Model Manager
Version 4.1
OS: Windows

Q: I'm trying to connect to Model Manager and I'm getting the message, "This application is ERwin Build xxxx (ModelMart Build xxxx). The installation of ModelMart to which you are connecting was initialized with ERwin Build xxxx (ModelMart Build xxxx). You must upgrade your client software.

A: Your Model Manager has been upgraded, but you are using an older version of the AllFusion ERwin Data Modeler client. Both the Model Manager and AllFusion ERwin Data Modeler must be the same build number to connect and work together.

	11/25/02
	Product: AllFusion Model Manager
Version 4.1
OS: Windows
Q: Does Erwin/Model Manager support Sql Server 2000 Instances?
A: Yes. You need to put "server name/instance name" in the DBMS connection box. Then put the database name in the database box.

	11/05/02
	Product: AllFusion Model Manager
Version 3.0.2,4.1
OS: Windows

Product: ModelMart
Version 3.0.2,4.1
OS: Windows 
Q: I am aware that ModelMart 3.0.2 is not officially supported on MS SQL Server 2000, but should I try it? Will it work anyway?
A: The main obstacle is that ERwin 3.5.2, the client you use with ModelMart 3.0.2, does not support MS SQL Server 2000, so you cannot connect to a ModelMart 3.0.2 on MS SQL Server 2000. Also, in MS SQL Server 2000 the way user information is stored was changed from MS SQL Server 7.0 to MS SQL Server 2000, and lastly, there is a problem with the suid field in MS SQL Server 2000. 

Bottom line: ModelMart 3.0.2 will not work on MS SQL Server 2000. The solution is to upgrade to AllFusion ERwin Data Modeler 4.1 and AllFusion Model Manager 4.1, which does support MS SQL Server 2000. 

	10/08/02
	Product: AllFusion Model Manager
Version 4.1
OS: Windows
Q: Are there server based diagnostics to check the integrity of models in ModelManager as there were in ModelMart 3.0.2?
A: There are currently no diagnostics to be run against the database. The model integrity checks are being incorporated into Erwin to make them easier for the user. Under the ModelMart menu item there is an option for diagnostics. You can check the API Metadata Checks to check for model integrity. The diagnostics will be expanded as needed.

	09/30/02
	Product: AllFusion Model Manager
Version 4.1
OS: Windows
Q: I initiated/converted ModelManager 4.1 and now when I look at the objects generated, some of the stored procedures in the database are invalid.
A: Some procedures require other procedures or objects to be available to compile. If the required object has not yet been created the procedure is created but will not compile. This does not cause a problem. You can manually compile the procedures anytime in the database. If you prefer not to, it will not cause an error. If Erwin/ModelManager calls one of these procedures it will automatically compile it at that time.

	09/23/02
	Product: AllFusion Model Manager
Version 4.1
OS: Windows
Q: I upgraded my 3.0.2 ModelMart via the conversion and now I am getting an error message that begins "Session Component..." trying to open a model. Then the model won't open.
A: This is sometimes due to an obsolete 3.5.2 object in the model that is not needed in 4.1. You may be able to filter out the obsolete 3.5.2 object by using the ERwin 4.1 Model Manager Diagnostics. Close ERwin 4.1, re-launch, go to the ModelMart menu/Diagnostics and check Model Integrity (SP1) and API Metadata Checks (SP1 and GA). Then reopen the model. If successfully filtered, your model will open, if not call us at 1.800.833.7528, or open an issue via StarTCC for assistance.

	09/09/02
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS

Q: I've upgraded my ModelMart 3.0.2 to Model Manager 4.1. In an attempt to "validate" the models which were converted, I'm running Complete Compare between a model checked out of my new 4.1 Model Manager with ERwin 4.1, and the original model which was checked out of 3.0.2 with 3.5.2 and then opened in 4.1. Is this a valid procedure? If so why do I see differences?

A: It is and is not a valid procedure to compare models in this way. Many differences you may see are completely insignificant. For instance:

You may see different Bitmap, Index, Table, or other internal MM IDs when comparing one diagram to another. The reason for this is that the original 3.0.2 model is now stored in a different ModelMart (4.1) and has different internal IDs simply because they are different MMarts. The same thing would happen if you had checked a model out of one 3.0.2 MM and then checked it into another 3.0.2 MM. 

Similarly, you may see differences in some objects, or object properties because they are represented or stored slightly differently in MM 4.1 and MM 3.0.2. For instance:

In ERwin 3.5.2/MM 3.0.2, Column Order is stored internally by integers 1,2,3....n. However, in 4.1, column order is stored internally by integers 0,1,2....n. This difference is insignificant because the column order itself, is still the same. 

You may see some objects in 4.1, but not in 3.5.2, but that may be because they simply did not exist in 3.5.2.

So.... there will be times when you will want to run Complete Compare between a 3.0.2 model and a 4.1 model. However, don't expect them to be identical. And if you see a difference you feel *is* significant and can't explain, just give us a call and we will help you determine whether the difference makes sense, or not. 

	09/04/02
	Product: AllFusion Model Manager
Version: 4.1
OS: Windows
Q: How do you share objects between models?
A: You need to derive models from a template or base model. You then sync each derived model you would like to change to the base model.

	08/23/02
	Product: AllFusion Model Manager
Version: 3.0.2, 4.1
OS: WINDOWS

Q: I have SQL Server set with WIndows NT security setup but cannot connect to the database from ERwin. What could be the reason?

A: ERwin and ModelMart as yet do not support NT authentication. The workaround is to set another account using the SQL Server or Both connectivity option.

	08/22/02
	Product: AllFusion Model Manager
Version: 4.0
OS: WINDOWS

Q: When trying to assign users in Model Manager, I receive an error: You have defined more users (X) than your ModelMart license allows (Y). Please contact the Computer Associates sales department for more information about upgrading your license. BUT, I have applied a license file that should allow for sufficient users, what is the problem?

A: After applying a new license file, Model Manager must be reinitialized in order to recognize the new license count. Upon restarting the product, you should be prompted if you would like to update your license count. If, after applying a new license file and reinitializing the Model Manager you are not prompted about updating your license, please contact support. 

	08/15/02
	Product: AllFusion Model Manager
Version: 3.5.2, 4.1
OS: WINDOWS

Q: On conversion I have the choice of Moving Library Objects to Models and Remove Old Tables After conversion. Should I choose these?

A: We recommend you leave both unchecked.

· Moving Library Objects to Models is the option to move unreferenced library level objects to converted models. Any objects being used will be in the converted model. If the objects are not being used they would only affect performance. There will be a template model that will be created with all library level object for each library. You can then run Complete Compare and import only those objects you want. 

· Remove Old Tables After Conversion. We NEVER recommend this option. This will delete the MM 3.0.2 tables after the conversion before the customer gets a chance to test. They can use the 4.1 mart for weeks or months, then delete the 3.0.2 mart when they feel 4.1 is sufficiently tested. 

	Upgrade

	Date
	Question and Answer

	06/13/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: I am trying to connect to my AllFusion Model Manager and I am getting an error that says my ERwin client does not match my ModelMart build. But I'm sure I downloaded and installed Model Manager 4.1 SP2b b2771. What's up?
A: Even though you have downloaded and installed the Model Manager administration software, you still need to connect to your Model Manager database and run the Update process. In this case you probably did not do so. You can check the version of the Model Manager database itself by connecting to it via a SQL editor and running the SQL string, "Select * from MMapplication". The version of the database will be returned. If you are not sure you installed the Model Manager administration software itself, you can launch MMOPN32.EXE from the ...CA/AllFusion/Model Manager directory (as opposed to the Start|Programs|Computer Associates|Model Manager menu). When the connect screen appears, hit Cancel, and you will be taken to the ERwin workspace. Go to Help|About to see the version.

	03/21/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: I just upgraded my Model Manager license and now get an MMOPN32.exe error when starting Erwin or Model Manager. What's up?
A: When you receive the ALP Key Certificate the Model Manager license line is usually wrapped over two lines. You may not have cut and pasted it exactly as delivered. Verify that you have the entire license on one line and that there is a space before 3FMM[#] near the end of the line.

	03/21/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: Will my ModelMart 3.0.2 license be transferred when I run the Model Manager conversion?
A: No. Model Manager 4.1 is shipped with only a one-user license. A separate license for additional users purchased is shipped with the product if you purchased it directly, or arrives separately, within a week, if purchased from a re-seller. Before running the Model Manager conversion you will need to ensure you received your Model Manager 4.1 ALP key and copied it to your ca.olf file. Depending on how many additional user licenses you purchases, this is what enables the multiple users. Model Manager 4.1 will read this to update the license in the converted mart. If the license file is not updated you will need to manually remove all users from the security manager. You can, of course, update the license to enable additional users later, but you will need to recreate the security for all these users.

	03/21/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: I converted to Model Manager 4.1 and now I have duplicate entities that do not have any attributes in my models. Why is that?
A: These entities are 'invisible entities'. In ModelMart v. 3.0.2 Invisible entities were used as placeholders for foreign keys that were contributed to child entities in sub models in ModelMart. If you had a subject area that contained child entities that had foreign keys contributed to them, ERwin needed a way to maintain the contribution of those foreign keys. To do that, the parent entities that were not included in the sub model were made 'invisible'. They still existed in the model but were not visible to the user. Further, if the user had opened a subject/subject area from ModelMart 3.0.2, and then did a Save As new model back to the ModelMart, then you would also have child entities in the main subject area that had invisible parents. 

Model Manager 4.1 no longer uses invisible entities to maintain the foreign key chains. When the ModelMart conversion takes place the formerly invisible entities are placed into the main subject area so the user can decide if they wish to delete them or keep them and use them in their modeling. There will be duplicate tables, i.e. the original table as it was in 3.0.2, plus its invisible twin, the one missing the attributes. The entity without any attributes is in lowercase (usually) and the 'real' entity with the attributes is in uppercase. Lastly, the mmzlog will show rows ignoring the invisible entities. 

	03/21/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: When trying to upgrade Model Manager 4.1 SP1 to SP2a on SQL Server why do I get the error: 

SQL Server 2000 (using db-lib) error 515, severity 16: Cannot insert the value NULL int column 'owner', table 'tempdb.dbo.#sp dbdesc __00010002 c8BE'; column does not allow nulls. INSERT fails."
A: This occurs because Model Manager cannot run the SQL Server stored procedure sp_helpdb. Typically this error appears if a database does not have a db owner. Create an owner for the database and re-run the upgrade.

	03/07/03
	Product: Model Manager
Version: 4.1
OS: WINDOWS
Q: I am trying to upgrade my Sybase based Model Manager to SP2 and getting a message:
"Error Sybase 11.9/12.0(usint ct-lib) error 10353, severity 14:
You must have the following role(s) to execute this command/procedure:
'sa_role'. Please contact a user with the appropriate role for help." 
A: In order to upgrade to SP2 on Sybase you must have sa_role permissions on the database.

	03/07/03
	Product: Model Manager
Version: 4.1
OS: WINDOWS
Q: I converted from ModelMart 3.0.2 to AllFusion Model Manager 4.1 and some of the users did not convert to the new Model Manager.
A: If you did an export/import of your ModelMart to a different database before conversion (especially likely if you are using a test bed DB) to Model Manager, all users may not exist in the new database. If they do not exist in the database they can not be converted to the new Model Manager. The conversion process needs to know the database user id from the DBMS. If this does not exist the user can not be added by the conversion process.

	03/07/03
	Product: Model Manager
Version: 4.1
OS: WINDOWS
Q: What build of AllFusion Erwin Data Modeler will connect to my AllFusion Model Manager?
A: Go to a query tool, connect to the DB where your Model Manager is installed, and execute the SQL line "Select * from mmapplication". This will give you the build and lower limit of your AllFusion Erwin Data Modeler or AllFusion Process Modeler client you need to use to connect to this Model Manager. To determine the build/version of AllFusion ERwin Data Modeler or AllFusion ERwin Process Modeler go to the client application and choose the menu option Help - About <the product>.

	03/07/03
	Product: Model Manager
Version: 4.1
OS: WINDOWS
Q: I am trying to connect to my AllFusion Model Manager and I am getting an error "This application is Erwin Build 2765 (ModelMart Build 2765). The installation of ModelMart to which you are connecting was initialized with Erwin build 2522 (ModelMart Build 2522)." What's up?
A: Your version/build of AllFusion ERwin Data Modeler and AllFusion Model Manager are not compatible. In this case, you have upgraded your client AllFusion Erwin Data Modeler on your client computer to 4.1 SP2, however, the Model Manager administrator has not upgraded the Model Manager to the corresponding version. You need to either de-install AllFusion ERwin Data Modeler and re-install 4.1 SP1, or the Model Manager administrator needs to visit our Technical Support Web Site at www.ca.com to obtain the AllFusion Model Manager 4.1 SP2 upgrade, then run the Model Manager upgrade.

	03/07/03
	Product: Model Manager
Version: 4.1
OS: WINDOWS
Q: I am trying to connect to my Model Manager and I am getting an error "This application is Erwin Build 2522 (ModelMart Build 2522). The installation of ModelMart to which you are connecting was initialized with Erwin Build 2765 (ModelMart Build 2765)." What's up?
A: Your version/build of AllFusion ERwin Data Modeler and AllFusion Model Manager are not compatible. In this case your Model Manager administrator has upgraded your Model Manager to version 4.1 SP2 but your AllFusion ERwin Data Modeler client is still at at the 4.1 SP1 level. You will need to visit the Technical Support Web Site at www.ca.com, obtain the AllFusion ERwin Data Modeler 4.1 SP2 upgrade, and upgrade your AllFusion Erwin Data Modeler client to 4.1 SP2..

	11/25/02
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS 

Q: I'm trying to convert my ModelMart 3.0.2 to AllFusion Model Manager 4.1 but when I click the "Convert" button nothing happens. 

A: The database where your 3.0.2 ModelMart and new 4.1 Model Manager is installed needs to be a minimum of 36MBs in size and, in general, should be 3 times the size of the 3.0.2 ModelMart. This should provide adequate space for your 3.0.2 ModelMart, the new 4.1 Model Manager, and temporary tables used during the conversion process.

	10/22/02
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS 

Q: I am trying to connect to Model Manager 4.1 and getting error: ORA-06550: identifier 'MM_USER_HASPROFILE2' must be declared. 

A: This is due to a version incompatibilty between ERwin and Model Manager. If you have upgraded to SP1 of ERwin, be sure the Model Manager also gets upgraded.

	09/13/02
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS

Product: ModelMart
Version: 3.0.2
OS: WINDOWS

Q: When I try to run the ModelMart conversion I get a permission problem or there is no Convert button.

A: Make sure you have the correct permissions on the ModelMart and database. The best way to do this is to run the ModelMart 3.0.2 update.

On the system where you have the ModelMart Manager, 3.0.2 installed, go to Start - Program Files - Platinum ModelMart Manager 3.0.2. You will get a connection box. Connect to the mart. You should get a message that the ModelMart exists. Say Yes to Update. The next box should have an Update button. DO NOT click on a button if it says Create. 

Click the Update button. If the update runs successfully this verifies that you are logging in as the correct user and your ModelMart is recognized. You do not have to be concerned about running the update. This only updates ModelMart objects and will not change any user data.

	Security

	Date
	Question and Answer

	03/21/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: Can multiple users log into Model Manager with the same login if they are using Model Navigator?
A: No. Model Manager is designed to only allow a login one concurrent session. You can add other logins with the guest profile so they do not count against the license.

	Connection

	Date
	Question and Answer

	03/21/03
	Product: AllFusion Model Manager
Version: 4.1
OS: WINDOWS
Q: We recently moved our Model Manager 4.1 database from one MS SQL 2000 Server instance to another MS SQL Server 2000 instance. I am the db owner and I am able to connect using ERwin, however, whenever anyone else tries to connect using ERwin they get the error, "Your ModelMart Client is incompatible with the ModelMart you are trying to connect to. Please acquire a compatible copy of ModelMart Client." We have already checked the MMAPPLICATION table and that shows the same build that the ERwin users are running. Since the ERwin client build number matches the Model Manager build number there shouldn’t be a compatibility problem. What's up?
A: We have heard reports of a problem with the user ids in MS SQL Server 2000 when moving the MM database. To recover, drop the users and recreate them in the destination MS SQL Server 2000 instance to allow the users to connect. 

Here are the steps we have found to work:

1. Make list of all MM users in the database. 

2. Drop all the MM users in the database except for dbo. Note: Most MM database are running exclusively on a dbms instance as we recommend. But be careful if your users are connecting to other databases on the same instance. 

3. Recreate logins with the same names as the users. 

4. EXEC sp_grantdbaccess for all the users to that database as follows: 

EXEC sp_grantdbaccess user1
EXEC sp_grantdbaccess user2
... 

5. Execute grants to public script (see below). 

GRANTS TO PUBLIC SCRIPT 

FIRST EXECUTE THE FOLLOWING IN SQL QUERY TOOL: 

select 'GRANT all on ', name, ' to public' from sysobjects
where type = 'U' 
or type = 'P'
and name like 'mm%'
order by type, name 

THEN PASTE THE RESULTS BACK INTO SQL QUERY TOOL AND EXECUTE 

6. Connect to Model Manager 4.1 in ERwin using DBO (or whoever restored the db). 

7. Go to Model Manager Security manager. Make sure all the users appear in their profiles with the correct assignments. Click OK to exit the Security Manager. Your users should be able to connect now. 

	Error Codes

	Date
	Question and Answer

	05/27/03
	Product: Model Manager
Version 4.1
OS: Windows
Q: I am trying to open a model and getting an error:
"Session Component Error - Required property parent relationship was not set for object of attribute type..........."
A: This is occurring because the model has some inconsistencies relating to Foreign Key migration. There is a diagnostic tool built into ERwin which will detect and repair these inconsistencies. These inconsistencies relate to how a foreign key attribute is linked back to its parent attribute. Once these are corrected, the model can be saved into Model Manager and subsequently can be opened. 

Steps to solve the problem are: 

1. Turn on Diagnostics in ERwin (Tools --> Diagnostics - select both Foreign Key Migration and File Open). 

2. Open the er1 file for the model and allow the diagnostic to run. 

3. Save the model to Model Manager. If the model has already been saved you must delete the Model from Model Manager before saving it again. 

4. The model can now be opened from Model Manager. 

	05/27/03
	Product: Model Manager
Version: 4.1
OS: Windows
Q: I just saved an er1 model to my Model Manager with some history options (available through Model Properties) unchecked. Upon attempting to open the same model I get the error "Session Component Error 24630: Operation Failed. Failed to create object of History Information type with id........" and the model cannot be opened. What's up?
A: Open the original ER1 diagram and go to the Model->Model Properties; History Information Tab and turn on all the history information options. This is all turned on by default in a new AllFusion ERwin diagram but you have the option of turning off all or some of these options. Now save this original ER1 back to the Model Manager and check that it can be checked back out again. 

Note: This is only a workaround, it is considered a Problem (#365) so you should still open an issue in StarTCC or contact Technical Support so you will be notified when the fix for this Problem is included in a Service Pack.
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